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 3D’s primary function is to help 
ate 2D image maps that wrap 
 3D models to create various 
 effects. You can work in 3D or 2D 
te the maps wherever is convenient 
. Paint directly on the model or 

n the 2D view of the map image. 

 3D automatically updates the 
stroke in the other window. This 
 if you paint on the model, the 
also appears in the 2D map Image 
w, and vice versa. 

prefer, you can turn off updating in 
 view (by clicking shut the Eye icon 
Maps Manager palette) to increase 
mance and drawing speed in the 2D 
w. Or, you can hide all 2D windows 
rk exclusively in the 3D view by 

g the Show Maps option in the 
ed Maps Manager palette. 

 3D lets you have up to six maps 
h object in a model. Each map 
nts a different map channel: 
, bump, highlight, reflection, glow, 
vironment. These six maps 
ne to create just the effect you want.

ntrol maps with the Maps Manager 
, a palette that gives you detailed 
ation about each of the maps 
creating. The Maps Manager 
 lets you select and edit maps 
Welcome to Painter 3D™

MetaCreations Painter 3D is the latest 
development in the MetaCreations 
Painter family. Painter 3D is the best way 
to create realistic or artistic looks for 3D 
models. It contains hundreds of Natural- 
Media® tools and effects, which let you 
create surface maps that control the 
appearance of your 3D objects. With 
Painter 3D, you can interactively create 
texture, bump, reflection, highlight, glow, 
and environment maps, with all the 
control and flexibility MetaCreations 
products are known for.

Painter 3D is a new product from 
MetaCreations, but its roots are strong. 
A natural evolution from Fractal Design 
Detailer™, Painter 3D marries the proven 
technology from its predecessor with the 
richness of Painter 5 to create an exciting 
new application for 3D artists.

Your Painter 3D package includes:

• The Painter 3D CD-ROM

• The Painter 3D User Guide

• The Painter 3D Quick Reference Card

• A software registration card

• A set of Painter 3D serial number 
stickers. Do not lose these stickers! 
You’ll need the serial number when 
you launch Painter 3D for the first 
time. Adhere the stickers to 
easy-to-remember spots, such as the 
CD-ROM case or the title page of this 
manual. 

If you’re missing any of these items, 
contact your Painter 3D dealer, or contact 
MetaCreations using the e-mail form at 
the MetaCreations Web site 
(www.metacreations.com).

What Is Painter 3D?

Painter 3D is a paint program abundantly 
filled with artistic tools and effects for 3D 
models. With Painter 3D, you can express 
your artistic vision by painting directly on 
3D models with Natural-Media tools. You 
can easily transform your models from 
the ordinary to the spectacular by adding 
color, texture, shine, reflection, glow, and 
environment effects. It’s the closest thing 
to actually holding an object in your hand 
and painting on it. 
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ent Workflow

 

 3D is set up to streamline your 
alettes and tools are organized to 

ntrols at your fingertips. The 
s 3D palette not only contains the 
chy list (which shows you all the 
 that make up a model), but also an 
 list and an Objects list. 

ages list shows you all open 
, whether they are associated with 
odels or not. Beneath each image 

s a list of all the objects associated 
at image. This lets you see the 
hat are attached and shared across 
. 

bject list is similar. It lists all open 
 and shows you which maps are 
ted with them. 

age windows for each object use a 
nalogy. If you have multiple maps 
ngle object, you use the Maps 
er palette to bring the map you 
 edit to the front view in the Image 

w. This prevents multiple Image 
ws for the same object from 
ing your desktop. Of course, if you 
 view two individual maps at once 
s texture and bump), you can 
pen a new view to see both of 
2 Painter 3D

simultaneously, which means that you can 
precisely mimic brush strokes between 
maps. For example, a brush stroke that 
adds color to a texture map can also carve 
out a channel in a bump map.

Objects

Painter 3D lets you create primitive, 
single-object models—such as cubes, 
cones, and spheres—right within the 
application, but its true power lies in 
importing 3D models you’ve created in 
other applications like Ray Dream 
Studio™.

In Painter 3D, a model can be comprised 
of up to hundreds of objects, each of 
which can have its own set of surface 
maps and properties. Yet managing the 
maps associated with complex models is 
easy because you can share maps across 
objects. For example, if you have a model 
that contains repetitive objects, such as 
the legs of a spider, you can create one set 
of maps for one leg and then share those 
maps with the other legs. This simplifies 
and streamlines your workflow.

The Objects 3D palette contains a 
Hierarchy list, which also simplifies 
working with models. The Hierarchy list 
is as its name implies: a listing of the 
objects that make up a 3D model. From 
the list you can quickly select the object 
you want to work with, or you can turn 

off the display of multiple objects so you 
can isolate the piece you want to work on. 
(This can also save on screen redraw 
time.)

Once your model is detailed with the 
maps you’ve created, just save your maps 
and use your original 3D application to 
apply them to your model in the scene. Or 
if you like, you can export the models 
with the maps attached to your 3D 
modeling application (depending on your 
application and the file formats it 
accepts). Choose whichever method best 
suits your workflow. 

If you’re working with either Ray Dream 
Studio or 3D Studio MAX®, you can 
streamline your work by using the 
plug-ins (included on the Painter 3D 
CD-ROM). The plug-ins act as a direct 
link between either of these 3D 
applications and Painter 3D. The plug-ins 
provide a tight connection between the 
two programs and eliminates the need to 
actively save or import/export files 
between the two. 
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hting controls in Painter 3D are 
o help you view and paint your 
s, and render them in the Model 
w—they don’t carry over into other 
lications. This prevents lighting 

ts between Painter 3D and lighting 
 in your 3D application.

your model is mapped, lit, and 
ned just the way you want it, you 
want to render it into a 2D image. 
 3D can render 3D models at any 
ion, complete with anti-aliasing 
ask information. You can 
site renderings directly in 
 3D or copy them to another 
editing program. 

 

t’s New for Detailer 
s

 

re a Detailer user, you’ll find it easy 
e the switch to Painter 3D. The 
ethod of working in Painter 3D 
s the same as it was in Detailer, but 
 3D’s functionality has been 
lined and expanded, letting you 
ore efficiently with a greater 

r of materials, tools, and effects at 
ngertips.
Also, you can edit two or more maps at 
once. Shift-click the Pencil icons in the 
Maps Manager palette to select the ones 
you want and begin painting. The strokes 
paint down through the layers to the 
selected maps.

You can customize how Painter 3D’s 
palettes are arranged on your desktop. 
You can tear off the subpalettes you work 
with most frequently so that they’re 
always available. If you have a favorite 
arrangement of palettes on your desktop, 
you can save that arrangement and load it 
whenever you work in Painter 3D.

A Contemporary Artist’s Studio

Working in Painter 3D is like working in a 
contemporary artist’s studio. You have a 
range of traditional tools and media to 
choose from, combined with the 
sophisticated techniques computer 
technology can offer. 

For example, you can paint with 
Painter 3D’s arsenal of brushes to create 
traditional images, such as oil paint on 
canvas. Then use Plug-in brushes to 
deliver effects like fire or pinching.

Dynamic plug-in floaters can also 
transform the images you create for maps. 
For example, use the Liquid Lens plug-in 
floater to distort and smear the 
underlying imagery in your maps. Or use 

the Kaleidoscope plug-in floater to create 
a symmetrical pattern based on the 
imagery beneath it.

You can also use selections, masks, 
patterns, weaves, textures, fill techniques, 
and more to achieve almost any look you 
want. You can apply surface textures or 
color overlays to an entire map or just a 
portion of it; you can specify a texture 
grain to which a painting tool reacts. 

It doesn’t matter whether you’re trying to 
create maps that are photorealistic or ones 
that are surrealistic; Painter 3D can deliver 
the artistic look you want, limited only by 
your imagination.

Lighting and Rendering 

Painter 3D provides control over the 
lighting environment in the Model 
window (the 3D view of your model). You 
can illuminate models with up to ten 
lights and set their brightness, color and 
concentration. With the Light tool, you 
can click directly on the model to add a 
light shining at the spot you clicked.

You can also lock or unlock lights to 
objects in the Model window. You’ll find 
this useful if you’re painting directly on 
the model or if you’re positioning the 
model to render. 
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d positioning the model. You can 
o save your own custom viewing 
gles.

u can now let Painter 3D figure out 
 best aspect ratio for your maps by 
ng the Minimal Distortion Ratio 
tion in the Apply Map dialog. 
inter 3D calculates the optimum 
dth and height dimensions based 
 your model. (Of course, you’re still 
e to determine the aspect ratio 
urself if you like). 

e many more features and 
ements than those listed here. Take 
at “Painter 3D Basics” on page 29, 
ing With Models” on page 57, and 
 Maps” on page 67 for information 
basic changes in functionality. And 
 to read the 

 

What’s New in 
 3D

 

 PDF file on the CD-ROM to 
u get the most out of moving up 
etailer to Painter 3D.
4 Painter 3D

The Painter 3D CD-ROM contains a PDF 
file, What’s New In Painter 3D, that fully 
describes new and changed features. Here 
are some of the highlights:

• The new Maps Manager palette gives 
you a central place for managing 
maps. It lists all the maps associated 
with a selected object and gives you 
controls for manipulating the maps.

• The new Objects 3D palette 
concentrates actions and tasks for the 
model. For example, you can view the 
hierarchy of objects that make up a 
model, view images associated with 
objects and vice versa, control lighting 
in the Model window, and more.

• You can now share maps across 
objects by linking the same set of 
maps to different objects. This is a 
great time and space saver if you’re 
working with models that contain 
repetitive objects.

• Painter 3D comes with plug-in 
floaters, a new type of floater that lets 
you apply an effect that can be 
changed, moved, and reapplied 
without altering your original source 
material. 

• New plug-in brushes give you 
astonishing new brush strokes to 
experiment with in your surface 
maps. Brushes such as Fire, Blur, and 
Twirl let you paint on a transparent 
floater to transform the imagery 
beneath.

• There are new, refined map controls 
that make your work go more 
smoothly. For example, you can hide 
or show all Image windows, 
depending on what you want to see 
on your desktop. And the Maps 
manager now uses a layered approach 
where all the maps for one object are 
stacked in a single Image window 
(unless you choose to open a new 
view). This helps eliminate Detailer’s 
tendency towards desktop clutter 
from having separate Image windows 
open for each map. 

• It’s easier to look at your model from 
different angles thanks to new preset 
views you access from a pop-up in the 
Controls palette: Virtual Trackball 
tool. These preset views let you 
quickly shift the model’s orientation, 
freeing you from manually dragging 
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tomer Support

 

cal support is free* to registered 
f Painter 3D. There are many easy 
 contact technical support for 
ns about installation, 
ration or functionality. These 

s are Web, e-mail, phone, and fax 
t. 

Creations does not currently 
 for technical support for 
 3D. The only expense to the user 
hone toll charges. 

ll find the answers to most of your 
ns within the pages of this User 

and in the online book 

 

Painter 3D 
ced Guide

 

. If you need further 
nce, you can contact 
reations’s Technical Support in any 
following ways:

 

upport

 

f the answers to your questions are 
le 24 hours a day on our Web site:

www.metacreations.com/support
About Your User Guide

This manual provides basic information 
you need to get started using Painter 3D. 
It will help you learn the application and 
become familiar with basic features and 
functions. 

This user guide assumes you are already 
familiar with basic Macintosh® and 
Windows® concepts—menus, dialogs, 
and mouse operations, such as clicking 
and dragging. If you need more 
information on these subjects, or on the 
Macintosh Finder or the Windows 
Desktop, refer to the Macintosh User’s 
Manual or the Microsoft Windows User’s 
Guide, respectively.

The best way to learn Painter 3D is to read 
the chapters “Getting Acquainted With 
Painter 3D” on page 13 and “Painter 3D 
Basics” on page 29. Then, complete the 
lessons in the online Painter 3D Tutorial 
(PDF format), located on the Painter 3D 
CD-ROM. The tutorial leads you through 
the process of using Painter 3D with maps 
and models. 

After you complete the tutorial, it’s best to 
jump right in and start experimenting 
with Painter 3D. You can use this User 
Guide for reference and refer to the online 
book Painter 3D Advanced Guide (located 

on the Painter 3D CD-ROM) for further 
information about sophisticated 
techniques and effects.

Conventions

The Painter 3D User Guide is for both 
Macintosh and Windows. By convention, 
Macintosh commands precede Windows 
commands in the text. For example, 
Command/Ctrl+I, is equivalent to the 
Macintosh Command-I and the Windows 
Ctrl+I. For simplicity, the term folder 
refers to directories as well as folders. The 
Painter 3D interface for Macintosh and 
Windows platforms is identical, unless 
otherwise specified.

There are also several conventions used to 
identify paths to certain tools and 
controls. The convention to a menu 
follows the rules of the menu name> 
menu item. The convention to a palette 
follows the rules of the palette name: 
subalette name. The convention to a 
palette menu follows the rule of palette 
name: palette menu> menu item.

Modifier Keys

When a modifier key differs between the 
Macintosh and Windows platform, the 
Macintosh modifier is listed first followed 
by a slash and the Windows modifier key. 
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ore Information 

 

re information about 
reations’ products, see our Web site 
 Internet:

www.metacreations.com
6 Painter 3D

In addition to frequently asked questions 
(FAQs), the Web site provides 
troubleshooting techniques, late breaking 
product news, and other resources to help 
you get the most out of Painter 3D.

E-mail Support

To answer your technical support 
question most effectively and quickly, 
please use the e-mail form provided to 
you on our Web site:

http://www.metacreations.com/support

Phone Support

Phone support hours are Monday–Friday, 
8:00 AM–5:00 PM Pacific Standard Time, 
excluding holidays.

Call (408) 430-4062. When calling, please 
have your serial number handy and be at 
the computer where you need assistance.

Fax Support

Dial (408) 438-9672 to send a fax.

Please include your name and serial 
number on all correspondence.

MetaCreations reserves the right to 

change its support policies at any time.

Who Is MetaCreations?

MetaCreations is a major force in 2D and 
3D graphic software, developing and 
marketing next generation products that 
unite traditional art, and design 
techniques with digital technology. 
MetaCreations products are engineered to 
deliver real-time interaction, intuitive 
functionality, and creativity to design 
professionals, graphics hobbyists, and 
consumers who work on desktop 
computers. 

MetaCreations’ focus is maintained by 
three product values:

• Faithfully replicate Natural-Media 
and real world looks in the digital 
medium.

• Facilitate and extend the range of 
creativity by allowing artists to do 
things they couldn’t do before.

• Capture human expression and allow 
the artist’s perspective and intent to 
show through.
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requirements for Painter 3D and provides 
installation instructions.

Painter 3D runs on both Macintosh and 
Windows computers. Follow the 
instructions appropriate for your system.

Late-breaking information about 
Painter 3D can be found on a text 
document called Read_Me on the 
Painter 3D CD-ROM. The information 
might affect your installation so it’s a 
good idea to read this file before 
beginning the installation process.



                   

inimum of 16 MB RAM (32 MB 
more recommended)

inimum of 30 hard disk space; 
u’ll need additional space to save 
s you create

ressure-sensitive graphics tablet 
d stylus are recommended but not 
uired (Painter 3D supports most 
es of tablets)
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all Painter 3D:

  

rn off any virus protection and 
mpression programs, and close any 
er applications currently open.

  

ert the Painter 3D CD-ROM into 
 CD drive.

indows locates the installation 
gram on the CD-ROM.

  

ick Install.

  

llow the onscreen instructions to 
mplete the installation.
8 Chapter  1 Painter 3D

Macintosh Installation

This sections describes the system 
requirements and installation procedure 
for Macintosh computers.

System Requirements

Painter 3D works on any Power 
Macintosh with at least the following 
configuration:

• Power Macintosh computer

• A minimum of 16 MB application 
RAM (24 MB or more recommended) 

• A minimum of 30 MB hard disk 
space; you’ll need additional space to 
save files you create

• A pressure-sensitive graphics tablet 
and stylus are recommended but not 
required (Painter 3D supports most 
types of tablets)

Installing Painter 3D on a 
Macintosh Computer

To install Painter 3D:

1. Turn off any virus protection and 
compression programs, and close any 
other applications currently open.

2. Insert the Painter 3D CD-ROM into 
your CD drive.

3. When the Painter 3D icon appears on 
your desktop, double-click to open it.

4. Double-click the Installer icon and 
follow the onscreen instructions.

Windows Installation

This section describes the system 
requirements and installation procedure 
for Windows computers.

System Requirements

Painter 3D works on any PC with at least 
the following configuration:

• 486, Pentium or Pentium Pro 
computer running Windows 95 or 
NT 4.0 or later

• A m
or 
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ke a note of the number of the 
rgest Unused Block size. You should 
 Painter 3D’s memory allocation to 
umber that is a little bit less than 
s number. 

ay need to adjust the memory 
ion to programs you want to use 
aneously with Painter 3D.

add new fonts or INITS to your 
, the available memory may 
.

 

nge Painter 3D’s memory 
tion:

  

en the Painter 3D folder and locate 
 Painter 3D icon. Click the icon to 

ect it.

  

oose 

 

File menu> Get Info

 

 from 
 Finder or press Command-I.

  

ick in the Preferred Size field and 
ter the amount of memory you 
nt to allocate to Painter 3D.

  

ick the Close box to save the setting 
d close the dialog.
Launching Painter 3D

When you launch Painter 3D for the first 
time, you need to enter the serial number 
of your copy. 

A set of serial number stickers is included 
in your Painter 3D package. If you haven’t 
done so already, affix the stickers to a 
convenient spot such as the Painter 3D 
CD-ROM case or the title page of this 
manual. 

To launch Painter 3D on a Macintosh 
computer:

✤ Double-click the Painter 3D icon in 
the Painter 3D folder.

To launch Painter 3D on a Windows 
computer:

✤ From the Start menu, choose 
Program> MetaCreations> 
Painter 3D.

Setting Memory and 
Printing Options

You can find detailed technical 
information on Painter 3D’s memory 
requirements and optimizing the program 
in “Memory Considerations” on page 10.

Macintosh

By default, Painter 3D is set to use the 
minimum amount of memory—16 MB. 
If you have more memory available, you 
can significantly improve Painter 3D’s 
performance by increasing its memory 
allocation.

Before changing the memory allocation, 
figure out how much memory you have 
available and how much of it you can 
allocate to Painter 3D.

To determine available memory:

1. If Painter 3D is running, quit the 
program. If you want to run other 
applications simultaneously with 
Painter 3D, launch them.

2. In the Finder, choose Apple menu> 
About This Macintosh. The system 
displays a window describing memory 
usage and availability.
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d to accommodate the levels of 
ou’ve set. Writing to and reading 
isk takes time. More RAM available 
ter 3D can help you avoid such 
 

 

st hard disk improves performance 

emory. You can choose which 

 disk Painter 3D uses in the Edit 

 

u> Preferences> General dialog.

 

ting a large amount of RAM to 
 3D may mean that you won’t be 
 run other graphics applications 
aneously. If you do want to run 
r program such as Ray Dream 
 at the same time as Painter 3D, 
eed to find a balance that allocates 
 memory to both applications. 

 

odel Window

 

 view in the Model window 
s 68 bytes per pixel. You can choose 

k with a small window or, if you 
ough memory, set the window to 
ired size. For better performance 

 keep memory available for other 
se a small Model window.
10 Chapter  1 Painter 3D

Windows

Painter 3D has a preferences dialog that 
helps you optimize the program’s use of 
memory, printing speed, and display 
quality.

Choose Edit menu> Preferences> 
Windows to display memory and printing 
options.

Refer to “Preferences for Windows” on 
page 47 for a discussion of these Windows 
preferences.

Memory Considerations

Painter 3D runs with a minimum of 16 
MB application memory (Macintosh) or 
16 MB system memory (Windows). Some 
of Painter 3D’s features have particular 
memory requirements. With more RAM 
available, you increase your capabilities in 
these areas.

Like any graphically intense 3D 
application, Painter 3D uses a lot of 
memory. The benefit you receive, 
however, is well worth the cost in 
memory. Painter 3D renders the model 
(and all associated maps) in real time. 
This means that whenever you look at the 
Model window, you see all your artistic 
enhancements without having to go 
through a separate rendering process. Any 

mark you make or effects you create 
appear instantly on the model. (You can, 
of course, render the Model window for 
purposes of creating a high-resolution 2D 
image.)

The major areas of the program with high 
RAM requirements are as follows:

• The size of the Model window

• The complexity of the model (the 
total number of facets in all objects)

• The resolution (number of pixels) of 
maps you apply

• The number of undo steps allowed 
without using the disk.

• The dimensions of a fractal pattern 
you create

By paying attention to the RAM you 
allocate to Painter 3D, you can avoid 
frustrating delays in your work. 

Allocation

If your Macintosh system has enough 
RAM to allocate more than 16 MB to 
Painter 3D, do it. More RAM extends 
your capabilities and the speed of some 
operations. 

For example, Painter 3D virtualizes to 
disk when image resolution and changes 
go beyond available memory. This may be 
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tion. Otherwise, the results may be 
factory—regardless of image 
ion.

e of the rendering process, 
ed resolution in the map improves 
fidelity on the model surface up to 
t. Beyond this point, higher 
ion maps don’t help. 

robably want to experiment by 
g progressively larger maps on your 
, then examining the renderings 
oduce.

  

 3D offers up to 32 levels of undo 
nges you make in an image. The 
 setting is 5 levels of undo. (You 
 your preference by choosing Edit 
 Preferences> Undo and making a 

 in the dialog.) 

ndo level requires Painter 3D to 
e document at that level. When the 
hanges can be kept in memory, 
ill be. Otherwise, Painter 3D must 
hem to disk, which might delay you 
ntarily.

ould set an undo level appropriate 
r system capabilities (RAM vs. disk 
, work habits, and level of patience.

    
The following table describes RAM 
requirements at several Model window 
sizes.

These figures apply to each Model 
window you open, so you probably want 
to work with one model at a time. Keep in 
mind that these values are for the Model 
window only. The rest of the application 
has additional requirements.

Complex Models

Files for 3D models can be quite large. It’s 
a question of how much data is used to 
describe the surface. More data points 
(vertices) provide better fidelity in form 
(smoother surfaces), but increase file size 
and memory requirements. 

You can control the number of facets 
created from patches in objects exported 
from Ray Dream Studio. Refer to “Using 
Painter 3D With Other Programs” on 
page 49 for more information on export 
options.

A related consideration that depends on 
RAM is saving a model file. With 
minimum RAM, you might not be able to 
save a complex Painter 3D model.

Images and Resolution

Open images require memory, and the 
larger they are, the more they require. 
Additionally, each floater in the image 
increases the memory needed to maintain 
the image in the window. For example, a 
floater of the same size as the canvas 
image effectively doubles the file size.

Painter 3D allows you to use maps that are 
several thousand pixels across and have 
any number of floaters. However, the 
result on the model might not justify the 
performance hit and memory 
requirement of the large scale image. 

Each of the maps you apply to an object 
can be a different size. You might want to 
use high resolution maps for the texture 
map, but use low resolution images for 
the bump, highlight, and reflection masks.

The fidelity of the map image on the 
model depends on factors beyond the 
map’s resolution. The mapping process is 
one factor and rendering is the other. The 
mapping mode you choose should be 
appropriate to the image and model, as 
well as compatible with your 3D 
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3D View Size Memory Required 

200 x 200 2.6 MB

400 x 400 10.6 MB

640 x 480 20.4 MB
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Fractal Patterns

The Make Fractal Pattern feature 
(available from the Art Materials palette: 
Pattern menu> Make Fractal Pattern) 
allows you to create fractal textures at 
various dimensions. The larger 
dimensions are available only when 
Painter 3D has sufficient RAM to create 
them.
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Painter 3D lets you create surfaces on 
three-dimensional models by wrapping 
the models with images. 

There are two types of windows in 
Painter 3D where you create the images to 
wrap your models in: 

• The Model window shows you a 3D 
view of your model. You can paint 
directly on the surface of your model 
in this window.

• The Image window shows you a 
two-dimensional representation—a 
map—of the image you want to wrap 



            

n control the display of these
s using the Window menu.

e Tools palette determines your 
rrent activity. For example, you use 
s palette to draw, zoom in on a 
cument, or select part of an image.

e Controls palette complements 
 Tools palette. It changes to reflect 
tions appropriate for whatever tool 
u select in the Tools palette. The 
ntrols palette gives you instant 
ess to the tool’s main functions. 

r example, if you select the Brush 

   

ls palette.
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on your model. You can have several, 
connected images in which you can 
wrap a single model object. 

Some of Painter 3D’s features and tools 
are specialized for working in 3D on the 
model. Others are geared more towards 
working on the 2D image. And some are 
used exclusively to apply the images to the 
model, a process called mapping. 

Painter 3D has a wealth of features. You 
access these features by using menus and 
palettes. 

Palettes

Palettes are windows that float over your 
“document” windows (the Model and 
Image windows). Palettes contain tools, 
options, and materials that you use to 
create images. 

Some palettes have all their functions 
visible. Others save space on your screen 
by storing features in drawers or 
subpalettes.

Types of Palettes

Painter 3D has seven main 
palettes—Tools, Controls, Brushes, Art 
Materials, Objects, Maps Manager, and 
Objects 3D. 

You ca
palette
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The map appears in the Image window and the 
model appears in the Model window.

Some of Painter 3D’s palettes.

The Too
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e Maps Manager palette helps you 
nage the maps you apply to 
jects. For each object you select in 
 Model window, the Maps 
nager palette lists the map types 

d gives you information about 
ich ones you’re using. From this 

lette, you can switch between 
ious maps, edit several maps 
ultaneously, turn visibility on and 

, view the mapping type, and see 
red maps. 

e Objects 3D palette helps you keep 
ck of models, maps, objects, and 
hting. Each of the subpalettes gives 
u information about the model. For 
mple, the Hierarchy subpalette 
ws you the model’s object 
rarchy (if your model contains 
ltiple objects), and the Objects 
palette lists all the objects 

ociated with each map.

   

ps Manager palette.
tool, the Controls palette shows 
drawing style options such as size, 
opacity, and grain. 

• The Brushes palette is where you 
choose from Painter 3D’s abundant 
drawing, painting, and image editing 
brushes. You can move brushes from 
inside the palette drawer to the drawer 
front to access them more quickly.

• The Art Materials palette is where you 
select your materials—from the 
basics, like a color for your pencil, to 
sublime effects, like paper grain, 
patterns, and gradations. The 

subpalettes of the Art Materials 
palette are Color, Paper (texture), 
Grad, Pattern, and Weave. 

• The Objects palette gives you access to 
plug-in floater effects and helps you 
keep track of floaters and masks. For 
example, the Floater palette contains a 
Floater list that you use to select, view, 
and order floaters in your image 
maps. The Objects palette has three 
subpalettes: Plug-in Floater, Floater, 
and Mask. (For previous Detailer 
users, the Plug-in Floater and Mask 
subpalettes are new features.)
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The Controls palette.

The Brushes palette.

The Art Materials palette.

The Objects palette.

The Ma



                    

ng Additional Palette 
ols

 

of Painter 3D’s palettes have 
nal controls you can display or 
epending on the task at hand. If 
en a subpalette, you can expand it 
king its grow box. For example, the 

anager palette can be expanded to 
ou options for flipping the map 
he X or Y axis or for dropping the 
nto the map. Click the grow box 
o hide these options. In the 
ing example, you can view the 
Variability sliders in the expanded 
terials palette.

  

nd the palette on a Macintosh, click the 
ox” in the upper-right corner.
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Rearranging Palettes

You can drag a palette to any location 
that’s convenient for your work. You can 
also stack palettes together to save space. 
When palettes are moved in close 
proximity, they snap together.

Painter 3D saves your palette arrangement 
when you quit, including locked items, so 
that the arrangement appears as you left it 
the next time you start the program.

Viewing and Hiding Palettes

You can hide a single palette by clicking its 
close box. You can display a palette by 
choosing its name from the Window 
menu or using the key combination 
shown on the Window menu.

To hide all of the palettes:

✤ Choose Window menu> 
Hide Palettes.

Or 

✤ Press Command/Ctrl+H. 

To display palettes again:

✤ Choose Window menu> 
Show Palettes to display the palettes.

Or 

✤ Press Command/Ctrl+H. 
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ct a command from the palette:

  

oose a command from a menu 
ove an icon.

enu items open other palettes. For 
le, you can open the Brush Size 
 by choosing Size from the Brushes 
: Control menu. 

you’ve finished using the Brush Size 
, close it by clicking its close box.

 

 Palette Drawers

 

u can open the drawer of a main 
lette or subpalette to see the other 
ms inside the drawer. The pushbar 
icates which palettes or subpalettes 

ve drawers.

     

 the pushbar opens the drawer.
Using Items in Palettes 

To select an item from the palette:

✤ Click the item’s icon on the front of 
the palette.

A red outline appears around the icon 
you select. If you clicked an icon 
representing a subpalette, the palette 
displays the options for that 
subpalette.

For example, when you click the 
Paper icon on the Art Materials 
palette, the palette appears along with 

a drawer containing a collection of 
different papers. You can collapse this 
subpalette by clicking its icon again.

To sele

✤ Ch
ab

Some m
examp
palette
palette

When 
palette

Using
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ite
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To expand the palette on Windows, click the 
Maximize button in the upper-right corner, 
left-hand position.

Click items on the front of a palette to select 
them.

˙

Pop-up menus within palettes offer additional 
options. 

Clicking



            

g items out of a drawer: 

  

ce the drawer is open, you can drag 
ms out of the drawer to a specific 
sition on the drawer front. 

 

u want to rearrange an icon’s 

tion on the drawer front, first 

ace it by an icon from the drawer. 

n drag the icon from inside the 

er onto the desired position on the 

 

er front.
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Storing items in closed drawers gives you 
more screen space. It’s a good idea to keep 
items on the drawer front that you use 
most often and retrieve other items when 
you need them. For example, you can 
keep the most often used papers on the 
front of the Paper subpalette. Then open 
the paper drawer to retrieve a paper you 
use less often.

To retrieve items from inside a drawer, 
open the drawer by clicking its pushbar. A 
down arrow on the pushbar means the 
drawer can be opened. You can click 
anywhere on the pushbar to open and 
close a drawer. There are three ways to 
retrieve items from drawers: 

• By clicking the icon

• By dragging the icon from inside the 
drawer to the drawer front

• By selecting the item’s name from the 
pop-up menu.

You can reload some of the drawers 

with a new set of materials (a library). 

How to use, create, and manage 

libraries is covered later in this chapter.

You can access any palette drawer 

while in the Effects dialogs. Your new 

selection updates in the preview 

window. For more information about 

effects, see the online book  Painter 3D 

Advanced Guide located on the 

Painter 3D CD-ROM.

To take items out of a drawer:

✤ Open the drawer and click the icon 
for the item you want. 

The item moves to the front of the drawer 
and is outlined in red to show that it is 
selected. Painter 3D automatically 
replaces the least recently used item.

Items that are already on the front of the 
drawer are ghosted inside the drawer. This 
means that there’s a dimmed space inside 
the drawer for the item, but because the 
item is already on the drawer front, its 
space appears dim inside the drawer. 
When you put an item away, it goes back 
to the same location so that you can 
always find it easily.

To dra

✤ On
ite
po

If yo

posi

repl

The

draw

draw



 

Getting Acquainted With Painter 3D 19

              

m stays locked until you unlock it 
king the icon again and holding 
the mouse button until the green 
isappears. Painter 3D lets you lock 
 one item on any drawer front. One 
ust remain unlocked to allow a 
or any new item you might select. 

 

ng Off Palettes

 

es you’ll want to work with two 
s that usually aren’t available at the 
ime. For example, you might want 
k simultaneously with the Images 
bjects subpalettes. 

want to work with two subpalettes 
-side, you can “tear off” one of 

o display it separately. Just drag its 
f the main palette. The torn off 
 appears where you drop it.

   

 unselected palette off the main palette by 
g out the palette icon.
To use the pop-up menu to take items 
out of a drawer:

1. To select an item by name, click the 
Brush pop-up menu to display a list of 
all the items in the drawer.

2. Highlight the item you want and 
release the mouse or stylus to confirm 
your selection. The item’s name 
appears on the Brush pop-up and its 
icon appears on the drawer front 
outlined in red.

3. Click the pushbar to close the drawer.

Locking Items on the Drawer Front

You can arrange the items you use most 
frequently on the drawer front and lock 
them in place. When an item is locked, 
Painter 3D will not put another item in its 
place. You can lock your favorite tools to 
the front of the drawer so they are always 
there when you need them. 

To lock items in place:

1. Drag each item out of the drawer to 
where you want it on the drawer 
front.

2. For each item you want to lock, click 
its icon, and hold down the mouse 
button until a tiny green light appears 
under the icon. When you let go, the 
light stays on to show that the item is 
locked. 

The ite
by clic
down 
light d
all but
item m
space f

Teari

At tim
palette
same t
to wor
and O

If you 
side-by
them t
icon of
palette

You can use the Brush pop-up menu to select 
items within drawers.

Hold down on an icon until a small green light 
appears beneath the icon. This item is now 
locked on the drawer front.

Green light
(indicates a locked item)

Tear an
draggin



              

ou like the palettes arranged in a 
rticular manner, save the layout by 
oosing Windows menu> Arrange 
lettes> Save Layout.

 

Tools Palette

 

ction describes the tools in the 
alette. The other palettes are 
ed more fully in subsequent 

rs.

ols palette contains tools for 
g and navigating, adding light, 
g, filling with color, and creating 
ns. If the Tools palette doesn’t 

 on your screen, you can display it 
osing Window menu> Show Tools. 

ools are exclusively for working in 
del window. Others are only for 
g in 2D Image windows. Several 
ay be used in both windows. 

ding on which window is active, 
 3D dims the icons of tools that are 
ilable for the current window.

he tools have keyboard shortcuts, 
 the 

 

Quick Reference Card

 

 which is 
ed in your Painter 3D box.

ntrols palette relates to the Tools 
 in that it contains options for the 
t tool. The Controls palette updates 
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When you no longer need the palette 
you’ve torn off, just click its close box. 

One subpalette must remain displayed in 
the main palette.You can tear off any 
subpalette that is not currently selected. If 
you want to tear off the current palette, 
select a different palette first, then drag 
the icon of the palette you want to tear off.

If you find you can’t tear off a 

subpalette, it’s probably because it’s 

the currently selected palette. Deselect 

it first before trying to drag it off the 

main palette. 

Cleaning-up Palettes

If the palettes start to clutter your desktop, 
you can tidy up by returning palettes to 
Painter 3D’s default arrangement along 
the edges of the screen. 

To clean up palettes:

✤ Choose Window menu> Arrange 
Palettes > Default.

Palette Tips:

• Arrange your palettes so you can find 
and identify controls more effectively. 
Make sure that open palettes don’t 
overlap each other. Palettes hidden in 
this way can be hard to find.

• Lock your favorite brushes to the 
Brushes palette drawer front for quick 
access.

• If you have two monitors, use one to 
display the palettes, and use the other 
monitor to work in the Model and 
Image windows.
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When you choose the default palette 
arrangement, Painter 3D stacks them neatly on 
the right of your screen.
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irtual Trackball Tool

 

 

rtual Trackball tool works in both 
del and Image windows.

 

 Window

 

rtual Trackball tool lets you rotate 
iew of the model in the Model 
w. The Controls palette offers 
 for controlled rotation on each of 
ee axes. You can control rotation 
recisely by either typing in rotation 
or by choosing preset and custom 
rom the Preset View Position 
 menu.

rtual Trackball tool rotates the view 
model in the Model window so you 
w it from different angles; it does 
ate the model itself. By default, 
emain fixed in relation to the 
s of the model (unless you specify 
ise). Refer to “Using the Virtual 
all” on page 33, for more 
ation about using the Virtual 
all tool.
as you select different tools to reveal the 
selected tool’s options. If the Controls 
palette is not displayed on your screen, 
you can display it by choosing Window 
menu> Show Controls.

The Object Selection Tool

The Object Selection tool works only in 
the Model window.

The Object Selection tool lets you select 
the object (in a model comprised of 
several) that you want to detail. The 
Controls palette shows technical 
information on the selected object. If you 
don’t want the object outlined in red in 
the Model window, be sure the Show 
Selection Indicator option is unchecked in 
the Controls palette.

The Controls palette also gives options for 
adjusting normals. Normals are used by 
3D applications to perform smoothing 
and shading calculations. Adjusting 
normals might be useful with certain 
imported models. Refer to “Special 
Features for Normals” on page 52 for 
more information.
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n access the Grabber tool while any 
ool is selected by holding down the 
ar.

 

ropper Tool 

 

ropper tool works in both the 
 and Image windows.

ropper tool lets you pick up a color 
 elsewhere. The Controls palette 
you values for the color. When you 
 color with the Dropper tool, that 
ecomes the current color on the 
terials: Color palette. 

n access the Dropper tool from any 
elated tool by holding down 
and for Macintosh and Ctrl for 
ws. These tools include the Brush, 
ucket, Rectangular and Oval 

on tools, and the Floater Adjuster. 

used on a model, the Dropper picks 
 color of an object without 
ting the color of a light on the 
.
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Image Window

In an Image window, the Virtual Trackball 
tool lets you rotate the image canvas to an 
angle that’s comfortable to your drawing 
style.

Using the Virtual Trackball tool, drag (in 
the Image window) to rotate your page. 
When you want to set the image back to 
its natural orientation, click once in the 
window, or double-click the tool in the 
Tool palette.

The keyboard shortcuts for this tool work 
regardless of the window type. Use 
Option-Spacebar for Macintosh or 
Spacebar+Alt for Windows. (Also, 
holding down the Shift key while rotating 
the view disables locked lights.)

Magnifier Tool

The Magnifier tool works in both the 
Model and Image windows.

The Magnifier tool allows you to magnify 
areas of an image to perform detailed 
work or zoom-out to get an overall view 
of an image. Click once to zoom in. To 
zoom out, hold down the Option/Alt key 

and click. Double-click the tool to return 
the Model window to original 
magnification.

Drag a marquee to zoom in on a given 
area of an image. You can also use the 
Controls palette to set the zoom level in 
Image windows. 

You can access the Magnifier tool while 
any other tool is selected. For Macintosh, 
hold down Command-Spacebar and click 
to zoom in or 
Command-Option-Spacebar and click to 
zoom out. For Windows, use 
Spacebar+Ctrl to zoom in and 
Spacebar+Ctrl+Alt to zoom out.

Grabber Tool

The Grabber tool works in both the 
Model and Image windows. 

The Grabber tool gives you a quick way to 
scroll the image or the model. You can 
also set the zoom level on the Controls 
palette for an Image window when the 
Grabber tool is selected.

Double-click the Grabber tool to center 
the model in the window.
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ight Tool

 

 

ght tool works only in the Model 
w.

ght tool lets you click the model to 
a light that shines on the spot you 
he Controls palette gives you 

 to adjust the light you create. You 
o choose to lock lights to objects 
lock them. 

 

election Tools 

 

lection tools work only in Image 
ws. 

lection tools lets you select an oval 
angular area. When you create a 
n, its coordinates appear on the 
ls palette.

tools share a space on the Tools 
. Only one appears at a time. To 
he other tool, hold down the 
 button when you click the icon. 
her tool pops up so you can 
t. 

own the Shift key while using these 
 constrain the selection to perfect 

s and circles.
The Brush Tool 

The Brush tool works in both the Model 
and Image windows.

The Brush tool lets you paint strokes 
directly on the model, on images or on a 
floater. You can set Size, Opacity, Grain, 
and Draw Style (Freehand or Straight 
Lines) in the Controls palette. You can 
also set 3D tracking speed, which affects 
how quickly a brush stroke appears on a 
model. (This can be useful when working 
with big brushes that take time to draw 
onscreen.) Refer to “3D Tracking Speed” 
on page 124 for further information.

The Brush tool represents a category of 
marking tools. Within the Brush category 
are pencils, crayons, pens, chalk, 
airbrushes, the remarkable Image Hose, 
and more. The Brushes palette lets you 
choose between these tools and gives you 
access to controls that let you customize 
the brushes. All of these features are 
described in “Painting” on page 117 and 
in the online book  Painter 3D Advanced 
Guide.

You can use the Brush tool to paint on 

a selected floater. A floater is an image 

element or layer that hovers over the 

canvas or background.

The Paint Bucket Tool 

The Paint Bucket works in both the Model 
and Image windows.

The Paint Bucket tool lets you fill an area. 
The Controls palette shows choices for 
what area to fill and what to fill it with. 
You now have the choice of doing a 
cartoon cell fill, a method useful for filling 
areas bounded by anti-aliased lines. 

The Text Tool 

The Text tool works in both the Model 
and Image windows. 

The Text tool lets you create text floaters. 
Use the Controls palette to choose a font, 
point size, and set tracking. 
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llowing functions of the Floater 
er are restricted to Image windows:

lecting floaters by dragging a 
rquee. 

justing a reference floater by 
agging its handles. 

 

ries 

 

ry is a saved collection of similar 
at can be loaded into a palette. For 

le, Painter 3D’s built-in brushes 
eir variants) are contained in the 
 brush library, which is loaded 
ou launch Painter 3D. As you 
ize brushes and other materials, 

n save them into your own libraries. 
acintosh computers, the default 

library is 

 

Painter 3D Brushes

 

; for 
ws, it’s 

 

PAINTER3D.BRS

 

.)

ies are available for papers, patterns, 
ions, brushes, nozzles, floaters, and 
g. You can have any number of 
s, but only one (of each type) can 

n at a time. When you want to use 
ools, load the alternate libraries. 

ies allow you to extend Painter 3D’s 
nd materials, without overloading 
ette drawers. The methods for 
g with all libraries are the same. 
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Rectangular Selection Tool

The Rectangular Selection tool allows you 
to create square or rectangular selections.

Oval Selection Tool

The Oval Selection tool allows you to 
create circular or oval selections.

The Lasso Tool

The Lasso tool works only in Image 
windows. 

The Lasso tool lets you create a freehand 
selection area. The selection automatically 
snaps closed when you let up on your 
mouse or stylus. On the Controls palette, 
you can choose to add or subtract from an 
existing selection.

The Magic Wand Tool

The Magic Wand tool works only in the 
Image window.

The Magic Wand tool lets you select a 
contiguous area based on color similarity. 
This tool can be quite useful because it 
quickly selects a free-form area based on 
pixels in a similar value range. 

The Floater Adjuster/Selection 
Adjuster Tool

The Floater Adjuster works in both the 
Model and Image windows; however, not 
all functions are available in the Model 
window. 

The Floater Adjuster tool allows you to 
select and adjust floaters. Click once to 
select one floater, or shift-click to select 
additional floaters.

Floaters are image elements that float 
above the background image. The 
Controls palette lets you change opacity, 
feathering, composite methods and 
floater layer order. It also allows you to 
group and drop floaters.
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cess the various Mover dialogs by 
ng the appropriate Mover 
and from palette menus: either an 
terial’s menu or a tool’s menu.

 

ng a New Library

 

 a new library first, then copy or 
ms to the library.

 

ate a new library:

  

en the Mover for the art material 
tool you want.

  

ick New. Painter 3D prompts you to 
me the new library.

  

ter a descriptive name and click 
e or OK.

ood idea to save libraries in the 
older. This makes them easy to 
and load when you want them.

 

ew libraries with the Movers. The Brush 
ets you customize your Brush Library.
You can create new libraries, add tools or 
materials, and move items between 
libraries.

It’s a good idea to limit the number of 
tools or materials in a library. This makes 
it easier to find a particular tool and helps 
Painter 3D manage memory.

Brushes are loaded into memory when 

you launch Painter 3D, so adding 

brushes to the default brush library 

increases Painter 3D’s need for RAM. If 

you’re working close to the memory 

threshold, you’ll want to organize new 

brushes into secondary libraries. When 

you want a different brush set, switch 

libraries. This allows Painter 3D to be 

more efficient with memory.

Adding Resources to the Current 
Library

As you work with Painter 3D and create 
new resources, you can save them to the 
current library. The command for adding 
a resource depends on its type. In some 
cases, you click a Save button. In others, 
you choose a menu command. And in the 
case of floaters, you drag them from the 
image into the Floater Portfolio.

The method of adding a particular 
resource to the library is described in the 
section on customizing that resource.

Loading Alternate Libraries

To use the items in a library different than 
the one currently loaded, load that library.

To switch libraries:

1. Open the palette drawer from within 
the palette you are currently working, 
for example, Brushes.

2. Click the Brush pop-up and choose 
Load Library. Painter 3D displays an 
Open dialog.

3. Select a library, then click Open or 
OK. Painter 3D loads the items from 
that library into the palette.

Customizing Libraries

The controls for creating libraries and 
managing their contents are contained in 
the Movers, which are special dialogs that 
help you work with libraries. A Mover is 
provided for each category supported by 
libraries—papers, patterns, gradations, 
brushes, nozzles, floaters, weaves, and 2D 
lights. (Color is the only art material not 
supported by libraries; therefore, there is 
no Mover dialog for colors.)
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ick Delete.

 

ing Items

 

nge the name of an item:

  

en the Mover for the resource 
egory you want to modify.

  

uble-click the icon of the item. 
u can also click once to select the 

m, then click Change Name.)

  

ter the new name and click OK. 

 

ing Brush Icons

 

working with brushes, you have the 
 of replacing the icon used on the 
s palette.

 you open the Brush Mover, use the 
gular Selection tool to select part of 

age you want as the brush icon.

 

nge the image icon of a bush 

  

eate artwork for the brush icon. Use 
 Rectangular Selection tool to 

ect the image.

  

en the Brush Mover by choosing 

 

ushes palette

 

:

 

 Brushes menu> 
ush Mover

 

.
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The new library’s name appears on the 
right-hand side of the Mover window. 
The area above the name is blank because 
this new library is empty. To put things in 
it, you can move them from other 
libraries.

Moving Items Between Libraries

Movers copy items from the two open 
libraries displayed in the dialog. 

When you open a Mover, the resources of 
the current library are listed on the left. If 
this is not the library you want to move 
items from, open a different library by 
first clicking Close. Then click Open and 
select a different library file. 

You must have a destination library open 
in the dialog. If you just created a new 
library, it appears in the right side of the 
dialog. If the dialog is empty, open an 
existing library. Click Open and select a 
library file.

When the source library is open on one 
side and the destination library is open on 
the other, you are ready to move 
resources.

To copy an item between libraries:

✤ Drag the item you want to move from 
the source to the destination library.

Modifying a Library

If you want to delete a resource from a 
library, you can—but be careful. If you 
remove one of Painter 3D’s default 
brushes by mistake, the only way to 
retrieve it is to reinstall Painter 3D. When 
you reinstall Painter 3D, you’ll lose any of 
the custom resources you’ve created, 
unless you save them into other libraries. 

Deleting Items

To delete an item from a library: 

1. Open the Mover for the resource 
category you want to modify.

2. Select the item you want to delete.
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ire Plug-ins

 

t plug-ins are accessed through File 
 Acquire. The Import interface is 

lly used to support file formats that 
t built-into Painter 3D. 

 

t Plug-ins

 

 modules are used to export 
s. Export modules are available 
h File menu> Export. 

 

ck the Web site at 

.metacreations.com for new 

rmation and availability of import 

 export plug-ins for different 3D file 

 

ats.

 

ng Plug-Ins Available to 
er 3D

 

Painter 3D launches, it searches for 
s in two locations. Painter 3D first 

n the Painter 3D application folder 
bfolders. The second place that 
 3D looks is the folder specified by 

it menu> Preferences> Other 
Plug-Ins preference.
3. Select the brush whose picture you 
want to change.

4. Click Change Picture. Painter 3D 
displays the change that you’re 
proposing.

5. If you’re sure you want to change the 
picture, click OK.

Deleting a Library

To delete an entire library on a Macintosh, 
go to the finder and drag the library to the 
trash. On Windows, you can delete the file 
from the Windows 95 Explorer. You can 
also drag the file to the Recycle Bin. Be 
careful not to delete Painter 3D’s default 
libraries. Painter 3D needs them to 
start up.

About Plug-Ins

Painter 3D supports third-party 
Photoshop®-compatible plug-ins such as 
Kai’s Power Tools™. There are three kinds 
of plug-ins: Filter plug-ins, Acquire 
plug-ins, and Export plug-ins. Plug-in 
modules are available from Painter 3D 
menus. However, the actual operation of 
these plug-ins is determined by the 
plug-in developer. You should refer to the 
documentation that came with your 
plug-in modules for instructions on how 
they work. 

If you are interested in developing 

plug-in modules, please contact Adobe 

Systems Inc. for Developer kit 

information.

Filter Plug-ins

Filter plug-ins appear after Painter 3D’s 
built-in effects, in the Effects menu. These 
Filter plug-ins are usually comprised of 
special image-editing effects. Plug-in 
filters operate the same way that 
Painter 3D’s Effects operate. If you have 
an active selection, the filter is applied to 
the selection. If you have no selection, the 
filter is applied to the entire image. Once 
the effect is applied to a map image that 
has been associated with a model, the 
view updates in the Model window.

Because Painter 3D and Photoshop were 
developed by different companies, there 
may be filters that run in one program, 
but not in another. MetaCreations has 
made a conscientious effort to maintain 
compatibility with as many third party 
filters as possible. Check with the filter 
developer to find out whether there are 
any compatibility problems between their 
product and Painter 3D. Please note that 
since Painter 3D is an RGB-based 
program, it cannot run filters that are 
specific to CMYK or Grayscale modes. 
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Before Painter 3D can display your 
plug-ins in the Effects menu, you must 
indicate where your plug-ins are located 
on your hard drive. Painter 3D loads 
plug-ins from the selected folders.

To locate the plug-ins folder:

1. Choose Edit menu> Preferences> 
Other Raster Plug-Ins. The Open 
File dialog appears. 

2. Locate the folder that contains your 
plug-ins.

3. Click Select Plug-ins.

4. Quit Painter 3D and then restart the 
program to load these plug-ins. 

When Painter 3D starts up, it quickly 
displays the names of all available plug-ins 
on the start-up screen.

To use third-party 2D plug-ins from 
within Painter 3D:

✤ Choose Effects menu. A list of 
available plug-ins appears at the 
bottom of the menu. You can use 
them to edit your image. 



  

nter 3D Basics

 

 Painter 3D Works

 

Painter 3D at its simplest level, you 
Pai

How

Using 
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basically work with two items: a 3D model 
and a 2D image that decorates the surface 
of the model. The image wraps around 
the model in a process called mapping. 
(There are various mapping methods you 
can choose from.) Depending on the 
images and settings you use, you can 
make the model look like wood, metal, 
stone, plastic, even skin, and more.

With Painter 3D, you develop the image 
by painting directly on the model in the 
Model window (for real-time accuracy) or 
by working on a canvas in an Image 
window. In fact, you’ll probably find 
yourself switching constantly between the 
two windows, depending on the look 
you’re trying to achieve. As you make 



                  

ing With the Pieces

 

xt several sections describe each of 
s you work with in Painter 3D. 

 

ls

 

ve several ways to generate and 
t models in Painter 3D, including 
g primitive models directly in 

r 3D, and opening 3D files that were 
 in Ray Dream Studio and saved as 
r P3D files. You can also import 3D 
m various other 3D modeling 

ms as long as they use DXF, 3DMF, 
 OBJ formats. 

you open a model, Painter 3D 
s a 3D view of it in the Model 

w. You can rotate your view of the 
, zoom in, and move the model in 
dow. 

  

odel appears in 3D in the Model window.
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changes in either window, the changes 
appear immediately on the model in the 
Model window. 

You can choose to not view brush 

strokes in the Model window. This lets 

you concentrate on the 2D image, if it 

suits you, and also saves your 

computer’s resources if you’re working 

with complex models. 

You can get much more elaborate with 
Painter 3D—using models made of 
several objects and applying several maps 
to a single object—but the fundamental 
idea is the same. You create a 2D surface 
and apply it to your 3D object.

Putting It All Together

This section briefly describes the typical 
process you use with Painter 3D.

1. Begin with a model. This can be a 
multi-object model you’ve created in 
a 3D modeling program and opened 
in Painter 3D. Or it can be a simple 
primitive model you created within 
Painter 3D.

2. Select an object and apply images to it 
as surface maps. You can have six 
types of maps associated with a single 
object to create various effects.

3. Add lights, if necessary, so you can 
clearly see the effects of the images 
you’re creating. (Note that lights are 
provided strictly as an aid to working 
with your model in Painter 3D. 
Painter 3D’s lights do not carry over 
into 3D applications.)

4. Save the maps and apply them to your 
model in your 3D application. Or, if 
you created and painted a primitive 
model in Painter 3D, you can export 
it and the maps individually to 
another application. 

5. If you like, render the finished model 
as a 2D image complete with mask for 
compositing in other 2D applications.

Work

The ne
the item

Mode

You ha
impor
creatin
Painte
created
VDU o
files fro
progra
3DS or

When 
display
windo
model
the win

As you paint in one window, the other updates 
with your changes.

 Your m



 

Painter 3D Basics 31

      

e Map

 

re map adds color to the object. 
he Painter 3D array of colors, 
s, and art materials, you can create 
etailed imagery on this map. You’ll 
ly find yourself using this type of 
ore often than any other.

 

Map

 

p map creates surface relief or the 
ance of physical texture for the 
 You can carve out or build up 
s with this map based on 
nce values. This means that peaks 

lleys are created from dark and 
reas, not from color itself.

 

ht Mask Map

 

light mask map controls the 
ht in different areas. Dark areas of 
sk reduce highlights and light areas 
e them. Using black, white, and 
 of gray, you can specify the areas 
rface that should be shiny or matte 
is map.

 

tion Mask Map

 

ction map controls the reflection in 
nt areas on the object. Dark areas of 
sk reduce the reflection and lighter 

ncrease it.

  
Once you have a model in the Model 
window, you can begin creating a surface 
for it, which you do by creating a map.

Objects

Objects are the pieces that make up 
complex models. Models can be 
comprised of many separate objects, 
limited only by your computer’s 
resources. In Painter 3D, each object can 
have completely different colors and 
surface characteristics. 

If your model is made up of several 
objects, you select each object individually 
before beginning to detail it. You can, 
however, “share” a single map to multiple 
objects. This lets you reuse a particular 
surface over and over again, which is 
handy if your model contains repetitive 
objects such as the rungs of a ladder or the 

legs of a centipede. It also lets you make 
sweeping changes easily because you 
simply make your changes in one map 
and the change is reflected in all the 
objects that use that map.

Maps

Once you select an object, you can apply 
one or more 2D images to its surface. 
Painter 3D maps these 2D images onto 
the 3D object to give it color and surface 
relief. 

For each object, you can load one image 
for each of six map types. You can leave 
any map type empty. The six map types 
are texture, bump, highlight, reflection, 
glow, and environment. 
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ng button on the Objects 3D: 
 palette or by double-clicking the 
ng method in the Maps Manager 
. 

, you might want to experiment 
ifferent mapping methods so you 
 how different the results can be, 
ough you’re using the same map. 

o “Using Maps” on page 67 for a 
iscussion of the various mapping 

ds.

 

ing

 

l of the surface effects you can 
depend on light. Painter 3D’s Light 
d the Objects 3D: Lighting palette 

 it easy to shine lights on your 
. You can color or dim the lights to 
e object just how you want it.

g effects are specific to Painter 3D 
hey appear in the Model window as 
d them or change their color. They 
pear when you render your image 
ter 3D. They have no effect when 
port maps and models to another 
tion.
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Glow Map

A glow map applies additional color after 
the other maps have been applied to the 
object. The glow map is useful for 
enhancing objects that emit light such as 
lamps or LEDs.

Environment Map

An environment map is an image that 
appears in reflections on objects. The 
effects can be quite subtle or dramatic, 
depending on whether the object’s 
reflection setting is low or high.

Map Files and the Image Window

Once you begin creating a map for an 
object, pick a mapping method, then 
Painter 3D opens the map in an Image 
window. Although you can have several 
maps for a single object, there is only one 
Image window associated with each 
object. This helps avoid clutter on your 
desktop.

If you have more than one map type for 
an object, you can work on the maps one 
at a time or simultaneously. Working on 
several maps at the same time ensures that 
the brush strokes you perform on one 
map are duplicated exactly on another 
map. Use the Maps Manager palette to 
select single or multiple maps (refer to 
“The Maps Manager Palette” on page 37).

You can create surfaces working in 2D in 
the Image window or working in 3D by 
painting directly on the object in the 
Model window. If you’re working in the 
Image window, you can set up Painter 3D 
so that the changes you make appear 
immediately on the surface of the object 
in the Model window. If you do so, be 
aware that constantly updating the Model 
window consumes more of your 
computer’s resources and may cause 
Painter 3D to react sluggishly. 

For times when you’re working mostly 

in the Image window, try turning off 

immediate updating in the 3D view by 

clicking the maps’s Eye icon shut the 

Maps Manager palette. Painter 3D’s 

performance will increase.

Mapping Methods

Painter 3D offers several methods for 
mapping the 2D image onto the 3D 
object: cylindrical, spherical, pass-thru, 
cubical, and implicit (UV). 

Each method is suited for objects of 
different shapes. The mapping mode you 
choose, and how you design the imagery, 
makes a huge difference in how the map 
appears on the object. You can change the 
mapping method at any time using 

Mappi
Object
mappi
palette

In fact
with d
can see
even th
Refer t
fuller d
metho

Light

Severa
create 
tool an
makes
model
light th

Lightin
only. T
you ad
also ap
in Pain
you ex
applica



 

Painter 3D Basics 33

       

To zoom-out, choose 
Command-Option-Spacebar for 
Macintosh, Spacebar+Ctrl+Alt 
for Windows.

To switch to the Grabber tool, 
hold down the Spacebar.

 

 Macintosh System has a keyboard 

on for cycling through different 

oard layouts. You’ll want to make 

 this is disabled before zooming 

otherwise your keyboard might 

t acting unpredictably. Choose 

le menu> Control Panels> 

board. In the dialog, make sure the 

mand-Option-Spacebar feature is 

 

bled. 

 

the Virtual Trackball

 

n view the model from any angle by 
g your view. Viewing from a 
lar angle helps when you’re 
g. It’s much easier to work when 

facing the surface you’re painting. 
 to paint oblique surfaces (on the 
 edge of an object) can be difficult.

 

Rendering

When you’re satisfied with the maps 
you’ve applied, the lighting you’ve set up, 
and the position and orientation of your 
model, you can render the Model window 
to a 2D image. 

The rendering can be a larger, anti-aliased 
version of what you see in the Model 
window. You can save the rendering and 
use it as a still image for printing or 
displaying on the Web.

The rendering includes a mask of the 
model, so compositing with other images 
is clean and easy. You can composite 
images directly in Painter 3D or in 
another 2D image-editing application.

Refer to “Rendering an Image” on page 38 
for more information.

Working in the Model 
Window

The Model window shows a 3D view of 
the model you’re working on. When 
you’re adding detail to a model, you’ll 
want to keep the area you’re painting 
centered in the window, at a reasonable 
scale, and square to your view. 

Painter 3D provides three navigation tools 
that make it easy to view and paint on any 
surface of the model—the Virtual 
Trackball, the Magnifier, and the Grabber 
tools. 

Key shortcuts let you temporarily switch 

to the navigation tools.

To switch to Virtual Trackball 
tool, choose Option-Spacebar for 
Macintosh, Spacebar+Alt for 
Windows.

To zoom-in, choose 
Command-Spacebar for 
Macintosh, Spacebar+Ctrl for 
Windows.
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model.



        

rect view of the north pole, in the 
 space, is 0°, 0°, 0°. A direct view of 
nt would be 90°, 0°, 0°.

 

 Views

 

n also choose from preset or 
 views to snap the model to a 

 orientation. You choose preset 
rom the Preset View Position 
. The choices are top, right, left, 
ack, or bottom. You can also set a 
 view using sliders or values, then 

s pop-up to save and name the 
 view so you can use it again.

 

fying Your Subject

 

agnifier tool works in Image 
ws and in the Model window.

  

xis runs horizontally. The Y axis runs 
ly. The Z axis runs perpendicular to the 
f your monitor screen.
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To change the 3D view:

1. Choose the Virtual Trackball tool.

2. In the Model window, drag to rotate 
your view of the model. 

Here are some tips for rotating the model:

• Drag down from the center of the 
window to view the model from 
above (rotating the model along the X 
axis).

• Drag left or right from the center of 
the window to view from the other 
side (rotating the model along the Y 
axis).

• Drag in a circle (or arc) from a corner 
of the window to change which side is 
up (rotating along the Z axis).

• Drag at an angle to rotate on several 
axes.

In the model space, the model doesn’t 
actually move. The model is fixed with 
respect to the lights. When you use the 
Virtual Trackball, you’re changing your 
view of the model. That is, the model stays 
in one place and you move around it. You 
may want to adjust lighting after rotating 
your view or lock the lighting to the 
object.

If you move around the model, you might 
find an area that is dark. This is because 
there is no light shining from that side. 
You could add a light to shine there, 
increase ambient light, or enable the Flat 
Lighting option in the Objects 3D: 
Lighting palette. See “Using Light” on 
page 95 for more information on 
controlling light.

If you prefer, you can have the lighting 
remain stationary relative to your 
viewpoint by holding down the Shift key 
as you drag in the Model window. In 
effect, it looks as if the model moves while 
the lights remain motionless.

Controlled Rotation

When the Virtual Trackball is selected, the 
Controls palette provides several ways to 
rotate the view. You can use sliders or type 
in precise values for rotating the view on 
the X, Y, and Z axes. The X axis runs 
horizontally. The Y axis runs vertically. 
The Z axis runs perpendicular to the 
plane of your monitor screen.

Drag the slider or enter a specific value for 
the direction you want to rotate the view. 
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mfortable to work in, but requires 
re RAM. The bigger the window, 
 longer it takes to display. A large 

ndow might not be possible on 
ur system. 

  

ick OK. Painter 3D sets the Model 
ndow to the new size.

 

’t set a Model window that requires 

e RAM than your system has 

lable. Between 200 and 300 pixels 

 

are is a good size for most systems. 

 

 the Model window Background 

 

n choose a color for the 
ound of the Model window to show 
r model and its surfaces in 

nt ways. You might want to use a 
ackground with a light colored 
and vice-versa.

you render the image in Painter 3D, 
kground color is included in the 

 It is not included if you export the 
 or maps to another application.
To zoom in:

1. Choose the Magnifier tool.

2. Click the area you want to view closer. 
You can also drag a marquee around 
the area you want to magnify. 
Painter 3D zooms to the highest level 
that can display the full area of the 
marquee.

To move back and get a larger view:

✤ Hold down the Option/Alt key, then 
click in the window.

Or

✤ Double-click the tool to return to 
100% in the Image window.

Magnification Pop-up Menu

The Controls palette: Magnifier tool 
provides a pop-up with a set of 
magnification factors. Select the level you 
want and Painter 3D immediately sets the 
magnification to that level in the Image 
window. This pop-up is active only if the 
Image window is the active window.

Panning the Model Window

Use the Grabber tool to pan the Model 
window so that the area you’re working 
on is centered in the window. The 
Grabber tool works in the Model window 
and in Image windows.

To pan the Model window:

1. Choose the Grabber tool.

2. Drag the model (or image) to view the 
area you want.

To return the object to center:

✤ Double-click the tool.

Changing the Size of the Model Window

You can change the size of the Model 
window at any time.

To change the size of the Model 
window:

1. Choose Window menu> Set 3D View 
Size. The Set View Size dialog 
appears. 

The dialog shows how much RAM is 
required for the window specified. A 
larger window may be more 
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vigate to the location of the file you 
nt, select it, then choose Open.

inter 3D imports the background 
age you chose.

r 3D supports the following image 
mats: RIFF, TIFF, PICT, Photoshop 
 3.0, BMP, PCX, TARGA, FRM, 

nd JPEG. 

ckground image appears in the 
 window aligned at the top left 
. 

ackground image is larger than the 
 window, only the upper left region 
image is visible. If this is not the 
ou want, create a new image that is 

scaled or cropped to the region you 

ackground image is smaller than 
del window, the image is tiled 

ted) to cover the area.

ckground image file cannot be 
while it is associated with the 
. If you need to edit the background 
 you can do so in another 
tion. Or, open it as a separate 2D 

in Painter 3D, edit it, then save and 
rt it as a background again. 
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If you are creating a 2D collage of 

several renderings, you might want to 

set the background color accordingly.  

To change the background color:

1. Choose Edit menu> Preferences> 
Model. Painter 3D displays the Model 
Preferences dialog. 

The other model preferences are 
described in “Model Preferences” on 
page 45. 

2. Click the Background Color swatch. 
Painter 3D opens the system color 
picker so you can choose a color for 
the window background.

Importing a Background Image

Painter 3D lets you import an image as 
the background of the Model window. 
You can use the image in the rendering of 
the finished model. This lets you adjust 
the surface maps, lighting, and view of 
your model to match the imagery in the 
scene.

When you render the 3D view, the 
background is included in the image. It is 
not included when you export a model or 
maps to another application.

To import a background:

1. Open the model you are working on.

2. Choose File menu> Acquire> 
Background. A standard Open dialog 
appears. 
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Change the background color and see how it 
affects the way the model appears.

You can import a background and render with it.
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 model comprised of a single 

ct, like Painter 3D’s own primitives, 

 

 object is automatically selected.

 

ault, Painter 3D outlines the 
d object in red. If you find the red 
 distracting, you can toggle it off 
 during the session or change the 
. 

porarily remove the red outline, 
k the Show Selection Indicator in 
ntrols: Object Selection palette. To 
 Painter 3D’s default behavior, 
k the Show Red Indicator When 

ng Objects setting in the General 
nces dialog. Refer to “General 
nces” on page 41 for more 
ation about Painter 3D’s 
nces.

 

aps Manager Palette

 

atures for applying and controlling 
re found on the Map menu and on 
ps Manager palette. Some features 
 in both places to give you a choice 
 to work.

aps Manager palette lists the six 
pes that you can apply to objects: 

e, Bump, Highlight, Reflection, 
and Environment.

 

Hiding and Showing the Background 
Image

At times, you might want to temporarily 
remove the background image. Perhaps 
you find the image a distraction to your 
painting or you want to render without it. 

To hide the background image:

1. Bring the Model window to the front.

2. Choose Window menu> Hide 
Background. Painter 3D sets the 
window to display the background 
color.

To show the background image:

1. Bring the Model window to the front.

2. Choose Window menu> Show 
Background. Painter 3D sets the 
window to display the background 
image.

To remove the background image 
completely:

✤ Choose Window menu> Remove 
Background.

Objects and Maps

Painter 3D supports models constructed 
of hundreds of separate objects, limited 
only by your computer’s resources. Each 
object can have a unique set of maps 
applied to it. When you work with a 
multi-object model, you need to select 
which object within the model you want 
to detail. 

To select an object:

1. Choose the Object Selection tool.

2. In the Model window, click the object 
you want. The selected object appears 
outlined in the 3D view. 

In a

obje

that

By def
selecte
outline
and on
default

To tem
unchec
the Co
change
unchec
Selecti
Prefere
Prefere
inform
prefere

The M

The fe
maps a
the Ma
appear
of how

The M
map ty
Textur
Glow, 

Selecting one object of a multi-object model.



     

ering an Image

 

n render the 3D view of your model 
arate image at any time. The 

ing you create is a high resolution 
 of what you see in the Model 

w. The rendering includes a mask, 
makes it easy to composite with 
mages.

 

ter 3D’s rendering camera does 

create perspective views of the 

el. If you want a true perspective 

ct, you can export your Painter 3D 

el to Ray Dream Studio or another 

 

program.

 

er to Image 

 

ring settings are found in the 
r to Image dialog.

 

der the 3D view:

  

fore rendering, use the Virtual 
ckball, Magnifier, and Grabber 
ls to set the view of the model. Set 
 lights how you want them.
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When you select an object, the Maps 
Manager palette updates to show any 
settings and maps loaded for that object. 

In each map type listing, there are four 
icons to the left of the map type, and the 
name of the map file to the right. Two Xs 
at the left of a map list indicates that the 
selected object does not have a map of this 
type loaded. 

If an object has a map associated with it, 
Eye and Pencil icons appear next to the 
map type. The map file name appears on 
the right of the listing.

The Eye icon controls whether Painter 3D 
displays the map on the object in the 
Model window. When the Eye is open, the 
map appears on the object in the Model 
window. When the Eye is shut, the map is 
not applied; it’s only viewable in the 
Image window, which saves memory. You 
can click the Eye once to open and close it.

The Pencil icon controls which map is 
active for editing. Click the map name to 
select it for editing. The Pencil icon for an 
active map is clear—the other Pencil icons 
have a red slash over them. When you 
select a map to edit, it moves to the top of 
the stack in the Image window. (You can 
open a new view by choosing Window 
menu> New View if you want to have 
maps in separate Image windows.)

The remaining two icons show you the 
mapping method for the map (spherical, 
cubical, UV, and so on) and whether the 
map is shared. (Shared maps are indicated 
with a yellow link icon.)

Simultaneous Map Editing

You can select multiple maps for 
simultaneous editing. This is useful when 
you want to precisely carry over brush 
strokes from one map to another. 
Shift-click Pencil icons to select and 
deselect multiple maps.
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The Maps Manager palette holds the controls for 
the six maps.
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like the results, save the image file. 
endering isn’t what you expected, 

he window without saving changes. 
 your model, maps, or lights and 
 again.

 

all formats maintain the mask 

rmation. Save in RIFF, TIFF or 

toshop formats to maintain the 

 

k information.

 

 Renderings in Painter 3D

 

you’ll want to composite the image 
endered model with other imagery. 
ask Painter 3D creates in the 
ing makes compositing easy.

  

osaur eggs are separate renderings 
ited in Painter 3D.
2. Choose File menu> Render to 
Image. Painter 3D displays a dialog 
that lets you set rendering options. 

3. Enter width and height values (in 
pixels) for the rendering resolution 
you want.

The values you enter should conform 
to the aspect ratio of the Model 
window. Values that describe a 
different aspect can lead to 
unexpected results in the rendering.

4. Enter a pixel resolution at which to 
render the image. (Refer to “Images 
and Resolution” on page 11 for 
information about resolution.)

5. Set your anti-aliasing options. 

Anti-alias image: when this option is 
enabled, pixels at the edge of the 
model are faded to the background 
color. Anti-aliasing the image creates 
a softer edge. 

Use this option if you intend to use 
the rendering as a complete image. 

Anti-aliased images take significantly 
longer to render.

Anti-alias mask: when this option is 
enabled, mask pixels at the edge of the 
model’s shape are given intermediate 
density values.

Use this option (and disable 
Anti-alias image) if you intend to 
composite the model with other 
images. 

If you will be using your rendering as a 

finished image, choose to anti-alias the 

image but not the mask. If you are 

going to turn your rendering into a 

floater or layer, choose to anti-alias the 

mask, but not the image.

6. When you click OK, Painter 3D 
renders the image. Rendering can take 
some time, depending on the 
resolution you requested and the 
speed of your system. When the 
rendering is ready, Painter 3D opens it 
in a new Image window. 
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Image dialog.
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el. You can hide them however, by 

ing the Show Maps option in the 

 

s Manager palette.

 

or Saving Files

 

you’re working with multi-object 
s and multiple maps, naming, and 
 files can quickly become chaotic 
you apply some organization to the 
s. Here are some tips to help you:

ve the model and all the maps 
ociated with it in a single, separate 
der. This simplifies opening and 
porting files in both Painter 3D and 
er 3D applications.

me your maps descriptively and 
nsistently. For example, name all 
 maps for a single object using the 
e prefix but different suffixes: 

ndle Texture, Handle Bump, 
ndle Highlight, and so on. This 

lps you quickly find the maps that 
long together when you’re applying 
m to a model in another 

plication.

t in the habit of using File menu> 
ve As. It’s easy to lose track of maps 
d objects when you’re working with 
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To composite your renderings in 
Painter 3D:

1. Open the saved rendering in 
Painter 3D. The rendering must be 
saved in a format that retains the 
mask (RIFF, TIFF, or Photoshop 
formats).

2. Click the Draw Inside icon at the 
bottom left of the Image window. A 
selection marquee appears around the 
model shape.

3. Choose Edit menu> Copy.

4. You can now move to another file and 
paste the selection. The selection is 
pasted as a floater. Refer to the online 
book Painter 3D Advanced Guide for 
more information about working 
with floaters.

Saving Files

A model you’ve painted can have up to six 
maps for each object. If the model is 
comprised of a number of objects, there 
may be quite a few image files used for 
this one model. You’ll need to save all 
these image files with the model.

When you select the Save command, 
Painter 3D applies it to the foremost 
window.

When an Image window is active, 
Painter 3D saves that image.

When the Model window is in front, 
Painter 3D saves the model as a 
Painter 3D model (P3D format). If any 
map images have not been saved, 
Painter 3D requires you to save them 
before saving the model file. When you 
save the model, Painter 3D prompts you 
to save any unsaved maps associated with 
the model. 

Map Image windows must remain open 

while you are working with the model. If 

you close a map Image window, that 

map becomes dissociated from the 

mod
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Select the model object with the Draw Inside 
icon, then copy the image element and paste it in 
another image.
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 the Default Libraries

 

r 3D provides several libraries that 
 many different brushes, papers, 

s, lights, and color sets. You can also 
your own libraries. By typing a file 
or the library in the text box next to 
s, Papers, Floaters, and Color Set, 

n designate the libraries that appear 
ers when you open Painter 3D.

 

ing a Default Scratch Disk

 

ct the disk volume that Painter 3D 
its temporary file on, choose the 
e name from the Temp File Volume 
 menu. 

 

t Units

 

tting lets you control the default 
 measurement (pixels, inches, 
eters, and so on) for any aspect of 

r 3D that requires measurement. 
mple, suggested sizes for new 

 or Image windows are based on the 
 measurement specified with this 
nce. Also, if you choose to display 

in the Image window, the rulers will 
 in the units specified with this 
. 

 

r Pre-Feather

 

oater pre-feather box determines 
uch you can feather a floater’s 
ty mask without bumping into the 

 

complex models. Save As gives you the 
chance to review the location and 
name of the file before performing the 
save, saving you from overwriting a 
file you may not have wanted 
changed. This can be a life-saver if 
you’ve copied several maps for several 
objects.

Setting Painter 3D’s 
Preferences

Painter 3D has several preference dialogs: 
General, Brush Tracking, Function Keys, 
Interface, Other Raster Plug-ins, Undo, 
and Model. There are also preferences you 
can set that are specific to Windows.

General Preferences

To display the general Painter 3D 
preferences dialog, choose Edit menu> 
Preferences> General. 

Drawing Cursor

Painter 3D gives you several choices for 
the appearance of your cursor. To choose 
whether the cursor appears as a triangle or 
a single pixel, check the radio button next 
to Cursor Type. To determine the 
direction the cursor will point (depending 
on your design and whether you’re left- or 
right-handed), click the appropriate 
button in the circle above Orientation. To 
select a cursor color that contrasts with 
your working area and is therefore clearly 
visible, click the appropriate rectangle 
above Color.
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The Painter 3D General Preferences dialog.



              

lay the Brush Tracking dialog, 
 Edit menu> Preferences> 
Tracking.

how sensitive the stylus will be to 
and pressure and speed, move the 
across the scratch pad area at a 
l speed and with a normal amount 
sure.

 your signature varies, so will the 
u work with the stylus at any given 
o you’ll set up Brush Tracking each 
u start Painter 3D. When you exit 
 3D, the Brush Tracking sliders go 
 their default settings. 

 

sh Tracking to customize how Painter 3D 
s to your stylus pressure and speed.
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edges of the floater. The default setting is 
16 pixels. You can change this default to 
any number up to 50. The change takes 
effect the next time you launch 
Painter 3D.

Cloning Preference

When you clone an image, Painter 3D 
uses the color information from the 
original as you fill in your clone. If you 
want Painter 3D to display what part of 
the original you’re cloning, check the box 
next to Indicate Clone Source with Cross 
Hairs While Cloning.

Draw Zoomed-out Views Using 
Area-averaging

When looking at an image at less than 
100% view, screen re-draw is faster if you 
leave this option disabled. Drawing is 
slower but more accurate if this option is 
enabled.

Display Warning When Drawing Outside 
Selection

Enabling this option activates the warning 
that appears when you draw outside a 
selection. The warning will not appear if 
this option is disabled.

Show Commit Dialog when Converting 
to a Floater

Enable this checkbox if you want to 
reinstate the Commit dialog after you 
have selected the Don’t Ask Again button 
in the Commit dialog.

Show Red Indicator When Selecting 
Objects

Enabling this option sets default behavior 
for the Object Selection tool. If this option 
is checked, when you select an object in 
the Model window, Painter 3D outlines it 
in red. 

You can override this default on an 
object-by-object basis by checking and 
unchecking the Show Selection Indicator 
in the Controls: Object Selection palette. 

Brush Tracking and Setting 
Pressure Sensitivity

When you draw with Natural-Media, the 
amount of pressure you use with a tool 
determines how dense and how wide your 
strokes are. Using a pressure-sensitive 
stylus with Painter 3D gives you this same 
kind of flexibility. Each artist bears down 
on a drawing or painting tool differently. 
In Painter 3D, you can program the 
computer to react to your individual 
touch just by dragging in the Brush 
Tracking dialog. 
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ick Use Current Color next to Icon 
lection Color. The selection box 
anges to the currently selected 
lor. This color is used until you 
ange it again. 

 

nge the palette background 
e:

  

oose the texture you wish to use in 
 Paper palette.

  

oose 

 

Edit menu> Preferences> 
terface

 

. The Interface Preferences 
log appears. Click in grayscale 
m the Palette Background section 
ou want the texture to be rendered 
grayscale. Click in current colors if 
u wish the texture to be rendered in 
 current primary and secondary 

lors.

 

erface Preferences dialog.
Function Keys

If your keyboard has function keys, 
Painter 3D lets you assign commands to 
your keyboard function keys (the F-keys). 
This saves you time by giving you 
immediate keyboard access to your 
favorite commands. Using the Shift key 
with the function keys lets you double the 
number of commands you can use.

To assign commands to function keys:

1. Choose Edit menu> Preferences> 
Function Keys.

2. Choose the function key you want to 
assign from the pop-up.

3. Check the Shift key box if you want to 
use the Shift key in combination with 
the function key.

The Current Function field shows the 
command assigned to this key (if 
any).

4. Choose the command you 
want—either from a main menu or a 
palette menu.

New Function displays the command 
you chose.

5. Click Set to assign the command to 
the selected key.

6. Repeat steps 2 through 5 for each key 
you want to set, then click Done when 
you’re finished.

Customizing the Interface

The colors and textures for Painter 3D’s 
interface were chosen to be aesthetically 
pleasing and very legible. However, you 
may want to experiment with your own 
interface colors and textures.

To change Painter 3D’s interface, choose 
Edit menu> Preferences> Interface. 
The Interface Preferences dialog appears.

Changing Icon Selection Color

To change the icon selection color:

1. Using the Materials: Color palette or 
the Dropper tool, choose the color 
you wish to use.
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oose the interface set from the 
en dialog that appears. 

ick Open to load the interface set.

rn to Painter 3D’s default 
ce:

ick Use Defaults in the Interface 
ts section. 

ick Done. Painter 3D reverts to the 
fault interface.

 Raster Plug-ins

 Painter 3D can display your raster 
s (Photoshop-compatible filters) 

Effects menu, you must indicate 
your plug-ins are located on your 
rive. Painter 3D loads plug-ins 
he selected folder and its subfolders.

icate the plug-ins folder: 

oose Edit menu> Preferences> 
her Raster Plug-ins. 

cate and select the folder 
ntaining your plug-ins.

ick OK, then restart Painter 3D to 
ivate this feature.
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3. Click Use Current Texture.

4. Click Done. Your palette background 
texture changes.

To use the current pattern as the palette 
background texture:

1. Choose one of the default patterns or 
use the Rectangular Selection tool to 
select part of an image to capture as a 
pattern. Choose Art Materials 
palette: Patterns menu> Capture 
Pattern.

2. Return to the Preferences dialog and 
click Use Current Pattern. The 
palettes updates so you can preview 
your choice.

3. Click Done. Your palette background 
texture changes to the current pattern.

To change the drawer bottom:

✤ To change the drawer bottom texture, 
follow the steps above, but use the 
selections under Drawer Bottom.

To change the window background 
color:

1. Set the current color using the 
Materials: Colors palette or Dropper 
tool.

2. Click Use Current Color next to 
Window Background Color. The 
background is filled with the current 
color.

When in current colors is selected in 

the Interface Preferences, Painter 3D 

uses the primary and secondary colors 

from the Materials: Color palette to 

customize interface elements. 

Experiment with two colors for 

interesting effects.

You can save your interface preferences by 
clicking Save at the bottom of the 
Interface Preferences dialog. A standard 
save dialog appears asking you to name 
the interface setting. Enter a descriptive 
name and click Save.

To load a saved interface set:

1. Click Load in the Interface Sets 
section. 
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rame

odel appears as a framework of 

rame with Depth Cueing

odel appears as a framework of 
ires that are distant appear fainter 

ose that are close.

liased Wire Frame

odel appears as a framework of 
iased wires.

liased Wire Frame with Depth 
g

odel appears as a framework of 
iased wires. Wires that are distant 
 fainter than those that are close.

isplay preferences are set in the Model 
ces dialog.
Setting Multiple Undo Levels

Multiple Undo allows you to undo and 
redo up to 32 levels of changes. The 
number of undo levels is set in Undo 
Preferences, found under Edit menu> 
Preferences> Undo. Five levels are set as a 
default. 

Undo levels apply across open documents. 
With five levels set, if you have two 
documents open and you have “undone” 
three operations on the first document, 
you can only undo two operations on the 
second. 

Multiple Undo can use a significant 
amount of disk space. If you perform 
multiple operations on the entire image, 
the whole image must be saved for each 
undo step. So be careful with the number 
of Undo levels you choose to save. 

You cannot undo rotations in the Model 

window.

Model Preferences

You can set preferences that affect the 
model and the Model window only.

Choose Edit menu> Preferences> Model. 
Painter 3D displays the Model Preferences 
dialog.

Model Display During Movement

Painter 3D lets you set an option for the 
model display during tracking. The model 
display option is only effective when 
changing the view of a model, such as 
when rotating or panning.

To change the model display during 
movement, choose the setting you want 
from the pop-up menu. The pop-up lists 
choices from fastest to slowest.
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Set the number of levels of undo in the Undo 
Preferences dialog.
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eam Compatible

r 3D allows you to use a different 
ng mode for each map type; 
er, this is rarely practical. Usually, 

ant all maps applied to an object 
the same mapping mode. This is a 
ment for detailed models you 

 to export to Ray Dream Studio.

u want all maps to use the same 

ping mode, enable the Ray Dream 

patible option. 

Ray Dream Compatible is enabled, 
 mapping options for the first map 
ply to a model. Painter 3D 
atically assigns this mapping mode 
ubsequent maps. 

then change the mapping mode for 
ap, Painter 3D updates all maps to 

 mode. 

Ray Dream Compatible to create models 
 use in Ray Dream Studio.
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Fully Textured Rendering

The model appears rendered with all 
surface maps. This is a 
computation-intensive display mode. 
Updating and tracking will be slower. 
Some systems might not be fast enough to 
work comfortably in this mode.

Shaded Non-Textured Rendering

The model appears with solid surfaces, 
but no surface maps. 

New Model Rounding Factor

The rounding factor lets you add a degree 
of convexity or concavity to flat faces of 
the Painter 3D primitives you create.

The valid range for rounding is -1 to 1. 
When the rounding factor is zero, models 
have perfectly flat faces.

Negative values make the flat faces appear 
slightly concave; positive values make the 
faces appear convex.

Background Color

The color of the Model window 
background is displayed on screen and in 
the final rendering. Sometimes a 
light-colored object is easier to view on a 
dark background and vice-versa.

To change the window background 
color:

1. Click the Background Color swatch. 
Painter 3D opens the system color 
picker. 

2. Choose a color for the window 
background. Model renderings will 
use this background color.

Mesh Color

The mesh is an optional overlay of 
mapping vertices on image files. The mesh 
makes it easier to paint on map image 
files. Its color should contrast the colors in 
the map image, so the mesh is easier 
to see.

To change the mesh color:

1. Click the Mesh Color swatch. 
Painter 3D opens the system color 
picker.

2. Choose a color for the mesh.
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ng Options

emory for Printing increases 
g speed by writing the active image 
, increasing the amount of memory 
le for the print manager and the 
 driver.

nt Banding disables print banding 
ices that support it. Disabling print 
g may help some PostScript 
s, but will hurt the performance of 
itmap printers, such as the 

tt-Packard DeskJet printers. Most 
trix printers are faster with No 
anding left unchecked in the 
 If you experience problems 
g in landscape orientation, you 
ve to turn off banding by checking 
io button in the dialog.

ay Option

 video display driver is set to 65,000 
 you may experience some color 
arities on your screen when using 
r 3D. Checking No Device 
dent Bitmaps corrects this problem 
ost 65,000-color video displays. If 

e not using 65,000 colors, this 
ox has no effect on your system.
This option may also be useful for other 

applications that require the same 

mapping type for all maps

If you intend to export your Painter 3D 

model to Ray Dream Studio, enable the 

Ray Dream Compatible preference 

before applying the second and 

successive maps. 

Preferences for Windows

The preferences described in this section 
are for computers running Windows 95 or 
NT 4.0.

Choose Edit menu> Preferences> 
Windows to display memory and printing 
options. 

Physical Memory Usage

For best performance, choose Maximum 
Memory for Painter 3D and run 
Painter 3D with no other programs 
running in the background. Choosing 
Half Memory for Painter 3D allows 
Painter 3D to run more efficiently with 
other Windows applications running at 
the same time.
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Overview

It’s most likely that you’ll use Painter 3D 
in conjunction with other programs. 
Using Painter 3D with other programs 
falls into these four general categories:

• Saving the maps you’ve created in 
Painter 3D and applying them to 
models within another 3D 
application. 

• Exporting the model (in standard 
formats) with its attached maps and 
placing it into a scene in another 3D 
application. 



                  

rting Models and Maps 
 Painter 3D

 

er method of working with models 
ter 3D is to import the model from 
r application, paint it, then save 
port both the model and its maps 
 your 3D application.

 

e and export a model and maps to 
r application:

  

 your 3D application, save the 
del you want to paint in a file 
mat compatible with Painter 3D 
BJ, 3DMF, VDU, P3D, DXF, 

 3DS).

  

oose 

 

File menu> Acquire

 

 to open 
 model in Painter 3D.

  

eate the surface maps, using all the 
inter 3D tools and features at your 
posal.

  

ith the Model window active, save 
 model as a P3D (Painter 3D 
mat) file. Painter 3D prompts you 
save the map images before saving 
 model. 

ving the model as a P3D file lets you 
ntinue to paint the model and maps 
a later time. 
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• Using the application-specific plug-in 
to step seamlessly back and forth 
between Painter 3D and Ray Dream 
Studio or between Painter 3D and 3D 
Studio MAX.

• Saving your maps and renderings as 
2D images and compositing them 
with other 2D image editing 
applications.

The remainder of this chapter describes 
typical scenarios for using Painter 3D 
with various 3D and 2D applications. If 
you don’t find the information you need 
in this chapter, try looking at the FAQs on 
the MetaCreations Web site 
(www.metacreations.com) for solutions 
to your situation.

Saving Maps for Use in 
Other 3D Applications 

You can use Painter 3D to create surface 
maps for models created in other 3D 
applications. With Painter 3D, you can 
choose to save just the maps, then use 
your 3D application to apply the maps to 
your model. 

To save maps and apply them in another 
application:

1. In your 3D application, save the 
model you want to paint in a file 
format compatible with Painter 3D 
(OBJ, 3DMF, VDU, P3D, DXF, 
or 3DS).

2. Choose File menu> Acquire to open 
the model in Painter 3D.

3. Create the surface maps, using a 
comparable projection map type or 
implicit UV mapping. 

4. With the image window active, save 
the maps in a file format compatible 
with your 3D application.

5. Return to your 3D application and 
apply the maps you’ve just created to 
the original object.

If the results from applying your maps to 
your model are not what you expected, 
you may need to return to Painter 3D and 
adjust various options, such as the 
mapping type or orientation. In some 
cases, you might need to just flip the map 
along its X or Y axis. (This is usually the 
easiest way to fix maps where the text 
appears incorrectly.) You can do all these 
tasks easily in the expanded Maps 
Manager palette. 
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ing with Bryce 3D

 

3D is an easy-to-use 3D animation 
tion from MetaCreations. With 

3D you can create incredible 3D 
 with realistic perspective and 
g.

n import DXF, 3DMF, or OBJ files 
ture maps into Bryce 3D. 

 

 3DMF Files

 

r 3D accepts 3DMF objects 
ucted of meshes, triangular grids, 
angles. 

r 3D does not support 3DMF 
ural primitives. Models that 
e a box, cone, disc, ellipsoid, torus, 
atch, polygons, and general 
ns will not import correctly. The 
ported objects are discarded.

you’ve created your models and are 
ing them for export, choose 
s that force them into meshes or 
lar grids. Meshes are preferred. 
bjects provide smaller files and 

quality. Smaller files open more 
y.

r 3D supports general matrix 
rms (scale and translate). 

r 3D ignores all other transforms.
U

5. Export the model by choosing File 
menu> Export. Choose a file format 
compatible with your 3D application.

6. Return to your 3D application and 
import the model and maps.

Some file formats save certain portions of 
map information but not others. For 
example, OBJ saves texture map 
information with the model file but does 
not save bump map information. 
Depending on your 3D application, you 
may need to apply the maps as separate 
images. 

If your 3D application only accepts 

texture maps, you can use Painter 3D’s 

features to simulate texturing in 2D. For 

example, use the Apply Surface Texture 

effect or the Impasto plug-in floater. 

Refer to the online book, Painter 3D 

Advanced Guide, for more information.

Working With Models from Poser

MetaCreations Poser provides direct 
figure manipulation, letting you use 
models of realistic human figures in your 
3D applications. You can use Painter 3D 
to create surface maps for 3D human 
figures you create in Poser.

To bring Poser models into Painter 3D:

1. In Poser, save the model in OBJ 
format.

2. Choose File menu> Acquire> 
Wavefront OBJ to open the model, 
then create whatever surface maps 
you like. 

3. When you’re through, save the maps 
as PICT files (Macintosh) or TIFF or 
BMP files (Windows).

4. Return to Poser and open the model, 
then apply the PICT images as surface 
maps. If you’re planning to bring your 
Poser image into another 3D 
application, save the image files in a 
file format compatible with your 3D 
application.

If you bring your Poser model into 

another 3D application first, then try to 

use the model in Painter 3D, the results 

may not be satisfactory. Surface maps 

might distort in unpredictable places. 

To avoid this, it’s best to work directly 

between Poser and Painter 3D, then 

place your finished, painted model into 

your 3D application. 
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ial Features for 
als

 

ormal” is the angle perpendicular 
surface of the object at a given 
Certain rendering effects take 
age of the normal data.

r 3D offers several commands for 
ng an object’s normal vectors. 
features may be useful with certain 
ted models. 

commands are on the Controls: 
 Selection palette. To use them, the 
 window must be in front.

 

 Normals

 

ported model may have normals 
int the wrong way. This causes 
o shine on the far side of the 
 instead of on the side nearest the 

 

rt normals:

  

lect an object in the Model window.
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Importing 3DMF Models

When you import a model, Painter 3D 
converts the 3D information to its native 
format. This is necessary to work with the 
model in Painter 3D.

The 3DMF format supports object 

hierarchy—objects may be collected in 

groups, and the groups may be 

collected in larger groups. Painter 3D 

maintains the hierarchy, which you can 

view in the Objects 3D palette: 

Hierarchy list.

Map Assignment

The 3DMF file format “understands” only 
texture maps. Painter 3D, however, 
supports six different map types. 

3DMF allows multiple maps per object, 
but the format imposes no standard on 
which map fulfills what purpose—that’s 
up to the application that created and 
saved the maps. There’s no way to tell 
which map is what type, so Painter 3D 
uses the last in the list as the texture map. 
The other maps remain unassigned. You 
can reassign them in Painter 3D.

A similar condition may exist on export in 
3DMF format.

Shared Maps

In 3DMF, multiple objects may share a 
single map. If you import a 3DMF model 
with multiple objects sharing a map, 
Painter 3D copies the map for each object.

Using DXF Files

There are a few things to know about 
using DXF files:

• The DXF file format supports 
geometry only—no maps.

• DXF models have no vertex normals, 
so you’ll need to smooth them after 
import.

• Painter 3D’s import function doesn’t 
support “instancing,” meaning that 
although DXF allows multiple 
instances of a single object, Painter 3D 
imports only one each.
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grees). This helps you avoid 
oothing corners that should be 

arp.

  

ecify an angle in the dialog, then 
ck OK. Painter 3D smooths the 
rmal vectors for the entire model. 

 

g the Plug-in With Ray 
m Studio and 3D Studio 
 

 

r 3D comes with two important 
s: one for Ray Dream Studio and 

r 3D Studio MAX. The plug-in lets 
ove easily back and forth between 
r 3D and either of these two 3D 
tions, without having to go 

  

orted DXF model, before and after 
ing.
U

2. In the Controls palette: Object 
Selection tool palette, click Invert. 
Painter 3D inverts the object’s normal 
vectors. 

Repair Normals

Some models may have inconsistent 
normals—that is, a few normals may have 
the wrong angle. This problem can be 
seen on an imported model as triangular 
areas of contrasting color. 

To repair normals:

1. Select an object in the Model window.

2. In the Controls: Object Selection 
palette, click Repair. Painter 3D makes 
the object’s normal vectors point in a 
consistent direction. 

Smooth Normals

When vertex normal vectors are not 
present (on imported DXF models, for 
instance), the model appears heavily 
faceted. Smoothing corrects this. 

To smooth normals:

1. Select an object in the Model window.

2. In the Controls: Object Selection 
palette, click Smooth. 

A dialog appears that lets you limit 
smoothing to angles flatter than a 
specified value (the default is 45 
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s and Floaters

 

reading in a Photoshop file with 
 each layer is automatically 
ed and converted to a Painter 3D 
floater with the appropriate 
y.

hotoshop 3’s layer blending modes 
ported by Painter 3D. However, 
hop 4’s new blending modes are 

pported. These blending modes are 
ted to Painter 3D’s “normal” 
d on open. Due to differences in the 
otoshop and Painter 3D deal with 
onversions, a few blending modes 
ok slightly different in Painter 3D 
 Photoshop. Once brought back to 
hop, the file will look as it did 

 it was brought into Painter 3D. 

r 3D’s “Pseudocolor” compositing 
d is not supported in Photoshop. 
ocolor” is mapped to Photoshop’s 
al” compositing method. Note that 
ter 3D, “Normal” and “Default” 
ds are identical. “Normal” is 
ed for compatibility with 
hop. 

hop’s user-defined layer masks are 
atically consolidated in the image 
’s visibility mask. When you bring 
age back to Photoshop, the layer 
 will have been combined with the 

itable transparency mask for each 
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through the tiresome steps of saving and 
importing and exporting to see your latest 
changes. 

The Painter 3D CD-ROM contains both 
these plug-ins. Read the online 
documentation for instructions on how to 
install the plug-ins and use them with 
your Ray Dream Studio or 3D 
Studio MAX.

Using Painter 3D 
Renderings in Other 
Applications 

Often you’ll want to composite the image 
of your rendered model with other 
imagery. The mask Painter 3D creates in 
the rendering makes compositing easy. 

To setup your rendering for 
compositing:

1. Render an image from the Model 
window and save it in a format that 
retains the mask: TIFF, RIFF, or 
Photoshop.

2. With the image open in Painter 3D, 
set the Selection Draw mode to Draw 
Inside. The selection marquee appears 
around the model shape.

3. Choose Edit menu> Copy.

4. You can now move to another file and 
paste the floater.  

Photoshop Compatibility

Painter 3D reads and writes image data in 
the Photoshop file format. The following 
descriptions cover how the several 
document elements are handled.

Unless otherwise stated, “Photoshop 

format” refers to both version 3.0 

and 4.0.
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U

layer. In addition, Photoshop’s ability to 
clip layer data to the layer below is not 
supported by Painter 3D.

When saving Painter 3D documents as 
Photoshop files, each Painter 3D floater is 
converted to a Photoshop layer. Plug-in 
floaters are committed so that they may 
appear in Photoshop layers. Opacity and 
composite methods are maintained 
whenever possible. Grouped floaters 
become separate Photoshop layers.

Rulers, Guides, and Grid

Painter 3D uses the ruler, guide, and grid 
information when opening Photoshop 4.0 
documents. Likewise, Painter 3D saves 
this data in Photoshop 4 format, so it will 
be available to Photoshop.

Adjustment Layers

Painter 3D does not support adjustment 
layers. This data is dropped when 
Painter 3D opens a Photoshop 4 file.

Channels and Masks

When reading a Photoshop with channels, 
Painter 3D converts channels #4 and 
above to user masks. When saving a 
Painter 3D document with user masks as a 

Photoshop file, the masks are saved to 
channels #4 and above in the Photoshop 
file. 

Painter 3D does not support transparent 
images. Therefore, when you open a 
transparent Photoshop file, Painter 3D 
automatically creates a blank background 
on which all the layers will sit.
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Painter 3D lets you paint and develop 
surfaces on three-dimensional models. 
Naturally, before you can do this you need 
a model. You can open or import models 
you’ve created in another application, or 
you can create a primitive, single-object 
model right in Painter 3D. 

A 3D model is a file comprised of one or 
more 3D objects. In Painter 3D, the model 
can have hundreds of objects, and each 
object can have a different set of surface 
maps and properties. For example, a 



             

t the dimensions and tolerance for 
e model and the width and height 
r the Model window. 

mensions: Enter dimensions that 
scribe the size of the model you 
nt. The dimensions required 
pend on the model type.

lerance: Painter 3D models are 
nstructed of triangular faces. The 
lerance setting allows you to 
ntrol the number of triangles used 
 approximate curved surfaces in the 
odel. 

  

 model type in the New Model dialog.
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wooden handle, corkscrew, and attached 
cork are three separate objects, but can be 
grouped as a single model. 

Painter 3D can create primitive objects. 
Painter 3D also comes with a catalog of 
interesting models you can work with. 
Most times, you’ll probably use 
Painter 3D with models you’ve created in 
other applications (like Ray Dream 
Studio), then imported into Painter 3D. 

The remainder of this chapter discusses 
how to create, open, and import models. 
It also describes how to work with models 
in Painter 3D.

Creating a Primitive Model in 
Painter 3D

You can have Painter 3D create very basic 
3D models for you. Painter 3D primitive 
models are single objects; you cannot 
group multiple Painter 3D primitive 
models together. 

To create a primitive model in 
Painter 3D:

1. Choose File menu> New Model. 
Painter 3D displays the New Model 
dialog. 

2. Choose the model you want: Box, 
Sphere, Cylinder, Cone, Cup, 
Ellipsoid, or Torus.
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n a Painter 3D model:

  

oose 

 

File menu> Open Model

 

. 
inter 3D displays an Open dialog.

  

vigate to the location of the file, 
ect it, and click Open. 

  

ou’re opening a Painter 3D model 
orted from Ray Dream Studio, 

inter 3D prompts you to choose a 
e for the Model window. Enter 
dth and height values for the size 
del window you want. 

 3D open all maps and images 
ted with this model. However, if a 
 been moved or renamed, 
 3D won’t be able to load it. In this 

ainter 3D displays a dialog giving 
hance to locate the missing file. If 

ncel the dialog without selecting an 

   

nd open a model file.
• Coarse creates the fewest triangles. 
This might lead to irregularities in the 
renderings. 

• Medium creates more triangles than 
the Coarse setting, but not as many as 
Fine.

• Fine creates the most triangles, which 
assures a clean image. 

The more triangles used, the smoother 

the curve. However, more triangles 

increase memory demands and may 

slow down some operations.

Width and height values: Enter values for 
the size Model window you want. You can 
get closer to the model by zooming in 
with the Magnifier tool, so a large window 
may not be necessary.

The dialog shows how much RAM is 
required for the window specified. 
The 3D view or Model window 
requires at least 64 bytes per pixel. A 
larger window requires more RAM 
and updates slower on screen. 

4. Click OK. Painter 3D opens the 
model in the Model window. 

Opening Saved Models

Models you save in Painter 3D are saved 
in Painter 3D format, also called P3D 
format. You can also export models you 
create in Ray Dream Studio in Detailer 
(VDU) or Painter 3D (P3D) format. (Use 
the special plug-in to work with Ray 
Dream Studio and Painter 3D at the same 
time.)
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Here, the Model window displays a cylinder 
model without any maps applied.
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ect an object:

  

oose the Object Selection tool. 

  

 the Model window, click the object 
u want. The selected object appears 
tlined in red in the Model window. 

 

e object isn’t outlined in red, it may 

hat the Show Selection Indicator 

on is turned off in the Controls 

tte: Object Selection tool. Click the 

 

on to turn it back on.

 

ject Selection tool 

 Object Selection tool to select the object 
nt by clicking. 
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image, Painter 3D opens the model 
without a map, background, or reflection 
environment. 

Opening Models Created in Ray Dream 
Studio or 3D Studio MAX

Use the plug-in that comes with 
Painter 3D to work with Ray Dream 
Studio or 3D Studio MAX models. The 
plug-in lets you work quickly and easily 
between either of the applications and 
Painter 3D without having to save, export, 
and import files between the two 
applications.

Refer to the online documentation on the 
Painter 3D CD-ROM for complete details 
on how to use the plug-in with 
Painter 3D.

Importing Models

Painter 3D lets you import models saved 
in 3DMF, 3DS, DXF, and OBJ formats. 

To import a model:

1. Choose File menu> Acquire and 
select the format of the file you want 
to import. The Import dialog appears.

2. Locate and select the file, then click 
OK.

Once imported, the model appears as any 
Painter 3D model. When you save the 
model in Painter 3D, it is saved in the 
Painter 3D (P3D) format. If you want to 
move the file back to your 3D modeling 
and rendering program, you’ll need to 
export it from Painter 3D. Refer to 
“Exporting Models” on page 65 for more 
information.

The Model in Painter 3D

A Painter 3D model can be constructed of 
many separate objects. Each object can 
have a unique set of maps applied to it.

Selecting an Object within a
Multi-object Model

When you work with a multi-object 
model, you need to select which object 
you want to work on.

When a model is comprised of a single 
object, like Painter 3D’s own primitives, 
that object is automatically selected.
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ain 3D information:

  

oose the Object Selection tool. 

  

ld down the Control key 
acintosh), Shift+Ctrl keys 
indows), and click a point of 
erest on the model. 

inter 3D displays an Object Report, 
ich describes that object’s point on 
 model, its normal vector, and its 

rrelation to the texture map. 

 

 a Base Color for an Object

 

n color an object without applying 
re map. 

  

ject Report provides technical 
tion.
If you try to paint on an object that isn’t 
selected, Painter 3D asks you if you want 
to select it. If you click OK and you have 
already applied maps to the object, 
Painter 3D locates the first map it finds, 
which is either the texture map, if you just 
opened the model, or is the last map you 
edited, if you’re already working with the 
map. If you click OK and you do not have 
any maps applied to the object, Painter 3D 
assumes you want to create a texture map 
and opens the Apply Texture Map dialog.

When you select an object, the Objects 
3D: Objects palette and the Maps 
Manager palette update to show the 
settings and maps, if any are loaded for 
this object. 

The Controls palette: Object Selection 
tool 

The Controls palette: Object Selection 
tool displays technical information 
describing the selected object. 

The minX, minY, and minZ and maxX, 
maxY, and maxZ describe the dimensions 
of the bounding box of this object. The 
bounding box is the smallest box that will 
enclose the object completely.

The Controls palette shows you the 
number of triangles in the surface mesh. It 
also gives you the option to turn the 
selection indicator on and off and it 
provides advanced options for adjusting 
normals.

Getting Technical Information

You can get technical information for a 
particular point on the object. You might 
find this information useful if you need 
precise data about the object point, 
texture point, and so on.
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the object whose properties you 
o adjust. Drag the Diffuse, Specular, 
flection sliders to set levels 
riate to your object’s surface. If the 
s 3D: Objects palette doesn’t show 
ers, expand the palette by clicking 

w box.

 

e

 

iffuse slider controls how much 
lor the object shows.

 

shading properties are set in the 
 3D: Object palette.
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Setting a base color for an object doesn’t 
make sense if you intend to apply a texture 
map to it because the texture map hides 
the base color completely. However, if you 
want the object to have a single, flat color, 
you can set its base color. This is useful if 
you have a multi-object model and you 
only want to create texture maps for a few 
objects.

To give the model a base color:

1. Select the object you want to color.

2. Display the Objects 3D: Hierarchy 
palette. 

3. Choose Objects 3D: Hierarchy 
menu> Set Object Color.

Painter 3D displays the system color 
picker. 

4. Select a color for the object and click 
OK.

To set the base color of an object using 
the Dropper tool:

1. Use the Art Materials: Color palette 
to choose a color. 

2. Select the Dropper tool.

3. Hold down the Option key 
(Macintosh), Alt key (Windows), and 
click the object you want to color.

To give all objects in a multi-object 
model the same color:

1. Choose Objects 3D: Hierarchy 
menu> Set All Objects Colors. 
Painter 3D displays the system color 
picker.

2. Select a color and click OK. 
Painter 3D applies the color you select 
to all objects in the model.

Setting Object Properties

The Objects 3D: Objects palette provides 
controls for an object’s basic shading 
properties. These properties control how 
the object appears under the lights. 
Particular settings help describe the 
object’s substance—whether it is glass, 
metal, cork, skin, or whatever.
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e the Show All Objects command to 
 all the objects associated with the 

 in the Model window.

e the Hide All Objects command to 
l objects associated with the model. 
bject is selected, the red selection 
or remains visible in the Model 
w, even though all objects are 
. 

ggle Visibility command reverses 
ibility state of objects and is useful 
lating parts of the model. For 
le, you may have hidden all objects, 
n turned visibility back on for 
 objects you want to focus on. (You 
sibility on for individual objects by 
g open the Eye icon in the 
chy list.) When you choose this 
and, objects that were visible 
e invisible and vice versa. 

ors for individual objects or for all 
 with either the Set Object Color or 
 Objects Color command. Refer to 
g a Base Color for an Object” on 
1 for more information.

 

jects 3D: Images Menu

 

bjects 3D: Image palette lists all 
mages and gives you information 
whether the images are being used 
s and if they are shared across 
.

   
Specular

The Specular slider controls the object’s 
tendency to show highlights. Highlights 
are the bright spots and streaks that 
appear on an object where light is 
reflected directly.

You can control specularity in regions of 
the object with the highlight mask.

Reflection

The Reflection slider controls the object’s 
tendency to reflect its environment. 
Moving the Reflection slider to the right 
allows more of the environment image to 
appear reflected in the object.

You can control reflection in regions of 
the object with the reflection mask.

Reflection is useful when a good 

reflection map is loaded as the 

environment. If you do not have an 

environment image, Painter 3D uses 

the current pattern. See section “Using 

Maps” on page 67 for more 

information. 

These settings offer combinations for 
achieving different surfaces:

The Objects 3D Palette Menus

The subpalettes in the Objects 3D palette 
(Hierarchy, Images, and Objects) provide 
menus and commands to help you 
identify and keep track of object and 
image relationships. 

The Objects 3D: Hierarchy Menu

The Objects 3D: Hierarchy menu lets you 
change the way the entire model appears 
in the Model window.
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Material Diffuse Specular Reflection

Chalk 100% 0% 0%
Obsidian 0% 100% 0%
Mirror 100% 100% 100%
Plastic 60% 40% 0%

An example of a surface using the obsidian 
combination.



              

 organized! Create an appropriately 

ed folder for this model and save 

mages associated with the model to 

 

 folder.

  

ve the map files to the same 
ation and name each file 

scriptively.

 

u use floaters in your image and 

t to preserve them as independent 

ting objects, you must save in either 

RIFF or Photoshop 3 file formats. 

eep file size to a minimum, use the 

F file format. If you intend to export 

 

r model, use the TIFF file format.

  

hen all images have been saved, 
inter 3D opens a Save dialog for the 
odel. In the Save dialog, enter a 
me for your model and click OK.

 

ng a Model

 

have maps associated with a model, 
r 3D asks whether you want to save 
ps before closing the model. If 
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If an image is being used as a map, it has a 
triangle icon next to its name. Click the 
triangle to see which objects are using that 
map. Images that are open but are not 
being used as a map do not have a triangle 
icon next to their names.

You can choose to view all open images in 
the list or only those being used as maps. 
From the Objects 3D: Images menu, 
choose Show All Open Images, or choose 
Show Maps Only to list just the maps.

The Objects 3D: Objects Menu

The Objects 3D: Objects menu lets you 
change the way individual objects are 
listed in the Object list. The Object list 
shows you the relationships between 
objects and associated maps. Objects with 
maps have a triangle icon next to their 
names in the list. Click the triangle icon to 
expand the list of maps beneath the object 
name.

Choose the Show All Objects command to 
display all the objects associated with the 
model in the Objects list.

Choose the Show Selected Only command 
to isolate a selected object in the Objects 
list. All the remaining objects are hidden. 

Saving a Painter 3D Model

After developing the surface of your 
model, save your work in P3D format. 
You’ll be able to open the model later and 
continue working. Saved models include 
settings for object properties, lights, and 
all references to applied maps, the 
background, and environment. 

A finished Painter 3D model consists of 
several files—the 3D model itself and each 
image file used as a map, environment, or 
background. For the sake of organization, 
it’s a good idea to keep your model with 
its image files in a new folder. 

To save a Painter 3D model:

1. Bring the Model window to the front. 
You can click in the window or select 
its listing from the Window menu. 
Model windows appear at the bottom 
of the menu.

2. Choose File menu> Save. 

If your model has maps associated with it 
that have not been saved, Painter 3D 
requires you to save them now before it 
saves the model. Painter 3D displays a 
Save Image dialog for each image that has 
not already been saved.
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 the special plug-in that comes with 

ter 3D to step easily back and forth 

een Ray Dream 3D or Studio and 

 

ter 3D.

 

sing Painter 3D With Other 
ms” on page 49 for more 
ation on importing Painter 3D 

s in Ray Dream Studio. Additional 
ation is in the Read_Me file in the 
 3D folder and at the 
reations Web site at 
etacreations.com. 

 

e aspects of the Painter 3D model 

ht not apply when you move to a 

rate 3D program. Lights are 

arded and the background image 

 environment map might be 

arded unless your program accepts 

images for these effects. If so, you 

 create these aspects of the scene 

 

ur 3D scene-building program. 

 

 3D can export models in several 
s. 

vefront OBJ

ickDraw 3D, also known as 3DMF 
there are no masks associated with the 
model, Painter 3D asks whether you want 
to save the model before closing it.

To close a Painter 3D model:

1. Bring the Model window to the front. 

2. Click the window’s close box, or 
choose File menu> Close. If you 
don’t want to save the model or any of 
its maps, click Don’t Save.

3. If you want to save any associated 
maps and the model, click Save. 
You’re prompted for a name and 
location for each map and the model.

Exporting Models

Painter 3D is a powerful tool for 
developing surfaces on 3D models. 
Painter 3D lets you render a model, but 
you’ll probably want to move your 
finished models to a full featured 3D 
program for assembling in a 3D scene and 
rendering. 

Ray Dream 3D and Ray Dream Studio are 
examples of 3D programs. They offer 
advantages that Painter 3D doesn’t, 
including:

• You can create a scene with numerous 
models.

• You can develop sophisticated lighting 
and rendering effects, like shadows, 
luminous objects, and translucence.

• You can achieve different perspective 
effects with an adjustable camera.

• You can create animations in Ray 
Dream Studio or Ray Dream 3D.

These are only a few of the benefits you 
get from moving your Painter 3D models 
to a scene-building and rendering 
program like Ray Dream 3D or Ray 
Dream Studio. 

Ray Dream 3D and Studio can import 
models saved in Painter 3D format. The 
model retains its surface properties and all 
of the maps applied to it. When you 
import the model in Ray Dream Studio, 
all of your details, including the alignment 
of the maps, remain intact.

For models created in Ray Dream 3D or 
Studio, you have the option of importing 
just the maps and shading from 
Painter 3D. Ray Dream automatically 
applies the maps to the existing model 
objects.
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• 3D Studio (R4), also known as 3DS

• DXF

To export a Painter 3D model:

1. Open the model you want to export.

2. Choose File menu> Export and 
select the format you want to use. An 
Export dialog appears.

3. Choose a location to save it to and 
name the file. 

4. Click OK. Painter 3D exports the 
model file. 

You can now import the model to your 
other 3D program.

Painter 3D has an extensible 

architecture for 3D file formats. Plug-ins 

for import/export in other 3D formats 

may become available. Visit the 

Painter 3D area of 

www.metacreations.com for updated 

information.
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A model is a 3D file made up of one or 
more objects, and each object can have a 
different surface. The combination of 
applied maps gives an object its overall 
surface, also known as shading. Shading 
is the set of characteristics that give an 
object its appearance—color, surface 
relief (bump), shininess, and so on. 
Shading is apparent when the object is 
rendered or when viewed in the Model 
window, which always renders your 
objects in real time. 

For example, a model of a cork screw and 
cork might be constructed of three 
objects—the cork, the screw, and the cork 
screw handle. Each of these objects would 
have a different set of maps and surface 



          

atures). Bright areas of the bump 
ppear recessed in the rendering and 
reas appear raised. 

n invert the map with the Negative 
y option on the Maps Manager 
.

portant to note that the actual 
of the object doesn’t change—only 
pearance of the rendered surface. 
lhouette edges of the object are not 
d by the bump map.

mp effect is created by the 
tion of light and the bump map. 
nt lighting conditions change the 
ance of the bump. See “Light 
s the Third Dimension” on page 96 
re information about using light to 
ut surface relief.

tinue with the chimney example, 
n use the same brick image in the 
 map as you did in the texture map. 

   

mp map.
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properties that describe its 
material—cork, chrome, and wood, 
respectively.

About the Six Maps

In Painter 3D, you color and texture 
objects by wrapping them with 
two-dimensional images, called maps. 
You can create up to six maps for each 
object to describe its surface attributes. 
“Map channel” is another term used to 
describe one of the six map types for a 
single object.

Each map consists of a single 2D image 
you apply to the object. Of course, for 
each object you can leave one or more 
channels empty.

The Maps Manager palette lists the maps 
for the selected object. 

Texture Map

The texture map gives the object color. 
For example, a pattern of red bricks 
mapped onto a box-shaped object turns 
the box into a chimney. 

The texture map adds color, not 

physical texture. This might be 

confusing at first, but it’s the standard 

3D graphics term for this map type. 

Bump Map

The bump map creates surface relief, like 
the rough terrain of tree bark. The bump 
map can be a grayscale image. When the 
program renders the object, the bump 
map deflects the light (in the model 
space) according to its imagery (light and 
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tion Mask Map

 

flection mask map controls the 
t of reflection for different areas of 
ect. Reflectivity is only interesting 
he environment (the object’s 
ndings) appears in the reflection. 
ter 3D, you apply an image in the 
ment map channel to be reflected 
nvironment.

ject has an overall reflection 
t, set with the Reflection slider on 
jects 3D: Object palette. The 
on mask lets you control the 
t of reflection for specific areas on 
ect. 

tinue with the wine bottle example, 
ss bottle should be reflective, but 
er label shouldn’t be. In the 

on mask image, use a black 
le that matches the size and 
n of the color label to eliminate 
on in the area covered by the paper 

  

ection mask map.
When applied to the bump map channel, 
the image creates the appearance of 
recessed mortar lines between the bricks.

You can also use the bump map to add 
wrinkles, crinkles, moles, dimples, and 
scars to the face of the bricks.

After loading a Bump Map, you can adjust 
the level of bump. At the bottom of the 
Maps Manager palette, the Bump Map 
Adjustment: Amount slider lets you 
control the height and depth of the bump 
features. Dragging the slider to the right 
increases bump depth. 

Painter 3D renders the new bump settings 
to the Model window in real time, so 
you’ll get immediate feedback on your 
depth adjustment.

Highlight Mask Map

The highlight mask map controls the 
amount of specularity (shininess) for 
different areas of the object. Highlights 
are the bright spots on an object where 
the light is reflected directly. 

The object has an overall highlight 
amount, set with the Specular slider on 
the Objects 3D: Object palette. The 
highlight mask lets you control the 
highlight amount for specific areas on the 
object. 

For example, say you’re developing a 
model of a wine bottle. You use the 
texture map to place a rectangular label 
on the bottle. The object should have a 
strong highlight on the glass, but much 
less on the paper label. In the highlight 
mask map channel, use a dark rectangle 
that matches the size and position of the 
label in the texture map to reduce the 
highlight on the paper label.
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ghout this section, “painting on the 
” refers to creating images in any of 
 map channels. Remember that the 
f an image on the model depends 

 map that it’s in. In the texture map, 
ed brush stroke puts color on the 
. That same stroke in the bump 
ight cut a notch in the model. 

ethod and features for developing 
 are the same, regardless of the 
n the model. Tools and techniques 

ating images are described in 
loping Images” on page 103, in 
ing With Painter 3D’s Brushes” on 
17, and in “Working With Art 
ials” on page 133. The online book 

 

r 3D Advanced Guide

 

 also contains 
ation about creating images.

 

ale Images 

 

ing to keep in mind as you develop 
y for a given map is what 

r 3D does with the image. For the 
 map, reflection mask, and highlight 
Painter 3D uses only the pixel 
ance values to control shading. Hue 
turation are ignored. 

eans that the bump map, highlight 
ap, and reflection mask map can 

yscale, which gives 256 value 
s. Black is the lowest value, white is 
hest. 
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Glow Map

The glow map applies additional color on 
top of the other maps’ effects. Glow is a 
special effect that is particularly useful for 
objects that actually produce light, like 
light bulbs, LEDs, and CRTs. For example, 
a red LED on a control panel looks red, 
even when there are no other lights in the 
scene. A little airbrushing of color in the 
right spot of the glow map helps you 
create this effect—without interfering 
with your texture map.

Painter 3D applies the glow map after the 
other maps. This means that an area 
darkened by other shading effects will 
receive uniform color from the glow map.

The glow map applies color to the 

object. It does not create a light source 

within the object. If you want an object 

to actually cast light onto other objects, 

you’ll need to work with it in a 3D 

rendering program.

Environment Map

The environment map is an image that 
appears in the reflective areas of an object. 
The Reflection slider in the Objects 3D: 
Objects palette determines how much of 
the image is reflected onto the object. 

You can use an environment map in 
connection with a reflection mask map. 
Areas of the object that you set up with 
high reflectivity will reflect the 
environment map. Areas with limited 
reflectivity will not.

Combining environment maps with 
reflection settings requires some 
additional explanation. Refer to 
“Reflection Mapping” on page 86 for 
more information about environment 
maps.

About Images in the Different 
Maps

In Painter 3D, you create images for the 
six map types using the brushes, effects, 
and other image creation features. 
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 that the Maps Manager palette 
s to show that a map is loaded. You 
d additional maps by 
-clicking the map type you want in 
p listing.

 

u choose the Brush or Paint Bucket 

and start to paint on an object that 

n’t have a map, Painter 3D 

 

lays the Apply Map dialog.

  

 a map, double-click the map type in the 
anager palette.
As a consequence, the bump map image 
can describe up to 256 levels of bump 
elevation. And the highlight or reflection 
mask images can describe up to 256 levels 
of mask density. The darker the pixels in 
the image, the greater the masking effect 
on the object.

Applying Maps

Once you’ve selected an object, you can 
apply one or more images for the surface 
maps. The Maps Manager palette holds 
the central controls for working on maps. 

The process of applying a map to an 
object is the same regardless of which of 
the six map types you apply. When you 
first create a map, you must provide 
Painter 3D with parameters of 
information.

To apply a map to an object:

1. Display the Maps Manager palette by 
choosing Window menu> Show 
Maps Manager.

2. Select the object you want to work 
with.

3. Choose Map menu> Load> and 
select the map type you want 
(Texture, Bump, Highlight, 
Reflection, Glow, or Environment). 

Or

Double-click the map type in the 
Maps Manager palette.

Painter 3D displays the Apply Map 
dialog.

4. Choose the map source and content, 
the image size, the mapping type, and 
the orientation. (The next several 
sections provide information about 
the choices in this dialog.) 

5. Click OK. 

Painter 3D opens an Image window to 
display the new map. If you based the new 
map on an image or material, the image 
or material fills the Image window and is 
mapped onto the model in the Model 
window.
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chnical Considerations for 

igning Maps” on page 87 for more 

 

rmation.

 

ng an Image into a Map

 

 you apply a map, you can choose to 
 saved image file as the basis for the 
ap. In the Apply Map dialog, the 
Image option lets you open a saved 
file. When you select this option, 
r 3D displays an Open File dialog so 
n locate and select the file you want.

r 3D opens a number of popular 
formats. When you open a RIFF file 
er and Painter 3D’s native format), 
aters remain floating. You can 
scale, distort, and rotate these 
g images.

open a Photoshop 3.0 file, the layers 
verted to floaters. Photoshop files 
me technical considerations. See 
 Painter 3D With Other Programs” 
e 49 for more information.

 

g an Image into a Map

 

 you apply a map, you can choose to 
n image from another open map. In 
ply Map dialog, the Copy image 
p lets you choose any open image 
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Determining the Map Source

There are various ways to specify the 
image you create for the map. You can 
start with a new canvas, use existing 
images, or use an art material as the basis 
for a map.

Making a New Image

When you create an entirely new image, 
you can start with a blank canvas or fill 
the image with the current pattern or 
paper texture. 

Blank

If you want to start with a blank canvas, 
select Blank in the Apply Map dialog. 
Painter 3D displays fields that let you set 
the dimensions for the new image. Enter 
the dimensions you want, then click OK. 

Current Pattern or Paper Texture

If you want to use a pattern or paper 
texture, you can use the Art Materials 
palette to choose a pattern or paper 
texture and set options for it. 

Painter 3D lets you select your pattern 

or paper texture from the Art Materials 

palette while the Apply Map dialog is 

open.

Patterns and paper textures “tile” over the 
image area. Tiling describes how a 
rectangular image repeats to cover a larger 
area, like squares of linoleum covering a 
kitchen floor.

When you select one of these options, 
Painter 3D displays text fields that let you 
set the number of horizontal and vertical 
“repeats” (the number of tiles in each 
direction).

By default, Painter 3D suggests 2 x 2, 
which means that four tile images will be 
used in the map. The image size will equal 
the paper texture or pattern dimensions. 
Enter values to describe how many tiles to 
use horizontally and vertically. 

To avoid distortion when Painter 3D 

maps the image onto the object, you’ll 

want to use a specific number of 

repeats in each direction. See 
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d” with the active map on top. You 
en a new view if you want to see 
ps for the same object in two 

nt windows.

g an Image window’s close box, in 
hides that Image window. The 
window still remains attached to 
ect. You can select one of the Image 

’s maps in the Maps Manager 
 and the Image window will 
ar.

 

or Creating New Images

 

reating excessively large maps. The 
age files must remain open while 

painting the model. Larger images 
e the demand for RAM.

 (higher resolution) images increase 
n the model; however, the 

ing process limits the detail that 
s in the final image. This means 
ere’s a point beyond which 
ing map resolution does not lead 
er detail in the final rendering. 
er, if you are planning for high 
ion rendering, you should use a 
 map of at least the planned 
ing resolution.
file as the basis for the new map. Use the 
pop-up to select the name of the open file 
you want to copy. 

If the document you select contains 

floaters, they are dropped (merged with 

the canvas) into the copy. 

Copying an open image is often quite 
useful. For example, if you have a texture 
map applied, you can create bumps that 
enhance the imagery in the texture map. 
By copying the texture map, you have the 
perfect starting point for developing the 
bump map because the bumps can 
precisely correspond to the brush strokes 
and materials in the texture map.

Likewise, copying the texture map helps 
in developing a highlight or reflection 
mask. You can see which areas need to be 
masked, and you can edit the image 
appropriately. (Tracing paper is also 
useful in this regard. Tracing paper is 
discussed in the online book, Painter 3D 
Advanced Guide.)

Sharing an Image

When you apply a map, you can choose to 
share an image already assigned to 
another model or a different type of map. 
In the Apply Map dialog, the Share Image 

pop-up lets you choose any open image 
file as a basis for the new map. Use the 
pop-up to select the name of the open file 
to share. Sharing is different from copying 
because all shared maps continue to 
update all shared versions simultaneously 
in the Model window while a copied map 
will not affect the original.

When sharing maps, the maps must be 

of equal size and have the same 

mapping type.

Image Dimensions

The dimensions of the image you map 
onto the object can be critical in avoiding 
distortion. You’ll need to use an image 
with an aspect ratio appropriate to the 
selected mapping mode and object scale. 
Checking the Minimal Distortion option 
helps avoid aspect ratio problems. See 
“Technical Considerations for Designing 
Maps” on page 87 for important 
information on designing surface maps 
with the correct aspect ratio.

The Image Window

Maps applied to a model appear in an 
Image window. The maps for a single 
object appear in one Image window, 
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F) models have implicit UV 
nates. All of Painter 3D’s own 
ives have implicit UV coordinates. 
odels do not have UV coordinates.

 

ome cases, text used in an implicit 

 may appear in mirror image. This 

 result of the object’s construction 

 UV coordinate system. You can 

st for this difference by using the 

 X and Flip Y buttons in the Maps 

 

ager palette.

 

it is not a projective mapping 
d. It usually provides the best 
 on objects containing UV 
nates. You’ll probably find implicit 
ng most useful for objects that bend 
ard on themselves or that contain a 

  

 the mesh to view the implicit mapping 
ates in the map window.
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Choosing a Mapping Type

As you apply a map to an object, you set 
various options to affect the way the map 
wraps around the object. You set these 
options in the Apply Map dialog.

The word “mapping” refers to the method 
Painter 3D uses to transfer the 
two-dimensional image to the surface of 
the 3D model. Painter 3D offers five 
mapping modes. Each mode has benefits 
for certain types of models and map 
images. 

If you are using the Ray Dream 
Compatible option as your model 
preference, the Apply Map dialog appears 
only for the first map you apply to an 
object. All subsequent maps automatically 
inherit the mode setting of the first map. 
See “Model Preferences” on page 45 for 
more information on the Ray Dream 
Compatible model preference.

The mapping mode you use and the 
dimensions of the object determine the 
optimum aspect ratio for the map image. 
Using the correct aspect ratio minimizes 
distortion. By default, Painter 3D suggests 
an aspect ratio that will minimize 
distortion.

Tip: To view the distortion of a mesh on 

the object, display the mesh using the 

Maps Manager, then click the Drop 

Mesh button. This converts the mesh 

display to actual pixels on your image 

so you can see how the mesh 

translates to the 3D view. Save your 

image before trying this 

experiment—dropping a mesh cannot 

be undone.

Implicit

Implicit mapping assigns points on the 
map to points on the object and tightly 
wraps the image onto the model by lining 
up these points. 

The object must have implicit UV 
coordinates defined in its geometry to use 
implicit mapping. Exported Ray Dream 
Studio models have implicit UV 
coordinates. Some Quickdraw 3D 
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 used in spherical mapping should 
roximately twice as wide as they are 
is helps minimize distortion. 

  

rid in the texture map to display the 
latitude and longitude of the facets on the 
The spherical mapping method projects 
es into a rectangular grid.
See “Changing the Aspect Ratio of a Map 
Image” on page 93 for information on 
determining the optimum aspect ratio for 
images used in implicit mapping.

About Projective Mapping

All of the map types other than implicit 
use various ways of projecting the images 
onto the objects. Each of the projective 
map types—cylindrical, spherical, 
cubical, and pass-thru—give very 
different results. To become more familiar 
with the map types, try experimenting 
with applying the same map to the map 
object using different map types.

See “Technical Considerations for 

Designing Maps” on page 87 for 

information on determining the 

optimum aspect ratio for images used 

in the various projective maps.

Cylindrical

Cylindrical mapping wraps the image 
around the object horizontally. This 
projective mapping method is ideal for 
lathe-type objects, like cans, cups, cones, 
and vases. 

Spherical

Spherical mapping wraps the image 
around the object horizontally and 
vertically. This projective mapping 
method is useful for spheres, ellipsoids, 
eggs, and other rounded objects. 

Images
be app
tall. Th

Apply a grid to the texture map image by 
choosing Effects menu> Esoterica> Grid Paper. 
This displays the mapping method on the model 
and helps you determine if there is distortion.

Map a g
lines of 
sphere. 
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e object is closed, someplace on 

surface the map stretches and 

 

bles back.

 

imes it’s helpful to disable 
rapping of maps (also known as 
round colors) when using 
ru mapping. By default, if you 
ff the edge of the map, the stroke 
s on the opposite side. To 
rarily disable this behavior, 
ck the Map Wrap UV option in the 

ed Maps Manager palette.

 

 can only have one type of each 

 per object. To use two mapping 

es for one map type, use two 

cts. For example, cylindrical 

ping does a great job on the 

umference, but distorts the image 

he top and bottom. To apply a map 

he top of a cylinder as well, place 

ppropriately sized disk (a separate 

ct) on the end of the cylinder and 

 it with pass-thru mapping. You can 

 use Implicit mapping on an object 

 

 supports it.
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Cubical

Cubical mapping folds the image to cover 
each box face. This projective mapping 
method is used for boxes.

To take full advantage of cubical mapping, 
you’ll need to create a map in the correct 
aspect ratio for the dimensions of your 
box and know which regions of the image 
are folded (mapped) onto which faces of 
the box. Refer to “Technical 
Considerations for Designing Maps” on 
page 87 for an explanation of which map 
regions correspond to which box faces.

Pass-thru

Pass-thru mapping passes the map 
through the object, leaving imagery on 
the surfaces. Pass-thru is a projective 
mapping method, useful for flat objects, 
like walls, and for creating wood grain. 
This is similar to what happens when you 
shine a slide projector on an object. 
Pass-thru mapping is directional. The 
angle at which the projector shines is the 
angle of pass-thru.

In pass-thru mapping, the image appears 
on the distant side (from the angle of 
pass-thru) as well. On the distant side, 
you’ll see a mirror image of what appears 
in front.
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the cubical mapping method.

An example of pass-thru mapping. The model is 
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e model, but remains onscreen as 
age window, which you can then 

y clicking the window’s close box. 

you detach a map, the Image 
 might not appear to change, 

ing on the imagery in the maps or 
aps are displayed on the model. If 

ve obviously different imagery in 
ferent maps, and you detach one, 
ive image disappears and the 
ing image appears in the Image 
. If you have two similar maps 

er, you might not notice the first 
disappearing because it appears so 
 to the second. Check the map list 

aps Manager palette to be sure 
ve the set of maps you want.

 

a map using the Detach button in the 
3D: Objects palette. 
Orientation

The Orientation options in the Apply 
Map dialog let you choose where the map 
begins on the object. If you need to adjust 
the map later, you can do so in the Set 
Mapping Options dialog.

Align with Coordinate Axes

Painter 3D orients the map according to 
the object’s construction axes. You can get 
information on the object by selecting it 
with the Object Selection tool and looking 
in the Controls palette.

Align with Current View

Painter 3D orients the map according to 
the view in the Model window. For 
example, if you choose this option with 
Pass-thru mapping, the image is 
“projected” onto the object from your 
current vantage point.

Align in Register With

Painter 3D aligns this map with the one 
you select in the pop-up. Corresponding 
regions of the two images will map to the 
same area on the model. 

This setting can be quite useful. For 
example, say you use a texture map to put 
a label on a bottle. You want a highlight 
mask to cover the paper label, reducing its 
specularity from the glass surface. With 

the color label in the texture map and the 
dark area of the highlight mask occupying 
the same region of their respective images, 
aligning the one with the other ensures 
that the two features map to the same area 
on the model.

Scale and Origin

Scale and Origin values in the Apply Map 
dialog provide further technical 
information. You can’t change these 
values manually. These values do change 
however, depending on the selected 
mapping mode.

Removing or Detaching a 
Map

At some point, you might want to remove 
or detach a map image. You might even 
want to replace the map with a different 
image. 

To replace a map, simply apply a different 
one. Painter 3D gives you a chance to save 
the map before replacing it.

You can detach a map from an object by 
selecting the image in the Objects 3D: 
Objects palette and clicking the Detach 
button. A detached map is disassociated 
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u can also use the Objects 3D: 
jects palette to open the Set 

apping Options dialog. Click the 
ting for the map you want to 
ange, then click Mapping.

you’re using the “Ray Dream 
mpatible” preference, Painter 3D 
dates all maps for this object to the 
w mapping. 

 

sting a Map

 

pplying a map, you might want to 
 its position on the object. You can 
e map image across the object 
, change its scale, and set its 

ation.

justments available depend on the 
ng mode of this map. (You cannot 
djustment for maps that use 

it mapping.)
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Unlike Painter 3D’s predecessor Detailer, 
you can close a map’s Image window 
without removing the map. Closing the 
Image window has the effect of hiding the 
map. You simply select it in the Maps 
Manager palette to make the Image 
window reappear. The only way to remove 
a map is to click the Detach button in the 
Objects 3D: Objects palette.

Unsharing a Map

If you’ve been sharing maps across 
objects, at some point you might want to 
“unshare” or disassociate them to work on 
them independently. Select the map you 
no longer want to share in the Objects 3D: 
Objects palette and click the Unshare 
button. Unshared images remain attached 
but changes don’t affect prior shared 
images.

Changing Mapping on a 
Current Map

After applying a map, you might realize 
that a different mapping mode or 
alignment might be better. You can easily 
change these settings.

When you open the Apply Map dialog, 
Painter 3D “auto-ranges” to determine the 
optimum values. You can use the Adjust 
features to change scale, origin, and 

orientation (the specific adjustments that 
are available depend on the mapping 
mode), but if you later decide to change 
mapping options, auto-ranging and the 
orientation setting in the Set Mapping 
Options dialog will effectively wipe out 
your adjustments.

To change mapping:

1. With the Object Selection tool, select 
the object you want to work with.

2. Choose Map menu> Set Mapping 
Options> Map Type. Painter 3D 
opens the Set Mapping Options 
dialog for the selected map. Refer to 
“Choosing a Mapping Type” on 
page 74 for more information. 
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You can open the Set Mapping Options dialog 
from the Objects 3D: Object palette.
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 single tile. The Plus Magnifier tool 
vailable for cylindrical, spherical, 

d pass-thru maps.

e Minus Magnifier tool doubles the 
mber of repeats of the image in the 
imension, making the map half of 
former size. Scale in the X 
ension does not change. The 

nus Magnifier tool is available for 
indrical, spherical, and pass-thru 
ps.

e Seam Adjuster tool lets you set 
 angle of pass-thru. Painter 3D 
jects the map onto the object 
pendicular to the surface at the 

int where you click with the tool. 
e Seam Adjuster tool is available for 
ss-thru maps only.

 

it

 

just Mapping tools are not 
le in implicit mapping. Because of 
iety in the topology of objects, 
 no way to know which areas of the 

age correspond to which surfaces 
model. Showing the mesh might 
 some cases, but you’ll probably 
 start painting on the model to 
ense of it.

  
To adjust a map:

1. Choose Map menu> Adjust 
Mapping> and select the map you 
want to adjust. 

Painter 3D displays the Adjust 
Mapping tools. This dialog must 
remain open while you are 
adjusting the map. 

2. Choose an appropriate tool and 
adjust the map.

The tools provided and their adjustment 
effect depend on the mapping mode. 

Mapping Tools

There are four mapping tools you can use 
to adjust maps. Not every tool is available 
for every map type.

• The Grabber tool lets you drag the 
map image on the surface of the 
object. This doesn’t move the position 
of the map seam. It uses the Pattern 
feature “wrap-around seams” to move 
the entire map, including the seam to 
different locations in the image. The 
Grabber tool is available for 
cylindrical, cubical, spherical, and 
pass-thru maps.

• The Plus Magnifier tool reduces the 
number of repeats in the Y dimension 
by a factor of two and then magnifies 
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You can also select the map you want to adjust by 
clicking it in the Objects 3D: Object palette. The 
selected map is highlighted. Then click the Adjust 
button.

Use the Adjust Mapping dialog for more control 
over how the map appears on the model.



      

 

 

ical

 

he Grabber tool is available for 
ing spherical maps. 

   

djust Mapping dialog, using the Grabber 
he map on the model.
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Cylindrical

You can use the Grabber and Magnifier 
tools with cylindrical maps. 

If you want to move only a portion of 

the map, work in the 2D image to 

select and float the region. Then you 

can move it.

 

Spher

Only t
adjust

In the Adjust Mapping dialog, using the Plus 
Magnifier enlarges the map on the model.

In the Adjust Mapping dialog, using the Minus 
Magnifier reduces the map scale. The map tiles 
and repeats on the model.

In the A
moves t
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 3D offers you a wealth of tools, 
s, and options for creating imagery. 
mainder of this manual, as well as 
ine book, 

 

Painter 3D Advanced 

 

describes the tools, features, and 
ues for developing imagery in 
 maps.

 

g Map Images

 

 develop images in your maps, you 
 save your work periodically. For 
rganization, save all map images 
ame folder as the model. 

t results, save the image using the 
le format, Painter 3D’s native 
 for images. This format retains the 
nd all floaters. Other formats 
not retain this information, which 
it your options for editing the 

later. If you intend to export the 
to another 3D program other than 
eam Studio or Ray Dream 3D, use 
F or another compatible file 
.

ving Images” on page 114 for more 
ation on saving map image files.

 

olling Applied Maps

 

are several ways to control maps 
applied, including making a map 
making more than one map active, 
ing maps.

  
Pass-thru

All of the adjustment tools are available 
for pass-thru maps.

Cubical

Only the Grabber tool is available for 
adjusting cubical maps. If you design your 
map properly, adjustment is not 
necessary. For more information, see 
“Finding the Box Faces” on page 92.

Working in the Maps and 
Painting on the Model

Painter 3D lets you work on the map 
images while they are applied to the 
object. You can paint new imagery, apply 
image effects, create floaters, and move 
floaters around in the image. (Floaters are 
an excellent way to place details on the 
model.)
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Click once with the Plus Magnifier to reduce 
repeats and enlarge the single map tile on the 
model.

Click once with the Minus Magnifier to increase 
repeats and decrease the size of the repeating tiles 
on the model.

Click once with the Seam Adjuster to change the 
angle of pass-thru.



              

ect multiple maps:

  

lect a map in the 

 

Maps Manager 
lette

 

 list.

  

ift-click the Pencil icon for any 
ditional maps you want to select.

lick the Pencil icon again to 
t any map. 

 

 a Map

 

ight want to hide a map from the 
 window temporarily. For example, 
ight want to check the effect of a 
 map on the model without the 
tion of the texture map. 

ting maps from displaying in the 
 window also speeds up the display.  

  

map to remove it from the Model 
.
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Making a Map Active

When you have several maps applied to an 
object, you’ll need to identify which one 
you want to work in. Usually, only the 
active map is available for painting, 
applying effects, and editing, unless you 
have shared maps. 

To make a map active:

Use any of these methods:

• Click the map name listed under the 
object in the Objects 3D: Objects 
palette.

• Click the map type listed under the 
image name in the Objects 3D: 
Images palette.

• If the map you want is attached to the 
currently selected object, click the 
map name in the Maps Manager 
palette.

The foremost Image window (displayed 
above all other Image windows) is active 
for painting. Regardless of which method 
you use to select the map, its window 
comes forward.

Making Multiple Maps Active for 
Simultaneous Editing

At times, you might want to work on 
more than one map at the same time. For 
example, you might want to paint a color 
on a texture map while simultaneously 
carving a niche with the same brush 
stroke on a bump map.
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Click the Pencil icon to activate the map so you 
can paint on it.

Hide a 
window
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a floater is selected, your brush 
 and effects apply only to the 
—the canvas isn’t touched. This is 

ether you’re working in the Image 
 or painting right on the model.

 

 the Mesh

 

 3D uses a mesh for the mapping 
ondence between the 2D image 
 surface. The mesh type depends 
mapping mode selected for this 
d the 3D modeling application 

eated it. Viewing the mesh might 
u see correspondence between the 
ge and 3D surface. In some cases, 
ormation might be helpful in 
ping images. 

 

w the mesh:

  

ect the Image window for the map 
ose mesh you want to view.

  

oose 

 

Canvas menu> Display 
sh

 

. 

ck the mesh icon in the top right 
ner of the Image window.

 

To hide any map:

1. Click the Eye icon beside its listing in 
the Maps Manager palette. The Eye 
winks shut and the map disappears 
from the 3D view of the object.

2. To bring back the map, click the Eye 
icon again to open it.

The Map menu> Show submenu also lets 
you hide and show the maps. The 
submenu has a listing for each applied 
map. Checked items are currently 
displayed on the model. Select an item to 
toggle its display state.

Working in Either the Image 
Window or Model Window

After making a map active, you can paint 
into it, apply effects, or use any of the 
other tools to develop and change the 
imagery. You can work in either the Image 
window or directly on the model. In 
either case, your brush strokes and effects 
appear almost immediately in the other 
window.

Some tools and features require you to 
work only in the 2D window.

In the Model window, you can paint on 
the object with the Brush tool, fill with the 
Paint Bucket tool, sample color with the 

Dropper tool, create text with the Text 
tool, and drag floaters with the Floater 
Adjuster tool. 

In the Model window, you cannot create 
selections with the Lasso, Magic Wand, 
Rectangular Selection, or Oval Selection 
tools. You cannot drag handles of a 
reference floater for resizing, rotating, or 
skewing. You cannot use the Effects 
menu> Orientation> features on the 
model. You can select a floater by clicking 
on it, but not by dragging a marquee.

You can create a mask (or selection) in the 
2D image and set the Drawing Mode to 
Masked Inside (or Masked Outside). 
When you paint on the model, the brush 
respects the Drawing Mode setting and 
the canvas mask. 
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You can create text directly on the model.



                    

 the 

 

Maps Manager palette

 

, click 
e Drop Mesh button.

r 3D drops the mesh into the image. 
nnot undo this action.

 

-around Colors and 
less Maps 

 

in this chapter, you’ve seen that 
r 3D wraps a 2D image around a 3D 
. You might be wondering about 
ainter 3D does with the edges of 
 image. Painter 3D wraps colors 
 and creates seamless edges.

 

around Colors

 

ailors thought the world was flat. 
eared that if they sailed too close to 
ge, their ship would fall into 
gness. 

magine your cursor as that ancient 
 ship on the sea of a 2D image. 
ing a brush stroke beyond the edge 
image would send it into 
gness.

tive thinkers and explorers proved 
rld was round. Magellan 
strated that by sailing in one 

on, you’ll eventually return to your 
g point.
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Click the Display Mesh option in the 
expanded Maps Manager palette.

To hide the mesh:

✤ Choose Canvas menu> Display 
Mesh again. You can also click the 
mesh icon in the top right corner of 
the Image window or uncheck the 
Display Mesh option in the expanded 
Maps Manager palette.

Dropping the Mesh

If you like working with the mesh, you 
might like to “drop” it onto the image as a 
graphic element. When you drop the 
mesh, the lines that make up the mesh 
become part of the image.

To drop the mesh onto the image:

1. Select the map into which you want to 
drop the mesh.

2. Display the mesh by clicking the mesh 
icon in the top right corner of the 
Image window.
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To view the mesh, click the Mesh button.

View Mesh

An example of mesh for pass-thru mapping on a 
more complex model.
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uous. This is the case for map 
 created from Painter 3D’s patterns, 
extures, and weaves.  

er, if the colors on the left edge of 
p contrast with the colors on the 
dge, the seam will be visible. You 
 the Adjust feature to move the 
d seam to the other side of the 

 or you can modify the imagery to 
t seamless.

need more information on 
ping seamless maps, look at the 
 on developing seamless pattern 
 “Creating Patterns” on page 156. 

  

he seam is apparent, rather than move 
 of the model, you can use Adjust 
g with Grabber to move the map and 
 the opposite side.
This is how the Brush tool behaves in a 
Painter 3D Pattern image. Drag it off the 
right edge of the image and the stroke 
continues on the left. This behavior is 
called “wrap-around colors.” 

Painter 3D wraps the map image onto the 
model. But there must be an edge where 
the two sides of the map meet (this is 
where you’d place a piece of tape on a gift 
wrapped package). Wrap-around colors 
lets you paint right across this seam. This 
is a huge advantage when painting directly 
on the model.

All surface maps applied to a model have 
the Pattern wrap-around seams attribute. 

An image you create with the File menu> 
New Image command won’t have 
wrap-around colors. You can enable this 
feature for an image if you like. Choose 
Art Materials palette: Pattern menu> 
Define Pattern. Once the image is defined 
as a pattern, all features will wrap around.

Disabling Wrap-Around Colors

Sometimes you might not want the canvas 
map wrapping, especially when painting 
on maps that use pass-thru mapping, and 
sometimes on ones that use implicit 
mapping. To temporarily disable 
wrap-around colors, uncheck the Map 
Wrap UV option in the expanded Maps 
Manager palette.

Seamless Maps

Normally, the right edge of a Pattern tile 
meets the left edge of the next tile. With 
the map wrapped in 3D, the right edge of 
the map meets its own left edge. In a 
sense, the map is a Pattern tile that “meets 
itself.”

The seam where the edges of the map 
meet should be invisible. The imagery 
should flow together as though it was 
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You can paint off the edge of the map image file 
and your stroke appears on the other side while it 
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d objects, like a porcelain vase, warp 
age across the curve of their surface. 
ter 3D, you may need to warp the 

before loading it as the 
nment. This depends on the 
gy of the object. The rounder the 
, the more likely you’ll need to warp 
age. 

 

rp an image:

  

fore warping, make sure all floaters 
 dropped. 

  

oose 

 

Effects menu> Surface 
ntrol> Quick Warp

 

.

 

ginal landscape image.
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Features and techniques described for 
creating seamless patterns apply equally to 
developing seamless maps.

Reflection Mapping

If you’re in a museum and you look 
closely at an 18th century porcelain vase, 
you might see your own face reflected on 
the surface. It’s a subtle detail, but 
reflection adds visual interest and realism 
to your models. Painter 3D lets you 
develop this kind of detail with reflection 
mapping. 

There are two ways to use reflection 
mapping in Painter 3D. One method 
requires you to create an image 
specifically for use as an environment 
map, which you can then apply to an 
object like any other surface map. The 
other method is more passive. It simply 
uses the current pattern as the image to 
reflect. Both methods require that you 
adjust the Reflection slider in the Objects 
3D: Objects palette before the effect can 
be seen.

Here are some pointers for getting the 
most out of reflection mapping.

• If you create an image for an 
environment map, you might need to 
warp it. 

• If you don’t create an environment, 
Painter 3D uses the current pattern.

• You need to select each object in the 
model and use the Objects 3D:Objects 
palette: Reflection slider to set the 
degree of reflection for reflection 
mapping to have any effect.

• If a single object has areas with 
different reflectivity, apply a reflection 
mask map to describe the areas with 
limited reflectivity. 

Reflection mapping is most useful for 

rendering your models into 2D images. 

You lose the effect when you import 

your models and maps into your 3D 

application. You might be able to use 

an environment map you’ve created if 

your 3D application accepts 2D images 

for use as a background or backdrop.

Creating an Environment Image

An environment map isn’t mapped 
directly onto the surface of an object. The 
image in an environment map is the 
image that appears in the reflection of an 
object. 
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 a Reflection Mask

n mask areas of the object to inhibit 
on by applying a reflection mask.

o “Applying Maps” on page 71 for 
nformation.

areas of the reflection mask allow 
l Reflection slider setting. Black 

 the reflection mask block 
on completely. A shade of gray in 
sk inhibits reflection at a level that’s 
erse of its luminance value. The 
 the gray, the more it inhibits 
on, and vice versa.

nical Considerations for 
ning Maps

ction offers technical information 
igning maps to minimize 
ion.

ection mask for the previous example.
3. In the Quick Warp dialog, use the 
default settings (sphere) and click OK.

4. When you’ve finished developing the 
environment image, save it.

Using an Image for the Environment 
Map

If you have an image you want to use as an 
environment map, the steps for applying 
it are the same as applying any other type 
of surface map. You select the object and 
apply the map, specifying your existing 
image as the source of the map. 

Once you load the image into the map, be 
sure to set the reflection setting high 
enough to view the image.

Setting Reflection for an Object

The Objects 3D: Objects palette: 
Reflection slider controls the object’s 
overall reflection. 

Select each object and drag the slider to 
describe its basic reflection amount.
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Using Sphere Quick Warp to create an 
environment map.

The resulting environment map.

Model shown using the landscape environment 
map for reflection.

The refl



aper is an excellent image to use as 
ence when exploring image aspect 
apping. Any distortion of the 
 grid will be apparent immediately. 
n apply grid paper by opening an 
 then choosing Effects menu> 
ica> Grid Paper.

ing and Distortion

paint with the Brush tool in the 2D 
 the brush dab will have the same 
ywhere in the image. However, if 
e that same brush on the sphere, 
b will be compressed by the 
ion and become smaller as you 
earer the pole; this is just one 
le. Brush scale (and mapping scale) 
s across regions of an object 

ding on the mapping mode and 
 shape. Even with implicit mapping, 
aries with the dimensions of the 
 at that point.

d is constant in the 2D texture map. On 
ere, scale diminishes approaching the 
88 Chapter  6 Painter 3D

Distortion is inherent in applying 2D 
images to some curved 3D surfaces. It’s 
the consequence of scale differences 
between the 2D image and the areas it 
maps to on the 3D surfaces. You’ll 
recognize this problem if you consider 
some real-world examples: 

• Imagine wrapping a basketball in 
newspaper. It’s impossible to wrap the 
paper close to the ball without 
creating folds. That’s because in some 
areas, you’ve got more paper than 
basketball surface. This is just what 
happens in spherical mapping. The 
folds in the paper translate to 
distortion when you map a 2D image 
onto a 3D object.

• Now imagine gift wrapping a can. It’s 
easy to get the paper tight around the 
circumference, but how do you cover 
the ends? You’ve got to fold the 
wrapping paper. What if your paper 
isn’t long enough to go all the way 
around the can? You’d need to stretch 
the paper until the ends meet. In 
terms of cylindrical mapping, 
stretching the paper stretches the 
images on it as well. 

Fortunately, distortion can be minimized 
by choosing the right mapping mode for 
the model and designing the map images 

carefully. The most important factor in 
map design is the aspect ratio of the 
image.

Aspect ratio describes the relationship 

between an image’s width and height. 

For example, the NTSC television 

image has an aspect ratio of 4:3 

(spoken as “four-to-three”). This means 

that for every four units of width, there 

are three units of height. 

Scale Changes Across the 
Surface

The grid paper wrapped onto the sphere 
demonstrates how scale can change across 
the 3D surface. In the 2D map, the grid is 
fairly regular—the cells are the same size 
and nearly square. Near the poles of the 
sphere, however, the cells are smaller and 
triangular.
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-tall. However, the orientation of 
 coordinate system might differ 

our logical sense of what is “left” 
p” for the object. 

correspondence between regions 

e map and points on the model is 

ed in the model’s construction. 

ending on the nature of the model, 

ery may appear mirrored or 

wards. This may not be a problem 

 some types of imagery; however, it 

lly is a problem for text. You can 

ly correct this by flipping any floater 

ap that appears mirrored on the 

del’s construction determines the 
ion of the map imagery.
Distortion cannot be eliminated, but its 
effect can be made negligible. For one 
thing, the ability to paint directly on the 
model is a tremendous advantage in 
avoiding distortion. Because you’re 
painting on the model, you can develop 
the imagery at the size and shape you 
want.   

Optimizing Maps for Implicit 
Mapping

Implicit mapping correlates points on the 
object with points in the map and wraps 
the image to align the two sets of points.

The points on the object are defined by 
the UV coordinates. Painter 3D locates 
points in the map based on the UV data 
from the model and the map aspect. This 
means that you can use almost any aspect 
in a map used for implicit mapping. The 
nature of implicit mapping minimizes 
distortion problems.

Because of the variety in object shape, 
there are no set rules for setting up images 
for implicit mapping. Ideally, the 
distribution of points in the map will 
minimize distortion on the model. You 
can support this by approximating the 
object surface area with the map image.

For example, if the object is long and 
slender, like a snake, it makes sense to 
make the map relatively wide and 
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This texture map is used with the following 
examples.

Mapping scale changes with the diameter of the 
vase.

Scale is constant on the walls of the cylinder.
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n use images of any resolution, but 
ust be consistent with this aspect 

mple shortcut: Use 942 pixels as 

width and 600 pixels as the height.

n convert the results to an aspect 
hen determine appropriate 
sions in pixels. You can also choose 
enu> New Image and create a new 
using inches as the units (which 
ecimals). Then resize the canvas to 
ensions you want. Resizing the 

 maintains its proportions.

u resize a map, you may need to 

ate the mapping information. Open 

Mapping Options dialog, make sure 

options are set as you want them, 

 close the dialog.

izing Image Aspect for 
rical Mapping

erical mapping, Painter 3D maps 
dth of the image to 2π radians and 
he height to π radians; therefore, 
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model. Use the Map Flip X or Map Flip 

Y options in the Maps Manager palette 

to easily flip maps.

After choosing implicit as the mapping 
mode, display the mesh on the map 
image. If the mesh “openings” are 
extremely narrow in one dimension, you 
might want to increase the image size in 
the other dimension. For example, if the 
openings are really wide, but not very tall, 
you might want to increase the image 
height.

You’ll discover more about the mapping 
when you begin painting on the model. 
After you paint a few strokes, you might 
decide that a different image aspect will 
produce a better map for this object.

When you create a new map based on 

the pattern or paper texture, you can 

often use a shortcut to determine the 

correct number of repeats. The 

shortcut works only if the pattern/paper 

texture tile is square. (A tile is square if 

the columns and rows values are equal. 

This information appears in the Pattern 

or Texture palette when the drawer is 

closed.)

Here’s the shortcut: Determine the 

correct aspect ratio for the object scale 

and mapping mode you plan to use. 

When you load a new map, enter the 

values for this aspect ratio (or multiples 

of it) in the horizontal and vertical 

repeats fields. 

Optimizing Image Aspect for 
Cylindrical Mapping

The aspect ratio of the map image should 
match the dimensions of the cylinder. If it 
doesn’t, the imagery on the map will be 
distorted in one dimension.

Remember from geometry class that the 
circumference of a circle is π multiplied by 
the diameter (πd). The images you create 
for cylindrical mapping on a cylinder 
should have an aspect ratio consistent 
with the ratio of the cylinder’s 
circumference to its height.

The map image width should be: 
3.14*cylinder_diameter

The map image height should be: 
cylinder_height

For example, if the cylinder is 3 units in 
diameter and 6 units tall, the image 
should be 3.14*3 wide and 6 high, or 9.42 
by 6 units.
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en you can develop imagery in this 
w canvas.

you apply this map and set 
ng options for it, use the Align with 
t view orientation option.

izing Image Aspect for 
ing onto a Box

mapping onto a box using either 
l or implicit mode, the aspect ratio 
map image should match the 
sions of the box. If it doesn’t, the 
y on the map will be distorted.

n calculate the correct aspect 
r mapping to any box as follows:

te the width, depth, and height of 
 box. To check the dimensions, you 
 click on the box with the Object 

ection tool. The Controls palette 
dates to show the extents in the X, 
nd Z dimensions. Width is X, 
ght is Y, and depth is Z.

e the following equations to 
ermine the correct aspect ratio for 
ages used in cubical or implicit 
pping on a box: 

p Width = 2*(width + height)

p Height = 2*height + depth
the aspect ratio of the map should be 2:1. 
(The image width should be twice the 
height.)

Optimizing Image Aspect for 
Pass-thru Mapping

In pass-thru mapping, the map image 
should have an aspect ratio that 
approximates the dimensions of the 
object’s silhouette when viewed at the 
angle of pass-thru.

The following steps suggest one method 
of working.

To optimize the image aspect:

1. Set the view in the Model window for 
the angle of pass-thru you want.

2. Choose File menu> Render to 
Image.

3. In the rendering, use the Rectangular 
Selection tool to draw a marquee 
that’s just large enough to enclose the 
object. 

This marquee describes the aspect of 
an appropriate image for pass-thru 
mapping at this angle.

4. You can get width and height values 
by looking in the Controls palette: 
Selection Tool. Then create a new 
image based on this aspect ratio.

5. You can also copy the selection, then 
choose Edit menu> Paste> Into New 
Image. Now you can choose Canvas 
menu> Resize and scale the image to 
any resolution you want. 
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pass-thru mapping at this angle.



agram shows the box height, width, and 
n the map.

agram shows how the map is folded onto 
.

ished box, rendered from several angles.
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For example: Your box is 3 units 
wide, 4 units high, and 2 units deep.

Map Width... 2*(3 + 4)=14

Map Height... 2*4 + 2=10

This gives you an aspect ratio of 7:5. Any 
image with dimensions consistent with 
that aspect ratio will map correctly on 
that box. For example, if you want the 
image width to be 700 pixels, the height 
should be 500 pixels.

If you wanted, you could create an image 
at the dimensions you calculated (140 
pixels by 10 pixels), then use the Canvas 
menu> Resize command to scale the 
image to the dimensions you want. This is 
an easy way to get the right proportions at 
a particular size.

Finding the Box Faces

This section assumes you have 
determined the correct image aspect ratio 
for mapping onto a box. If you are not 
sure about this, please refer to the 
previous section.

When developing a map for a box, you’ll 
need to know which areas of the image 
correspond to which of the box’s six faces. 
You can create text and imagery for the 
front, the sides, and the back of the box, 
and each image region will map to the 
correct box face.

Imagine cutting along the corners of a 
cardboard box in such a fashion that you 
could flatten the cardboard into a cross. 
Cubical mapping (and implicit mapping 
on a Painter 3D primitive box) is just the 
opposite of this. It takes the cross and 
folds it to reconstruct the box.

You lay out imagery for each of the six 
faces in a cross on the map image. To do 
this properly, you must know which areas 
of the cross will map to which faces of the 
box.

The following diagrams describe how to 
lay out images for box mapping:     

When you create a new box in Painter 3D, it has 
the orientation shown above.
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pth: 64*3=192 pixels

fer to the diagrams in “Finding the 
x Faces,” earlier in this chapter, to 
 how these values relate to regions 
the map image.

ging the Aspect Ratio of a 
mage

ap stretches on the object in a way 
n’t like, you might want to change 
ect ratio of the map image. 

nge the aspect ratio:

ke sure that all floaters are 
pped.

oose Effects menu> Orientation> 
le. Painter 3D floats the image and 

ens the Scale Selection dialog.

sable the Constrain Aspect Ratio 
ck box.

ter scaling percentages for the 
dth or height. Notice that a 
tangle in the Image window 
cribes the scaled dimensions of the 
age. When you’re satisfied, click 
. Painter 3D scales the floating 

age. 
When you’re developing your image, 

display the mesh by clicking the mesh 

icon in the top right corner of the Image 

window. The mesh lines help identify 

the regions that map to the different 

faces.

Tip: Use one reference floater for the 

imagery on each face. You can easily 

move, resize, and rotate the floaters 

without sacrificing image quality. You’ll 

be able to see the results of your 

changes on the 3D view of the box. 

Adjust the reference floaters until 

they’re on the correct faces. Reference 

floaters are described in the online 

book, Painter 3D Advanced Guide.

Finding the Dimensions of Each Box 
Face Region

You might want to know exactly which 
pixels in the map correspond to the box 
faces. In most cases, this won’t be 
necessary to do your work. The mesh lines 
and how your work appears on the model 
will give you enough information to scale 
imagery for the face regions. However, if 
you’re interested or technical 
considerations require it, the following 

mathematical example describes how to 
determine the dimensions of each face in 
pixels.

To determine pixel dimensions:

1. Use the formula described in 
“Optimizing Image Aspect for 
Mapping onto a Box” on page 91 to 
determine the width in units of the 
map.

For this example, use a box model 
that is 6 units wide, 4 units high, and 
3 units deep.

Map Width..... 2*(6 + 4)=20 units

2. Divide the width of the map image (in 
pixels) by the map width (in units). 
This gives you the pixels per unit 
(ppu) of the map. That is, how many 
pixels in the image are mapped to one 
unit on the box.

For the example, we’ll use a map 
that’s 1280 pixels wide (chosen 
arbitrarily). 

1280/20=64 ppu

3. Now you can multiply the ppu value 
by the box width, height, and depth 
dimensions.

Width: 64*6=384 pixels

Height: 64*4=256 pixels
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u can use the Floater Adjuster tool 
 scale the label by hand. For this, 
u need to work in the 2D Image 
ndow. Using Free Transform, drag 
her side handle to stretch the floater 
rizontally. When the label looks 
ht in the 3D view, Commit 

ansform and you’re done.

line book, Painter 3D Advanced 
 provides information about 
g with reference floaters.
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5. Choose Edit menu> Copy to begin 
moving this floater to its own image 
file.

6. Choose Edit menu> Paste> Into 
New Image.

Painter 3D creates a new image 
document for the scaled floater. 

Now, you can replace the old map 
with this new, scaled map.

7. In the Maps Manager palette, 
double-click the listing for the map 
type (texture, bump, etc.) you are 
working with. You can also click once 
to select it, then click Load.

8. In the Apply Map dialog, use the Copy 
Image pop-up to select the name of 
the modified image. Click OK. 
Painter 3D loads the image in the 
selected map channel.

Using Reference Floaters to 
Avoid Regional Distortion

Determining the correct aspect ratio for a 
map image works well when the object is 
regular—when the walls of the cylinder 
are straight, for example. But what do you 
do when the scale of the object changes? 
Consider a wine bottle. 

The body of a wine bottle has one 
diameter, and the neck has another. Labels 
placed on the body and neck should have 
different aspect ratios, but the texture 
map applied to the bottle can have only 
one aspect ratio. What do you do? The 
answer is to scale the labels differently. 

This technique works for both cylindrical 
mapping and implicit mapping.

To scale labels differently:

1. Set up your texture map so that the 
larger label (on the body) is at its 
natural proportions. 

2. Add the label for the neck as a 
reference floater. Position the floater 
on the neck of the bottle.

3. Increase the horizontal scale of the 
neck label. 

• If you know the diameter of the neck, 
use the Effects menu> Orientation> 
Set Transform feature. Disable the 
Constrain Aspect Ratio option. Set 
the Horizontal scale factor to the 
inverse of the diameter change 
between the body and the neck. (For 
example, if the neck is one-third the 
diameter of the body, the horizontal 
scale factor should be 300%.)
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ter 3D, as in other 3D programs, 
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light illuminates the model for the 
rendering camera. The rendering 
camera’s view is shown in the Model 
window. Without light, all you would see 
in the Model window is black. If you’re 
going to render the model in Painter 3D, 
you’ll want to set the lighting with care. 
Lighting directly determines the 3D 
appearance of the model.

If you’re going to export your model to a 
3D scene-building program, like Ray 
Dream 3D or Studio, you don’t need to 
pay much attention to Painter 3D’s 
lighting. You’ll set final lighting in your 
3D program. In Painter 3D you use light 
to see how your surface maps will look as 
you create them.



          

 Shading

 

 shading describes the dark areas 
velop on surfaces away from the 
urce. Depth shading is only 
nt when ambient light is low. 

  

del has pronounced highlights and depth 
.
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Colored Lights on the Model

Painter 3D lets you use colored lights. The 
color of the lights you use influences the 
colors on the surface of your model. For 
example, if your model has a cyan texture 
map and you shine yellow light on it, the 
model surface will appear green.

Use white lights to illuminate your model 
without adding tints to its surfaces. 

When you’ve finished adding surface 

detail to your models, you might want 

to export them to Ray Dream 3D or 

Studio or another 3D program. Ray 

Dream’s rendering engine uses ray 

tracing. Ray tracing offers light effects 

that Painter 3D doesn’t. If you want 

objects that cast shadows and render 

with translucence and refraction, you’ll 

need to export your models to a 3D 

program. 

Light Reveals the Third 
Dimension

Lighting the model creates two effects that 
contribute to its three-dimensional 
appearance: highlights and depth shading.

Highlights

Specular highlights are the bright spots 
and streaks where light reflects directly. 

You can control an object’s tendency to 
produce highlights with the Objects 3D: 
Objects palette: Specular slider and with 
the highlight mask map.

Depth
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This model has colored lights shining on it.
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 Painter 3D’s Lighting 
te

 

r 3D opens new models with a 
light shining on the front of the 
. You can move this light and create 
. Each light can have different color, 

ess, and concentration settings.

r 3D’s lights are distant lights. They 
n the model like the sun shines on 
th. You set lights for the entire 

, not for individual objects within 
del.

f the features for working with 
ppear in the Objects 3D: Lighting 
. 

  

tral controls for lighting are found on the 
 3D: Lighting palette.
Lighting and the Bump Map

Different lighting conditions change the 
appearance of the bump map.  

• Lights that shine from a low angle 
create greater contrast in the bump 
map.

• Ambient light shines from 
everywhere, so it minimizes the relief 
developed by the bump map. To see 
more bump texture, reduce the 
ambient light.

• Lighting a bump area from opposite 
directions creates a canceling effect on 
the bump features. To reveal more 
texture, light the model primarily 
from one side.

The bump effect responds to lighting 

changes just as you’d expect in nature. 

Shine a flashlight straight into a 

sidewalk crack, and you’ll see into it. 

The sidewalk surface and the crack are 

much the same color. But if you put the 

flashlight on the ground so that the light 

shines across the crack, the sidewalk is 

lit, but the crack is dark and its detail 

remains hidden.
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The effect of the bump map changes under 
different lighting.
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ve a light:

 

ag the light’s circle icon. By moving 
 lights on the sphere, you move 
m around your model.  

 

ct a light:

 

ick inside the light’s icon. The icon 
 the selected light appears in 
old.” 

 

light on the preview sphere to move it on 
el.
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If you want more sophisticated lighting, 

for example spot lighting, you will need 

to import your Painter 3D model into a 

3D rendering program.

Preview

The lighting preview sphere represents the 
model space. Imagine your model just 
inside the sphere. The lights shine on the 
preview sphere just as they shine on your 
model. 

Light Icons

The small circles on the preview sphere 
are icons representing the individual 
lights. The light’s color appears inside the 
circle. 

Display Slider

The Display slider controls the brightness 
of the lighting on the preview sphere. This 
slider changes the appearance of the 
preview; it has no effect on the lighting of 
your model.

Show Icons

When Show Icons is enabled, the light 
icons appear on the preview sphere. You 
might want to disable this option to hide 

the icons and see the preview without 
their distraction. You can hide the icons 
by disabling the Show Icons check box at 
the bottom of the palette.

Controlling Individual Lights

You can add individual lights and control 
them in various ways. 

To add a new light:

• Click the preview sphere where you 
want the new light. Painter 3D creates 
a new light using the settings of the 
current, selected light.
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nge the selected light’s 
ntration:

 

ag the Concentration slider to 
ntrol the spread of the selected 
ht. Increasing concentration 
ragging the slider to the right) 
ates a smaller patch of light on the 
del. Decreasing concentration 

ragging the slider to the left) 
reads light across the model.

  
When you’ve selected a light, you can 
change the settings for its color, bright-
ness, and concentration. 

To change the selected light’s color:

1. Click the Color button. Painter 3D 
displays the system color picker so 
you can choose a color. 

2. Choose a color from the color picker 
and click OK. The model in the Model 
window is tinted with the color of the 
light.

To change the selected light’s 
brightness:

• Drag the Brightness slider to the right 
to increase the selected light’s 
intensity. Drag the Brightness slider to 
the left to decrease the selected light’s 
intensity.
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When you use colored lights, the appearance of 
the model changes.

Dragging the Brightness slider changes the light’s 
intensity.



        

nt Slider

 

nt light is general—it illuminates 
del from all directions. To get a 

er 3D effect from the specific lights 
t, keep ambient light low.  

   

bient slider affects the general lighting 
l directions.
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To delete the selected light:

• Click the Delete button. 

Controlling Model Lighting

The following controls apply to the model 
in general.

Exposure Slider

The Exposure slider controls how much 
light enters the rendering camera. It 
works just like the exposure setting on a 
regular camera. Increasing exposure 
(dragging the slider to the right) allows 
more light into the camera, so everything 
gets brighter. 

Ambie

Ambie
the mo
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Dragging the Concentration slider changes the 
spread of the selected light.

The Exposure slider controls how much light 
enters the camera.
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ere in the 

 

Objects 3D: Lighting 
lette

 

 updates to show the new light 
well.)

  

e the 

 

Controls palette

 

:

 

 Light tool

 

 
adjust the light’s Brightness, 
ncentration, Exposure, and 
bience. These are the same sliders 
vided on the 

 

Objects 3D

 

:

 

 
hting palette

 

.

   

e model once with the Light tool to add a 
that location.
Flat Lighting

Flat Lighting puts a lot of light on all 
surfaces. Flat Lighting is equivalent to 
maximum ambient light. When you’re 
painting in the texture map, you might 
want to use Flat Lighting to see all areas 
clearly. You should disable this option to 
see depth shading, highlight, and bump 
effects.  

Adding Lights With the Light Tool

Sometimes, you’ll want to add a light 
without going to the Objects 3D: Lighting 
palette.

The Light tool lets you add a light by 
clicking directly on the model in the 
Model window. It concentrates a light 
directly at the spot on the model where 
you click. This lets you illuminate an area 
of the model more precisely than the 
Objects 3D: Lighting palette.

To add a light using the Light tool:

1. Select the Light tool from the Tools 
palette.

2. Click the model at the spot where you 
want the light to shine. Painter 3D 
adds the light. You’ll see the effect on 
the model immediately. (The preview 
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Flat lighting removes the 3D effects from the 
model.

The Light tool. 
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d saved light settings:

  

oose 

 

Objects 3D: Lighting menu> 
ad

 

. Painter 3D displays a dialog list 
the saved light sets.

  

ick the listing you want. Painter 3D 
plays a preview of the light set.

  

ick OK. Painter 3D closes the dialog 
d loads the light setting for the 
del.

n remove unwanted sets by 
g them, then clicking the Delete 

.

  

cking the Load button, you can preview 
t set in the Load Lights dialog before 
 your selection.
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Locking Lights to Objects

By default, Painter 3D keeps lights fixed in 
relation to objects. This means that as you 
rotate the model in the Model window, 
certain portions of the model always stay 
lit and certain portions always stay dark. 

You can temporarily disable this effect 
when rotating a model by holding down 
the Shift key as you use the Virtual 
Trackball tool. When you do this, you see 
that the lights remain fixed in relation to 
your view, and the faces of the model 
move in and out of light and shadow as 
you rotate the model.

You can lock lights to an object so that no 
matter how you’re rotating the model, the 
portion of the object with the locked 
lights remains lit. You lock lights to 
objects when you add lights with the Light 
tool. Check the Lock Lights to Objects 
option in the Controls palette: Light tool. 
Lights will remain locked to objects until 
you disable this option.

Saving Light Settings

When you’ve created a set of lights that 
you like, you can save them to a 
retrievable setting. You can load the saved 
lights for any model you work with.

To save light settings:

1. Set the lighting you want. The settings 
for position, color, and all of the 
sliders will be saved. 

2. Choose Objects 3D: Lighting menu> 
Save. Painter 3D prompts you to 
name the light set.

3. Enter a descriptive name and click 
OK.

Access saved light sets with the Load 

button on the Light palette. 3D light 

sets do not have libraries or movers.
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Applying maps to your models is just one 
aspect of Painter 3D. The major portion 
of your work will probably be creating 
images in the map image files.

You can create images and apply them 
later as maps; or you can apply a map, 
then develop an image in it. Painter 3D 
lets you work either way.

One of the advantages to applying the 
map first is that you can then paint 
directly on the model. This is often the 
best way to get the effect you want, in just 
the location you want it.



                 

urth of this number, depending on 
any colors are present in the 
ent. A document with fewer colors 
e white space can compress in RIFF 
 more than a document filled with 
ifferent colors.

 

 and Height

 

you create a new image, the Width 
 highlighted in the dialog. You can 
 Tab key to move from field to field.

 

ing a Unit of Measurement 

 

fault settings are in pixels. You can 
 the measuring units by using the 

p menus. Choose from pixels, 
, centimeters, points, picas, and 
ns. Columns are two-inch columns, 
u can indicate how many columns 
nd tall you’d like your image to be.

the width and height for a new 
ent, enter a value for Width and a 
or Height in the dialog.

 

 Resolution 

 

ter 3D, resolution refers to the 
r of pixels per inch (ppi) that make 

image. When you enter a value for 
tion, you need to consider the 
ed output or use for your project:
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The remainder of this manual and the 
online book Painter 3D Advanced Guide 
cover the many features for creating 
images. In this chapter, the text refers to 
“working in the image.” It makes no 
difference whether an image file is 
currently applied as a map or not—it’s 
still just an image. Painter 3D’s image 
development features are as well suited for 
putting the finishing touches on a 
rendering as they are for developing map 
imagery. 

Learning About Painter 3D 
Map Image Files

Painter 3D has its own 2D file format 
called RIFF. RIFF files have special 
properties. A RIFF maintains floating 
objects so you can return to the file to 
rearrange floaters. When you work in 
Painter 3D, you should always work in 
RIFF format to preserve editability. For 
compatibility with other programs, you 
can save finished work in other formats. If 
you intend to export your model to 
another 3D program, you should save all 
of your maps as RIFF files first and then in 
a format compatible with your 3D 
applications. (RIFF files are compatible 
with Ray Dream 3D and Studio.) 

Creating a New Image File

When you create a new image file, you set 
the image’s width and height, resolution, 
and paper color. 

To create a new image:

1. Create a new image by choosing File 
menu> New Image. The New Picture 
dialog appears. 

2. Set dimensions, resolution, and paper 
color, then click OK.

Canvas Size

The Canvas Size describes the file size. 
Next to the Canvas Size is how much 
memory (RAM) the document requires. 
RIFF is a lossless compressed file format. 
When saved in RIFF, the saved size of the 
document is roughly one-half to 
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.

 

the change, you need to delete areas 
image or use the eraser brush to 
reas (do not use a bleach variant, 
 variants erase to white). 

n choose a surface for the paper as 
 a color. You can specify a paper 
 full of texture so that the grain 
s beneath your brush strokes. You 
er surfaces in the Art Materials: 

palette. Refer to “Working With Art 
als” on page 133 for more 
ation about paper textures.

 

 Canvas> Set Paper Color to set the paper 
 the current primary color. Delete part of 
ge to see the new paper color.
• If you want a low resolution map, use 
the default 72 ppi resolution.

• If you intend to make a large, high 
quality map, the resolution of the 
map should be increased. If you try to 
make a high resolution rendering with 
a low resolution map, the map will 
appear softened on the model.

• If you are creating a 2D collage or a 
rendering intended for print, you will 
need to consider the output device’s 
resolution, measured in dpi, and, in 
the case of halftones, lines per inch 
(lpi). Output-device resolutions vary 
depending on the press and paper 
you’re printing on. Generally, a 
photograph to be printed on glossy 
magazine stock will be output at a 
crisp 150 lpi, and at 85 lpi for more 
porous, and therefore more forgiving, 
newspaper stock.

In the New Image dialog, setting the 
document’s pixels per inch is the same as 
setting its dpi. Using the default 
resolution setting of 72 pixels per inch 
means that your document’s dpi will also 
be 72. 

You can also set your size in inches, 
centimeters, points, or picas at a 
specific dpi. 

Paper Color

You can choose the background paper 
color. This color fills the image as the 
background color when the image opens. 
The Paper Color swatch shows the current 
paper color. Paper color differs from the 
backgr3ound color of the Model window. 
Paper color affects the background of the 
Image window only. The background 
color of the Model window is a color that 
appears behind the model in the Model 
window.

To set paper color, click the Paper Color 
swatch. Painter 3D displays the system 
color picker so you can choose a color.

To change an existing paper color:

1. Use the Art Materials: Color palette 
to select the color you want.

2. Choose Canvas menu> Set Paper 
Color. The paper is set to the current 
primary color
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ck image size and orientation:

  

ove the pointer to the 

 

i

 

 and hold 
wn the mouse button.

e Width, Height, and Resolution 
pear in a pop-up window.

hen a printer is defined, the 
ndow also shows how your image 
s on the page. Page size and 
ientation (landscape or portrait) are 
sed on those designated in the Page 
tup dialog. The non-printing area 
und the edge of the page is dim.

ou change your image’s resolution 
 dimensions by choosing Canvas 
nu> Resize, you can use the 
ormation window to see how the 
anges affect the way the image fits 
 the page. 

  

 printer is defined, the image size pop-up 
ow your image fits on the selected page.
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Opening a New View

You can choose to open a new view of any 
open image, which opens the image in a 
second Image window. When you open a 
new view, you’re working with the same 
image but seeing it twice onscreen.

A new view can be quite useful. For 
example, you can set different 
magnification levels for each window. If 
you zoom in close in one window but 
leave the other at 100%, you can paint fine 
details in the magnified view but keep an 
eye on the overall effect in the regular 
view. Because it’s the same image, the 
windows update simultaneously.

To open a new view:

✤ With an Image window selected, 
choose Window menu> New View.

The same image appears in a second 
Image window.

To close the view:

✤ Click the Image window’s close box.

Image Size Information

You can use the i (the international 
symbol for information) near the bottom 
left-hand corner of the Image window to 
check image size. 
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The image information pop-up contains your 
image’s dimensions and resolution.
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 the Grabber Tool

 

rabber tool gives you a quick way to 
n image.

he Grabber inside the window to 
 move your image.

re some Grabber tool shortcuts:

 center an image with the Grabber 
l, click once in the Image window. 

you double-click the Grabber tool 
the Tools palette, Painter 3D fits the 
tire image to the largest size 
ndow your monitor will permit. 
is feature is also available by 
oosing Window menu> 
om to Fit. 

 use the Grabber tool while almost 
y other tool is selected, hold down 
 Spacebar.

uble-click the tool while the Model 
ndow is active to center 
ible objects. 

rabber tool works the same way in 
del window and Image windows.
2. Release the mouse button to close the 
image information window.

Navigating Your Image

You can navigate through an image by 
changing the level of magnification 
(zooming in or out), scrolling to a 
different part of the image, or rotating 
the page.

Zoom to Fit 

By default Painter 3D opens an image file 
at 100% view, but you can change the 
view to suit your needs. Choose Window 
menu> Zoom to Fit and Painter 3D 
generates a view of the entire image to fit 
the size of your monitor. 

Zooming In and Out

Zoom in by clicking with the Magnifier 
tool. Zoom in to a given rectangle of the 
image by dragging with the Magnifier.

Zoom out by holding down the Option/
Alt key and clicking. 

In an image file, you can also choose a 
zoom level from the pop-up on the 
Controls palette: Magnifier tool. The 
zoom factors range from 8.3% to 1200%.

You can access the Magnifier tool while 

almost any other tool is selected. For 

Macintosh, hold down 

Command-Spacebar and click to zoom 

in and Command-Option-Spacebar to 

zoom out. For Windows, use 

Spacebar+Ctrl to zoom in and 

Spacebar+Ctrl+Alt to zoom out. 

To magnify a specific area:

• Use the Magnifier to drag a marquee 
around the area you want to magnify. 

The area inside the rectangle is magnified 
to the closest magnification level that fills 
the screen.

The Magnifier tool works the same way in 
the Model window and Image windows, 
with one exception. The zoom level 
pop-up in the Controls palette applies 
only to Image windows.

Double-click the Magnifier tool in the 

Tools palette to return the image to 

100% magnification.
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istance in laying out your images, 
r 3D provides rulers and guides. 

 

lay the rulers: 

  

oose 

 

Canvas menu> Rulers> 
ow Rulers.

 

e the rulers: 

  

oose 

 

Canvas menu> Rulers> 
de Rulers

 

.

  

re displayed in the Image window.
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Rotating an Image Window

You can rotate an image on the screen to 
accommodate the way your arm, wrist, 
and hand draw naturally. 

This feature doesn’t rotate the image 
data—only your view of it. 

To rotate an Image window to suit your 
drawing style:

1. Choose the Virtual Trackball tool or 
with almost any other tool selected, 
hold down Option-Spacebar 
(Macintosh) or Spacebar+Alt 
(Windows).

2. Press down on your stylus or mouse 
and drag, and a rectangle with an 
arrow pointing at the top of the 
screen appears. 

3. Drag the rectangle or the arrow to the 
angle you want. To constrain page 
rotation to 90° angles, hold down the 
Shift key while rotating the page. 

To use the key combinations, press 
the Shift key first, before choosing 
Option-Spacebar (Macintosh) or 
Spacebar+Alt (Windows).

To return the Image window to its 
normal position:

1. Choose the Virtual Trackball tool or 
hold down Option-Spacebar 
(Macintosh) or Spacebar+Alt 
(Windows).

2. Click once in the Image window.
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way your arm, wrist, and hand draw naturally.
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ick once in either the horizontal or 
tical ruler to create a guide at that 
int. If you drag, instead of clicking, 
u can move the guide to any point 
 the ruler.

 

guide doesn’t appear, Painter 3D 

 be set to Hide Guides. To show 

es, choose Canvas menu> Guides> 

 

w Guides.

 

reating a guide, you can drag it (by 
ngular marker) to any point on the 

ove a guide, drag its marker off the 
f the document. 

 

 Options

 

uide has an options dialog that lets 
ove it to a particular point and 
 its color.

 

Ruler Options

You can set ruler units by choosing 
Canvas menu> Rulers> Ruler Options. 
You can also hold down the Option/Alt 
key and click in the ruler to open the 
Ruler Options dialog.

Use the pop-up to choose the units you 
want: Pixels, Inches, Centimeters, Points, 
or Picas.

Snap to Ruler Ticks

Each mark in the ruler is called a tick. If 
you want the guides you create to land 
precisely on the tick marks, choose 
Canvas menu> Rulers> Snap to Ruler 
Ticks.

Changing the Origin

Normally, the origin (0, 0) is in the top left 
corner. Sometimes you might want to 
choose a different origin to assist in 
measuring between points.

To change the origin of the rulers:

1. Drag from the box where the 
horizontal and vertical rulers meet to 
the point in the document you want 
as the origin.

2. When you release the mouse button, 
the ruler updates to describe the new 
point as the origin.

This applies to the ruler only—not to 
floater placement or other location 
features.

To restore the top left corner as the 
origin:

✤ Double-click the box where the 
horizontal and vertical rulers meet.

Guides

Guides are non-printing lines that help 
you align objects, like floaters.

To create guides:

1. Show the rulers. You must display the 
rulers to create guides.
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Set the ruler units in the Ruler Options dialog.



      

llowing operations respect Snap to 
:

agging with the Rectangle and Oval 
lection tools.

awing straight lines with the Brush 
l.

icking and dragging with the Paint 
cket tool and Magnifier tool.

agging floaters. The edges of the 
ater rectangle snap to the guides. 
e cursor—wherever it might be in 
 floater—also snaps to the guide.

agging the handles of reference 
aters to scale or slant (skew) them.

agging with the Floater Adjuster 
l to create a selection marquee.
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Double-click a guide marker. If you 
haven’t created a guide, double-click 
anywhere in the ruler. Painter 3D displays 
the Guide Options dialog. 

The Guide Position value shows the 
current position of this guide. You can set 
the guide to a specific position by entering 
a value in the Guide Position field. The 
units are specified in the Ruler Options 
dialog.

By default, guides are created in black. You 
can change the guide’s color by clicking 
the color chip and using the system color 
picker to choose a color.

If you want all guides to be the same color, 
check the Same Color For All Guides 
option. Choosing this option makes all 
existing guides the current color. If this 

option is off, you can create guides of 
different colors. This might help if you 
have several guides near each other and 
want a reminder for which is which.

If you want to lock a guide, check the 
Locked Guide option. This makes the 
guide “un-draggable.” You’ll need to open 
the guide’s options dialog again to 
unlock it.

You can clear all guides by clicking the 
Delete All Guides button.

Hiding and Showing Guides

To display the guide, choose Canvas 
menu> Guides> Show Guides.

To hide the guides, choose Canvas menu> 
Guides> Hide Guides.

Snap to Guides

If you want drag and click operations to 
snap to the guides, choose Canvas menu> 
Guides> Snap to Guides.

This feature is enabled when the menu 
item has a check beside it. Choose it again 
to disable the feature.

The “snapping” occurs when the cursor 
(or edge) is within 6 pixels of the guide.
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Set a guide’s position and color in the Guide 
Options dialog. 
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ntal Spacing

 

orizontal Spacing setting 
ines the spacing between vertical 
he unit of measure can be in pixels, 

, centimeters, points, picas, 
ns, or percent. Each column is 
lent to two inches. Percent refers to 
centage of the image’s width. For 
le, if the user chooses 10% for 
and height in a 100 x 120 pixel 
then grid lines will appear every 10 
going across (vertical lines) and 
2 pixels going down (horizontal). 

 

al Spacing

 

rtical Spacing setting determines 
cing between horizontal lines. 
t refers to the percentage of the 
s height.

  

rid options under Canvas menu> Grid> 
ptions.
Using the Grid Overlay 

Painter 3D has a grid layer to help guide 
you when laying down brush strokes or 
creating compositions. To activate the 
grid, choose Canvas menu> Grid> 
Show Grid, or click the Show Grid button 
on the right side of your Image window. 

The Grid Overlay is a special kind of 

guide. It’s not part of the imagery. If 

you want a grid in the image itself, use 

the Effects menu> Esoterica> Grid 

Paper feature.

When you paint or draw with the grid 
turned on, you’ll see your brush strokes at 
50% opacity. When you turn off the grid, 
the strokes will be at 100% opacity. To 
have 100% opacity when the grid is 
turned on, enable the Transparent 
Background option in the Grid options 
dialog. 

Grid Options

You can set up the grid to suit your 
working style by choosing Canvas menu> 
Grid> Grid Options. 

You can use the Tab key to move between 
the following fields:

Grid Type

Choose a command from the pop-up 
menu to determine whether your grid will 
be rectangular, have vertical or horizontal 
lines, or consist of small dots.
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Click the Show Grid button to activate the grid.

Painter 3D’s grid overlay.

Show Grid

Access g
Grid O



           

n also drop the mesh onto the 
as a graphic element. To do this, 
e Drop Mesh button in the Maps 
er palette. This converts the mesh 
al pixels in the image; as a 
uence, the action cannot be 
e. 

  

sh displays the correspondence between a 
nd its 2D map.
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Line Thickness

The Line Thickness setting sets the width 
of grid lines.

Grid Color

Click the Grid Color swatch to change the 
color of the grid lines. Choose a color in 
the system color picker, then click OK or 
press Return or Enter. The default color is 
a light blue.

Background

Click the Background color square to 
change the grid’s background color. 
Choose a color in the system color picker, 
then click OK or press Return or Enter. 
The default color is white.

Transparent Background

Click Transparent Background if you 
want the grid to be transparent so that 
your image will appear at 100% opacity 
when the grid is turned on.

Using the Mesh

Painter 3D uses a mesh for the mapping 
correspondence between the 2D image 
and 3D surface. The mesh type depends 
on the mapping mode selected for this 
map and the 3D application used to create 
the model. Viewing the mesh helps you 
see correspondence between the 2D image 
and 3D surface; this information might be 
helpful in developing images.

Display the mesh by clicking the Mesh 
button in the upper-right corner of the 
window. You can also choose Canvas 
menu> Display Mesh, or click the Display 
Mesh button in the expanded Maps 
Manager palette.
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ng Sense of Open Images

 

might be times when you have 
 images open in Painter 3D. Some 
be maps attached to objects and 
 might be images you’re 
menting with. 

ding on what you’re trying to 
plish at the moment, you may want 
 list of all open images onscreen or 
ose images that are maps 
ted with objects. Use the Objects 
ages palette to toggle back and 
etween listing all open images and 
just maps.

 

 all open images:

  

oose 

 

Objects 3D: Images menu> 
ow All Images

 

.

 

 only maps:

  

oose 

 

Objects 3D: Images menu> 
ow Only Maps.
Opening and Saving Images

You can open and save images regardless 
of whether they’re associated with a 
model or not.

Opening Existing Images

Painter 3D will open files saved in any one 
of its compatible formats (except EPS). 
You can open documents from other 
graphics applications and use Painter 3D 
to add brush strokes, tints, or textures. 

To open an existing image file:

1. Choose File menu> Open Image. An 
Open dialog appears.

2. Locate the file you want to open. If it 
was saved in Painter 3D or Painter, the 
right-hand side of the dialog shows a 
thumbnail of the document. 

3. From the Open dialog or the Browse 
dialog, open the document by 
double-clicking the file name, or by 
selecting the file name and clicking 
Open. You can also select the file 
name and press Return or Enter.

Painter 3D doesn’t open files saved in 

EPS format.

In Painter 3D you can have multiple 
images open at a time; however, each 
image has a requirement for RAM. 
Depending on the size and resolution, 
keeping multiple images open at a time 
may make Painter 3D run significantly 
slower.

Painter 3D can read files created with 

other programs only when they are 

saved in the RGB color or grayscale 

formats. Grayscale files are 

automatically converted to RGB on 

import. If you try to open a file that was 

saved in another format, for example 

CMYK, a dialog tells you the file must 

be in RGB.
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ormat

 

mpatibility with other programs, in 
l, TIFF is the best file format to use. 
intend to export your model or 
 to another program, save your 
ages or renderings in TIFF format.

 

File Format

 

r 3D supports the 
hotographic-Experts-Group 

) file format. Because of its small 
e and high quality, JPEG is 
only used to transmit files via 

.

llows you to compress your file on 
 of Fair to Excellent, where quality 
tly proportional to file size. These 
 settings will let you achieve 
ession ratios from less than 10-to-1 
ter than 100-to-1. 

s a lossy file format, meaning that a 
pressed JPEG file will not be 
or-pixel identical to the original. 
er, because the JPEG algorithm 

nto account the sensitivity of the 
different colors, the higher quality 
s should achieve visually satisfying 
. 
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Saving Images

To name and save an image file or 
rendering, make sure the Image window is 
active and choose File menu> Save As. 

Use the file type pop-up menu to save 
your document in any of the formats 
Painter 3D supports: RIFF, TIFF, PICT, 
Photoshop (2.0 and 3.0), BMP, PCX, 
Targa, EPS, or JPEG. Name your file and 
click Save. 

You can create a 2D collage in 

Painter 3D with renderings and image 

files. This file can be saved in any 

image format Painter 3D supports.

RIFF Format

It’s recommended that you save working 
files (files in process) in RIFF format. 
RIFF lets you compress files and save disk 
space with a “lossless” compression 
method. This option is dimmed with 
other formats.

Select the RIFF format. The checkbox for 
Uncompressed should automatically be 
disabled. 

RIFF is the only format in which you can 
save the user mask and keep floaters 
floating. Photoshop 3.0, TIFF, and PICT 
formats can retain only the selection 
information. 

RIFF is the best format for working in 

Painter 3D (or in any of the Painter or 

Ray Dream products); however, if you 

intend to export your finished models or 

images, you need to save your map 

images or renderings in a format 

supported by the other program. TIFF is 

a good choice in most cases.
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o applies to changes you make in 

 Images. Changes to the view in 

Model window, including Lights, are 

 

part of Undo. 

  

 used to partially undo effects and 
strokes. It is a form of undo, but 
orks on strokes and effects. The 
ommand measures an undo as a 
tage of your last effect or stroke. 
 a great way to achieve just the right 
t of an effect.

 

lows you to partially undo an effect.
To save a file as a JPEG:

1. Choose File menu> Save As and 
select JPEG from the list of file types. 

2. Click the Save button and the JPEG 
Encoding Quality dialog appears.

3. Choose a quality option and click OK.

Excellent compresses the least but 
retains the most data. Fair compresses 
the most but loses the most data. 

It is best not to decompress and 

recompress a file multiple times. 

Although JPEG can compress and 

discard data that is not visible or 

obvious, the degradation of the data 

can affect the condition of your file. 

When a file has lost a significant 

amount of data, blocky patterns may 

appear in areas of the image. If you use 

a JPEG as your bump map or if you try 

to use Painter 3D’s Apply Surface 

Texture effect on a JPEG image, you 

may find it will accentuate the blocky 

patterns.

Undoing Operations

To reverse changes, you can set multiple 
undo levels, and you can also use the Fade 
command to partially undo effects.

Multiple Undo

Multiple Undo allows you to undo and 
redo up to 32 levels of changes you make 
in an image. By using the Multiple Undo 
feature, you can experiment freely with 
Painter 3D’s brushes and effects without 
“committing” to every edit you make. The 
number of undos is set in the Undo 
Preferences dialog, found under Edit 
menu> Preferences> Undo. Five levels are 
set as a default. 

To Undo an action, choose Edit menu> 
Undo. To Redo an “undone” operation, 
choose Edit menu> Redo. Redo is 
generally only available immediately after 
an Undo.

The Fade operation merges data from the 
image into the previous undo layer. An 
Undo of a faded operation will effectively 
take you back two Undo levels.
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To see how fade works:

1. Draw a dark brush stroke or apply an 
effect.

2. Choose Edit menu> Fade. The Fade 
dialog appears. 

3. Drag the Undo Amount slider and 
watch the brush stroke or effect fade 
in and out.

4. When the preview shows the weight 
of stroke you want, or the right effect, 
click OK.

Fade allows you to partially undo a brush stroke.
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Painter 3D lets you draw and paint just 
like you do in the real world. You use the 
Brush tool to make marks in the Image 
window or on the model in the Model 
window. An infinite variety of marks is 
possible. The result of any single stroke 
depends on the specific brush you’re 
using, the current paper texture, color, 
and other choices you make.

Painter 3D provides a drawer full of 
different brushes, each with its own 
characteristics. Many of the brushes are 
digital equivalents to the traditional 
media you’re familiar with (a unique 
MetaCreations concept known as 
Natural-Media). Using these brushes, you 



                           

oose Window menu> Show 
ushes.

ss Command/Ctrl+2. 

uble-click the Brush tool in the 
ols palette.

ct a brush from the Brushes palette, 
e icon for the brush you want. You 

have to open the palette drawer to 
particular brush. You can also 
 a brush from the Brushes pop-up 

f Painter 3D’s brushes apply color 
mage or map. Some of the brushes, 
er, make changes to the pixels 

 

u select the Brush tool, choose a brush 
ariant from the Brushes palette. 
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can create images and maps that look like 
they were hand painted and sculpted on 
real surfaces.

Many of Painter 3D’s brushes respond to 
the additional control provided by a stylus 
and graphics tablet. Brush strokes fade in 
and out, change width, or penetrate based 
on the pressure of the stylus. 

This chapter is an introduction to the 
Brush tool and painting, including 
information about plug-in brushes. You’ll 
find more information about the default 
brush variants in “Painter 3D Brush 
Variants” on page 165. The many controls 
and features for customizing brushes are 
described in the advanced painting 
chapter of the online book Painter 3D 
Advanced Guide.

To begin painting:

1. Open a model and load a blank 
texture map.

2. Choose the Brush tool from the Tools 
palette.

3. In the Brushes palette choose a brush, 
then choose one of its variants from 
the Variant pop-up.

4. Choose a color to paint with from the 
Art Materials: Color palette or from 
the color set. (When you first launch 
Painter 3D, the default color is black.)

5. Choose a texture from the Art 
Materials: Paper palette.

6. Adjust the sliders for brush size, 
opacity, and penetration into the 
paper grain on the Controls palette: 
Brush tool.

7. Mark in either the Image window or 
the Model window. 

The following sections provide details on 
each of these steps.

Choosing a Brush and Variant

The Brush tool represents a category of 
marking tools. The Brushes palette lets 
you choose different types of 
brushes—Pencils, Chalk, Crayons, Oils, 
Airbrush, and more. The Brushes palette 
also lets you choose different varieties 
(called variants) of each brush. For 
example, the Pencils brush offers the 
following variants: 2B Pencil, 500 lb. 
Pencils, Colored Pencils, a Sharp Pencil, a 
Single Pixel Scribbler, and Thick & Thin 
Pencils. 

You can show the Brushes palette in any 
one of three ways: 
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you choose a color from the Color 
, the color you select appears in the 
verlapping rectangle. This is the 
y color. The rectangle in back 
the secondary color, which is used 
te two-color brush strokes and 
int gradations.

ose the secondary color, click the 
ctangle, then select a color. 

 

u have colors in the image already, 

can pick one by clicking on it with 

Dropper tool. The Command/Ctrl 

toggles the Brush tool to the 

per tool, so you can easily sample 

 

lor.

 

ng a color on the Color palette is 
e beginning of working with color 
ter 3D. Painter 3D offers a 
ul range of color features, 

ing random color variability and 
ets. For more information, refer to 
ing with Colors: The Color Palette” 
e 139.

 

already in the image or map. If you use 
one of these brushes in a blank area, you 
might not see a change. If one brush 
doesn’t produce the results you’d like, try 
a different one. You’ll learn more about 
brushes and their methods in “Learning 
about Brushes—Starting with Method” 
on page 125.

Special Brushes

There are a few special brushes worth 
mentioning. You can find out more about 
how to use these brushes in the online 
book Painter 3D Advanced Guide.

The Cloner brushes are very handy. They 
take their color from a clone source rather 
than the Color palette. 

The Image Hose brush is unique—it lets 
you paint with images instead of brush 
dabs. 

The Layer brush is particularly useful for 
painting in 3D. It lets you paint on a 
transparent floater while viewing the 
imagery beneath it. 

You have so many brushes and 

variants to choose from in Painter 3D 

that you might use them with only the 

basic adjustments—size, opacity, and 

the amount of grain. If you want to 

create your own, custom variants, 

Painter 3D offers a number of controls 

that let you modify the brush effect. To 

retain these specific adjustments for 

future use, you’ll need to save the 

variant. Refer to the advanced painting 

chapter in the online book Painter 3D 

Advanced Guide for more information. 

Choosing Colors

Before painting, you’ll want to choose a 
color. Usually, you’ll pick colors from the 
Art Materials: Color palette or from the 
color set. You could also sample colors 
from an existing image using the Dropper 
tool.
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In the Art Materials: Color palette, drag in the 
ring to select a hue. Drag in the triangle to pick 
the color.



                   

ick the back rectangle and select a 
ondary color. 

  

ick the front rectangle again to 
ke it active. This keeps the primary 
tangle selected for the next time 

u pick a color.

  

fore you make a stroke, choose 

 

ushes palette: Control menu> 
ders

 

. Painter 3D displays the 
ders palette.

  

 the Color slider to Direction.

  

the Image window, paint an “X.” 
tice that the primary color is used 
one mark and the secondary color 
sed in the other. Draw some loops 

d circles to see the transitions.

ight want to try a different setting 
 Color slider. If you have a 
re-sensitive tablet, try Pressure 
 of Direction. 

  

ers help you to set up a two color brush 
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Two-color Brush Strokes

Usually you work with only the primary 
color, the front rectangle of the two 
overlapping rectangles in the Color 
palette. Using one color produces a solid 
brush stroke.

By selecting a secondary color, you can 
determine the colors for a two-color 
brush stroke.

Multicolored brush strokes are created 

using Color Variability. For more 

information, refer to “Setting Color 

Variability” on page 142.

The settings for the brush on the Brushes 
palette: Control menu> Sliders palette 
determine how Painter 3D decides when 
to use one color or the other.

To set two colors for brush strokes:

1. Choose the Brush tool from the Tools 
palette. 

2. Select the Graduated Brush variant of 
the Brush in the Brushes palette, or 
choose another mark-making brush 
variant.

3. Click the front rectangle on the Color 
palette to select it.

4. Select a color in the Art Materials: 
Color palette or from a color set. The 
front rectangle shows your selection.
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Set the primary and secondary colors to use two 
colors at once.
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Painting 121

      

g Basic Brush Controls

 

rush controls for Size, Opacity, and 
are found on the Controls palette 
he Brush tool is selected.

ntrols palette: Brush tool might 
 other sliders, depending on the 

t variant. You’ll learn about these 
her advanced controls in the online 

 

ainter 3D Advanced Guide

 

.

 

nges you make in variant size, 

city, grain, and so on are temporary 

ss you deliberately save them. For 

plete information on customizing 

 saving your brushes, refer to the 

e book 

 

Painter 3D Advanced 

 

e

 

.

  

ze slider controls the size of the 
dab. The text field lets you enter a 
c size (in pixels). Or, you can use 
izing shortcut, but the shortcut 

  

e, Opacity, and Grain sliders are found 
ontrols palette: Brush tool.
For more information, refer to the Sliders 
palette discussion in the advanced 
painting chapter of the online book 
Painter 3D Advanced Guide.

Choosing Paper Texture

In the natural world, a marking tool has 
different effects on surfaces of different 
texture. Painter 3D allows you to control 
the underlying texture beneath the marks 
on the image or map to achieve the results 
you’d expect from natural media on a 
given surface—pencil on watercolor 
paper, felt pens on cotton paper, chalk on 
the sidewalk, and so on.

You might think that specifying a paper 
texture lends itself more to 2D imagery, 
but the grain of a paper texture can add 
depth and realism to your 3D model too. 
The underlying paper texture is apparent 
when you paint in either the Image 
window or the Model window; paint into 
both to achieve the optimum effect. Paper 
texture is also useful for simulating bump 
maps for 3D applications that only 
support texture maps.

Of course some brushes, like the 
Airbrush, don’t reveal paper texture in 
their strokes. This follows the behavior of 
the natural tools. In Painter 3D, brushes 
that react with paper texture have a 
“grainy method.” You’ll learn more about 
controlling grain interaction in “The 

Water Color Brush Variants” on page 128 
and brush methods in “The Methods” on 
page 126.

Choose a paper texture on the Art 
Materials: Paper palette. Painter 3D uses 
the current selected texture, so you can 
make a few strokes, then change the paper 
and make a few more strokes with 
different results. 

If you have a stylus and tablet, you can 
adjust grain by changing the stroke of the 
stylus on the pressure sensitive tablet. In 
most cases, a light stroke colors only the 
peaks and ridges of the grain. A heavy 
stroke fills color deep into the pockets and 
valleys. You can also use the Grain slider 
on the Controls palette: Brush tool.
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Most of Painter 3D’s brushes interact with the 
current paper texture. 

The Siz
on the C



             

pacity low, the color is thin. You’ll 
 to see through to the underlying 
 

 

 brush method, Grainy Edge Flat 

er, does not change in opacity. It is 

nature of any brush with this 

hod not to respond to adjustments 

 

make in the Opacity slider.

  

ain slider controls how much color 
ates into the paper texture. You can 
 percentage for specific grain 
ation. Lower settings show more of 
in.

  

 Opacity slider to adjust buildup and 
rength.
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only works in the Image window—it 
won’t have any effect in the Model 
window.

Some brushes must be “built” after you 
resize them. Choose Brushes palette: 
Brush menu> Build Brush. You can also 
press Command/Ctrl+B (or click the 
Build button on the Size palette) to build 
the brush. If you try to paint with an 
“unbuilt” brush, Painter 3D alerts you. 
For more information on building the 
brush, refer to the online book Painter 3D 
Advanced Guide.

To change brush size in the Image 
window:

1. Hold down the Command-Option/
Ctrl+Alt keys.

2. In the Image window, click and drag. 
A circle that represents the brush size 
appears beneath the cursor. When 
you’ve dragged the circle to the size 
you want, release the button. 

3. You might need to build the brush 
now.

When you use this method to resize the 
brush, you must do so in the Image 
window. You can’t resize the brush in the 
Model window.

Opacity

The Opacity slider controls the degree a 
stroke “covers” or “builds up” on the 
underlying colors. You can also enter an 
Opacity percentage in the text field.

When Opacity is at maximum, the color is 
solid, completely covering, or building up, 
on the underlying colors.

With O
be able
colors.

One

Cov

the 

met

you 

Grain

The Gr
penetr
enter a
penetr
the gra

The quickest method to set brush size is to use the 
keyboard shortcut in the Image window. Use the

cover st
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 some brushes, you see a dotted 

before the mark appears. This 

ed line appears when you use 

plex brushes. For example, the Van 

h brush and the Hairy Brush must 

recomputed, which delays the 

ke’s appearance on the screen. For 

 results, apply these brushes in 

t strokes. Wait for each stroke to 

 

ear before you start the next one.

   

 an image to create strokes using the 
d Draw Style.
Moving the Grain slider to the right 
intensifies penetration of the color. This 
allows less texture to show through. 

Moving the slider to the left reduces the 
stroke’s penetration, which reveals more 
texture. 

Painting the Surface 

You paint the surface by dragging 
freehand in the Image window or the 
Model window with the Brush tool. Each 
drag is considered a stroke. Painter 3D 
also lets you create straight line strokes in 
the Image window by clicking.

Painter 3D offers a number of other brush 
stroke features that help you get the 
results you want as easily as possible.

Freehand versus Straight Lines Drawing

With Painter 3D, you can draw freehand, 
or with straight lines in the Image 
window. Radio buttons on the Controls 
palette: Brush tool let you choose the 
mode you want.

Freehand allows you to drag in any 
motion or direction you like. The stroke 
follows your drag path.

Straight Lines mode connects each point 
you click with a line. Instead of clicking, 
you can drag to place the point exactly 
where you want it. You can close the 
polygon (connected to the origin) by 
pressing the Return/Enter key. When 
you’re through drawing straight lines, 
click the Freehand button to return to 
freehand drawing. You can toggle between 
the Draw Styles as you paint.

You can’t paint with straight lines or 

constrain painting in the Model window. 
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Use the Grain slider to control how brush strokes 
react with the paper grain. 

Use the Controls palette: Brush tool to choose the 
Freehand or Straight Lines Draw Style.
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ls palette: Brush tool. For example, 
g the Opacity or Grain slider to the 
 give the same results as pressing 

 with a stylus. 

 3D offers brushes specifically 
ed for using a mouse. Load the 
 brush library located in the New 
s folder.

 

u have a mouse, you can use the 

hes palette: Control menu> Sliders 

tte to compensate for the lack of 

sure information. Instead of using 

sure to determine size or color, you 

ld use direction. For more 

rmation, refer to the advanced 

ting chapter in the online book 

 

ter 3D Advanced Guide

 

.

 

cking Speed

 

the Controls palette: Brush tool, 
n set the 3D tracking speed, which 
 the number of screen redraws in 
del window during a brush stroke. 

any of Painter 3D’s brushes, you 
not notice much difference 
n the settings at the ends of the 
For larger, complex brushes that 

e to compute onscreen, you’ll see 
ence. When you set the speed at 
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Keyboard Shortcuts

Use these keyboard shortcuts to switch 
between Freehand or Straight Lines 
mode.

Working in Straight Line mode, typing 
“v” will end the current polygon so you 
can begin a new one.

Constraining Stroke Angle

In either drawing mode, to constrain your 
strokes to 45° increments, hold down the 
Option-Shift/Alt+Shift keys as you drag 
or click. 

In Straight Line mode, lines automatically 
are constrained to a grid if the Snap to 
Grid option is turned on. Snap to Grid is 
found under the Canvas menu> Grid 
submenu.

Undo stroke

If you make a stroke you don’t like, choose 
Edit menu> Undo and Painter 3D 
removes it. Repeat the command to 
remove the previous stroke. You can set 
the level of undos as a preference. For 
more information, refer to “Setting 
Multiple Undo Levels” on page 45.

Fade stroke

If you apply a stroke, but want it less 
opaque, choose Edit menu> Fade. Set the 
fade amount for the opacity you want as 
shown in the preview.

Stylus Versus Mouse

Many of Painter 3D’s brushes respond to 
the pressure information provided by a 
drawing stylus. Greater pressure can 
increase the width of a brush stroke, the 
penetration of color, or the degree of 
some other effect, depending on the 
variant. 

Many stylus and graphics drawing tablets 
provide 256 levels of pressure 
information. The mouse has no pressure 
information. The mouse is either “on” 
(button down), or “off” (button up). 

If you are using a mouse with Painter 3D, 
you can compensate for the lack of 
pressure information by adjusting the 
Size, Opacity, and Grain sliders on the 
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ning about 
hes—Starting 
 Method

 

 3D has so many different brushes 
arching out the right one can be a 
ng task. You can expedite the search 
ning more about the 
s—specifically, what makes them 
nt from each other.

ethod defines the most basic level 
h behavior. A brush method is the 
tion on which all other brush 
es build. Painter 3D provides eight 
ds—Buildup, Cover, Eraser, Drip, 
Cloning, Wet, and Plug-in.

 

ause of Painter 3D’s masking 

bilities, the Mask method is no 

er required. The Mask method is 

ided for compatibility with Detailer 

hes. In Painter 3D, all Mask 

hods will be mapped to the Cover 

 

hod. 

 

ethod may have several versions, 
method subcategories. The 
egories further refine the brush 
or. The following terms are used in 
ing most of the variations:
100%, Painter 3D continuously updates 
the screen to try to match the speed of the 
cursor. This can make the paint look like 
it appears more smoothly on the model, 
but the stroke can sometimes finish after 
you release up on the stylus or mouse. 

Setting the speed slower makes the paint 
appear incrementally because Painter 3D 
updates the screen less frequently than at 
the 100% setting. However, the stroke 
finishes at the same time as you release up 
on the stylus or mouse.

You can set the 3D tracking speed to suit 
your personal working style as well as the 
brush and model you’re working with. 
Painting as close to real time as possible 
may be desirable much of the time, but 
might not be important at other times, 
such as when you’re using broad, big 
strokes to fill an area. Experiment with 
this setting to get a feel for what works 
best for you.

Where You Can Paint—the 
Image, a Floater, or a User Mask

Most of the time you’ll want your brush 
strokes applied directly to the image in 
either the Image window or the Model 
window. But you can also paint into a 
floater. When a floater is selected 
(highlighted in the Floater List), that 
floater is the target for your brush strokes. 

For more information, refer to the floaters 
chapter in the online book Painter 3D 
Advanced Guide. 

If you try to paint on a floating object 

that’s not an image floater (a plug-in 

floater or reference floater), Painter 3D 

immediately converts the object to an 

image floater so it can accept your 

brush strokes. 

There’s one other possible destination for 
your brush strokes—a user mask. When a 
user mask is selected (highlighted in the 
Mask List), that mask is the target for 
your brush strokes. For more 
information, refer to the masks chapter in 
the online book Painter 3D Advanced 
Guide.

In all cases, your brush strokes go to the 
selected target, so make sure of the 
destination before starting to paint. 
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ver methods produce brush 
 that cover underlying strokes. An 
le of “cover” is oil paint. No matter 
olors you paint, you can always 
 layer of paint that completely 
hat’s underneath. Even with a 
ackground, a thick layer of yellow 
 pure yellow. Chalk and Airbrush 
mples of Cover brushes.

  

aser methods either erase, lighten, 
, or smear the underlying colors. 
aser variants, Dodge, and Burn all 
 Eraser method.
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• Soft methods produce smooth, 
anti-aliased strokes.

• Flat methods produce strokes with 
hard, “pixellated” edges.

• Hard methods provide brush strokes 
with semi-anti-aliased edges 

In a few instances, you’ll see the words 
“edge” and “variable” in a method 
subcategory. Edge refers to strokes that are 
thick and sticky looking. Variable refers to 
a brush stroke that starts off a bit more 
transparent. Last, there’s “grainy,” which 
refers to how the brush reacts to the paper 
grain.

Method and method subcategories are set 
from the pop-ups in the expanded 
Brushes palette. You can think of the 
method and method subcategories as 
attributes of the stroke’s appearance. 
Putting together the method categories 
and their variations results in the specific 
brush method (that may be assigned to a 
given brush). For instance, Grainy Hard 
Cover means that brush strokes interact 
with paper grain and have 
semi-anti-aliased strokes that hide 
underlying ones. Grainy Hard Cover is the 
default method for Chalk and Charcoal.

To display the method and subcategory, 
click the Brushes palette grow box. You 
can hide the pop-ups by clicking the grow 
box again.

The Methods

Buildup

The Buildup methods produce brush 
strokes that build toward black as you 
overlay them. A real-world example of 
buildup is the felt pen: Scribble on the 
page with blue, then scribble on top of 
that with green, then red, and so on. The 
scribbled area keeps getting 
darker—approaching black. Even if you 
were to apply a bright color like yellow, 
you couldn’t lighten the scribble, it would 
stay dark; this is buildup. Crayons and 
Felt Pens are buildup brushes.
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The Method and Subcategory pop-ups show the 
method of the current brush. 
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haps you want the Scratchboard 
ariant of the Pens brush to smear 
ying colors. You can change its 
d from Cover to Drip.

 

e brush effects are closely 

endent on their own methods. The 

 

lts from some brushes may differ.

 

sh stroke on top was created using 
Hard Buildup. The stroke on bottom was 
using Soft Variable Buildup.
Drip

The Drip methods interact with the 
underlying colors to distort the image. 
The Liquid brush variants use the Drip 
method. The Grain slider controls the 
strength of distortion a Liquid brush 
exerts on an image.

The Drip methods do not work in user 

masks.

Cloning

The Cloning methods take imagery from 
a clone source and re-create it in another 
location, often rendering it in a 
Natural-Media style. Cloning is covered in 
detail in the online book Painter 3D 
Advanced Guide. 

Wet

The Wet methods work in the wet layer to 
produce water color effects. Using the 
Water Color brushes and working in the 
Wet method is described in “Water Color” 
on page 128.

Plug-in

Plug-in is a special method. It defines no 
specific brush behavior itself, but is an 
avenue to a wide range of behaviors. The 
specific behavior is determined in the 
method subcategory. You’ll find more 
information on Plug-in brushes in 
“Expandable Plug-in Brushes” on 
page 129.

Changing Methods

Because the method sets a brush variant’s 
most basic behavior, you can alter a 
variant’s behavior by changing its 
method.

Lets say you want a charcoal-looking 
stroke, but instead of hiding underlying 
strokes, you want brush strokes to build to 
black. You can get this effect by changing 
the method to Buildup. 
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ss Shift-D or adjust the slider on 
 Water palette.

  

peat the command until the strokes 
w the level of diffusion you want. 

 

ater Color Brush Variants

 

he Water Color variants, except 
aser, interact with the canvas 
. The Grain slider works differently 
e Water Color brushes than with 
er brushes. With Water Color 

ts, moving the slider to the right 
the texture more pronounced. 
g the slider to the left reduces the 
nteraction.

pressure affects the width of the 
stroke for all of the Water Color 
variants (except Wet Eraser). 
ed pressure widens a brush stroke; 

sed pressure narrows a stroke.

 

 color stroke before and after diffusion.
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Water Color

The Water Color brush variants produce 
natural looking watercolor effects.

The Wet Layer

Water Color brushes are different from 
the other brushes. Water Color brushes 
paint into the “wet layer,” which has 
special properties that enable the colors 
brushed into it to flow and mix. 

The wet layer floats over the image. This 
separation of layers enables effects and 
techniques that wouldn’t otherwise be 
possible. You can edit the watercolors, 
including erasing and blurring, without 
changing anything in the image layer. For 
example, you can draw pencil outlines in 
the image layer, then overlay watercolor 
shading without smudging the pencil 
lines. 

When you want the Wet layer to merge 
with the canvas, choose Canvas menu> 
Dry.

You can’t edit the wet layer with 
image-layer tools. If you’re using the 
Eraser brush and it has no effect on a 
brush stroke, that stroke may be in the wet 
layer. Use the Wet Eraser instead. 

You can’t use the Selection tools to select 
and delete an area in the wet layer. 

You can’t use the Dropper tool to sample 
colors from the wet layer.

Diffusion

Diffusion creates wonderful, soft, feathery 
edges on the strokes of some water color 
variants. In terms of natural water colors, 
wet paper produces more diffuse strokes.

After applying water color strokes—but 
before drying—you can increase the 
diffusion of your strokes.

Diffusion spreads color into the grain. 

Make sure the current texture is 

appropriate for the diffusion effect you 

want.

To use diffusion:

1. Apply one or more strokes with a 
water color brush variant.

2. To restrict the diffusion to a region, 
make a selection with any selection 
tool, such as the Lasso or the 
Rectangular Selection tool. The 
diffusion effect will apply only within 
the selection.
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nt. If you want to customize your 
to the New Brushes, place the brush 
ts on custom palettes. 

 

ing start-up, Painter 3D scans its 

 folder and its sub-levels. The 

ram loads any plug-in brushes it 

 

s.

 

lug-in Brushes may have a specific 
ontrols. These controls are 
ble through the Brushes palette: 
l menu. The nature of the controls 
s on the actual Plug-in Brush.

 Brushes fall into two categories: 
hat define a new method 
egory and those that define a new 
type. 

ber that the variants you find 
the Plug-in Brushes are just the 
ou can customize the effect from 
these brushes by moving sliders 
anging options in the Controls 
—Size, Spacing, Rake, etc. You can 

ent to discover brush effects you 

 

Expandable Plug-in Brushes

Painter 3D’s Natural-Media engine has an 
extensible, open architecture for creating 
and adding new brushes. The architecture 
is called the Plug-in Brush. Painter 3D 
comes with a variety of great Plug-in 
Brushes. This extensibility allows you to 
add new exciting brushes by copying files 
to your Painter 3D folder. The next time 
you launch Painter 3D, the program loads 
the new brushes and you can paint with 
them. 

The Plug-in Brush enables new brush 
behaviors never before possible, like 
painting on a transparent floater with 
color and into the mask simultaneously. 

The power and behavior of future brushes 
is virtually unlimited. Visit the 
MetaCreations Web site occasionally to 
learn what’s available.

MetaCreations encourages third-parties 

to develop Plug-in Brushes. If you’re 

interested in creating new Plug-in 

Brushes for Painter 3D or Painter 5, 

visit the MetaCreations Web site for 

more information.

Plug-in Brushes can deliver extraordinary 
effects and diverse painting styles. 
Painter 3D  comes with dozens of cool 
Plug-in Brushes.

All of the Plug-in Brush variants that 
come with Painter 3D are in alternate 
libraries. The brush files for F/X, Gooey, 
Layer, Mouse, New Paint Tools, Photo, 
and Super Cloners variants are found in 
the New Brushes folder in the Painter 3D 
folder. You can quickly load the New 
Brushes by choosing Window menu> 
Custom Palette> Shortcut to New 
Brushes. You can also load one of these 
libraries by choosing Brushes palette: 
Brush pop-up> Load Library. Use the 
Open dialog to locate and open the library 
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Each Plug-in Brush is unique.



        

ing on a Transparent 
er with the Layer Brush

 

yer brush uses a Plug-in brush 
d subcategory that lets you paint on 
parent floater. With the Layer 
 you’re able to look right through 
ater to the background imagery, but 
rush stroke appears in the floater. 
n paint over the image without 
ging” it. You might find this feature 
larly useful while painting in the 

 window.

yer brush works by adding color to 
ater image while simultaneously 
 to the floater’s mask to make the 
visible.

 

 can customize almost any brush to 

t into a transparent floater by 

nging its method to Plug-in and its 

category to Transparent Layer 

 

h.

 

nt on a transparent floater:

  

oose 

 

Objects palette: Floater 
nu> Transparent Layer

 

. 
inter 3D creates a new transparent 
ater that’s equal to the canvas size. 
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Many plug-in brushes let you use a 

captured dab. This can lead to 

extraordinary and unique brush 

variants. For more information, refer to 

the online book Painter 3D Advanced 

Guide.

Using Plug-in Methods with 
Other Brushes

Remember that you can change the 
behavior of any brush by changing its 
method. You can take advantage of this by 
giving one of the traditional brushes a 
Plug-in method.

You can choose any of Painter 3D’s 
traditional brush variants (for example, 
the Impressionist variant of the Artists 
brush) then set its Method to Plug-in and 
choose one of the available method 
subcategories—Left Twirl, for example. 
This gives you a brush that performs 
left-handed twirls with the dab and stroke 
of the Impressionist variant. This is only 
one example; the possible combinations 
are limited only by your imagination.
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The subcategories you find under the Plug-in 
Method are just the start. You can give any brush 
Plug-in behavior by choosing a Plug-in Method 
and Method subcategory.

You can give any built-in brush Plug-in power by 
changing its method.
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You can find out more about floaters 
in the floaters chapter in the online 
book Painter 3D Advanced Guide. 

2. Choose one of the Layer brush 
variants and start painting. To find 
the Layer brush, click the Layer brush 
icon from the Shortcut to New 
Brushes Custom palette or load the 
Layer brush library from the New 
Brushes folder.

The transparent floater must be 

selected (highlighted in the Floater List) 

to paint into it.
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lying Art 
terials

 

ing With Art Materials

 

App
Ma
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Painter 3D’s Art Materials palette holds 
the media you apply to images and 
maps—color, paper textures, gradations, 
patterns and weaves. You’ll use the art 
materials in several ways:

• To load the Brush tool for painting.

• To fill selections with the Effects 
menu> Fill command or with the 
Paint Bucket tool.

• To control certain image effects by 
applying surface textures.

This chapter shows you how to select and 
customize the different Art Materials. It 
also shows you how to create your own 
materials and save them to a library.



      

lor, Painter 3D offers Color Sets. All 
other art materials use libraries. 
fault libraries offer sample 
als. You’ll find more libraries with 
nal materials on the Painter 3D 
M. 

 

more information on libraries, 

ding loading alternate libraries, 

ting your own libraries and 

aging library contents, refer to 

 

raries” on page 24. 

  

er, Grad, Pattern and Weave palettes use 
s. Load other libraries for more materials. 
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The Art Materials Palette

The Art Materials palette organizes all of 
Painter 3D’s art materials. The materials 
are:

• Colors

• Papers

• Gradations

• Patterns

• Weaves

You can display the Art Materials palette 
in a variety of ways. In its smallest form, 
you see the face of the palette displaying 
the subpalette icons.

The Art Materials palette is a main palette, 
and each material is a subpalette. Click the 
icons to switch between subpalettes. You 
can tear off the subpalettes if you like, for 
example, to use the Color palette and 
Grad palette at the same time. 

If you do not see the Art Materials palette 
on your screen, you can display it by 
choosing Window menu> Show Art 
Materials. 

For more information on palettes and 

subpalettes, refer to “Palettes” on 

page 14. 
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Click the icon below the Art Materials palette 
menu names to display their subpalettes. Click 
the grow box in the upper right to expand the 
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 can also fill a user mask. Just 

ct the mask in the Mask List before 

 

osing Effects menu> Fill. 

 

with the Paint Bucket:

  

lect the Paint Bucket tool from the 
ols palette. 

  

ake sure the 

 

Controls palette: 
int Bucket

 

 tool is visible. You need 
o set your Paint Bucket controls.

  

e the What to Fill pop-up to choose 
 type of fill you want. 

age fills the canvas selection based 
 where you click and the current 
lerance and Feather settings. 

  

ntrols palette: Paint Bucket tool lets you 
hat to fill and what to fill it with. 
Filling With Art Materials

In order to use the art materials to their 
fullest, you need to know how to fill areas 
in your images. To fill an area with art 
materials—color, a gradation, pattern or 
weaving, use the Effects menu> Fill 
command or the Paint Bucket tool. 

The remainder of this chapter first 
describes filling techniques, then 
describes the various art materials. 

What about filling with paper? Paper is 

a texture or grain. It has no color by 

itself. However you can get grain into 

the image with various image effects. 

Use Effects menu> Surface Control> 

Express Texture for pure texture. You 

can also try other surface control 

effects that let you use paper as the 

control medium, for example, the Apply 

Surface Texture command.

Filling an Area

To fill an area with color, gradations, 
pattern or a weaving, use the Effects 
menu> Fill command or the Paint Bucket 
tool. 

To use the Fill command:

1. Select part of your image. Refer to the 
selection chapter in the online book 
Painter 3D Advanced Guide.

2. Choose Effects menu> Fill. You may 
also press Command/Ctrl+F. The Fill 
dialog appears.

3. Select what you want to fill with—the 
current color, gradation, clone 
source/pattern, or weaving. 

If no Clone Source file is selected, 
Painter 3D uses the current Pattern.

4. Adjust fill opacity if you like.

5. Click OK. Painter 3D fills the 
selection.
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Use the Fill command to fill a selection.
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creasing the Color Feather 
pands the neighborhood.” 

ypically, Tolerance is set low when 
lor Feather is high.) The more 
tant a pixel’s color is, the less 
aque the fill.

ti-alias creates intermediate fill 
lues on the boundaries. This gives 
ft edges to the fill. (Anti-aliasing is 
sirable when Color Feather is zero 
 extremely low.)

  

ick in the area of the image you 
nt to fill.

he result is not what you want, 
do the fill, change the settings and 
 again.

 

 Line Work

 

plex images, the lines don’t always 
his creates a leak that can send 
n Cel or contiguous pixel fills into 
here you don’t want 
sometimes even through the 

image. This can be particularly 
matic when the image is mapped 
 3D model. Fortunately, there’s a 
 limit leakage.
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If you click outside the selection, 

Painter 3D keeps the fill out of the 

selection. 

Cartoon Cel fills the interior of areas 
bounded by lines in the selection 
mask. For more information about 
Cartoon Cel fills, refer to “Using the 
Cartoon Cel Fill Method” on 
page 137.

4. Use the Fill With pop-up to choose 
the material you want in the fill. The 
Current Fill preview at the left of the 
Controls palette shows the selected fill 
material. 

Current Color uses the selected color.

Grad uses the selected gradation. 

Clone Source uses the current clone 
source image. If you haven’t defined a 
clone source, Painter 3D uses the 
current Pattern. For more 
information, refer to the cloning 
chapter in the online book Painter 3D 
Advanced Guide.

Weave uses the selected weave.

What about filling with Paper? The 

Paper is a texture. It has no color by 

itself. However you can get texture into 

the image with various image effects. 

Use Effects menu> Surface Control> 

Express Texture for pure texture. You 

can also try other Surface Control 

effects that let you use Paper Texture 

as the control medium.

5. Use the Art Materials palette to 
choose the specific material you want.

6. If you are doing an Image fill, adjust 
the Controls palette sliders for 
Tolerance and Color Feather and the 
setting of the Anti-alias option. 
(These settings do not apply to 
Cartoon Cel filling.)

Tolerance sets the amount of variance 
allowed from the color of the pixel 
you click on. With Tolerance set low, 
the Paint Bucket fills only contiguous 
pixels that are very close to the color 
of the pixel you click on. With 
Tolerance high, the Paint Bucket fills 
a greater range of colors.

Color Feather controls the fill opacity 
for pixels outside the Tolerance range. 
With Color Feather low, pixels with 
neighboring colors receive partial fill. 
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rtoon Cel Fill method is a 
tep process:

 

y the lines to the selection:

  

oose 

 

Select menu> Auto Select

 

.

  

oose Image Luminance from the 
ing pop-up.

  

ick OK. Painter 3D creates a 
ection that will protect the dark 
es.

hen you protect anti-aliased or 
n-black lines in this way, the lines 
the selection mask have varying 
els of transparency—depending on 
 pixel luminance. The Mask 

 

Cartoon Cel fill, you paint the lines first, 
 areas afterward.
To limit leakage:

1. With Cartoon Cel or Image selected 
on the Controls palette: Paint 
Bucket tool, click within the image 
section you wish to fill.

2. Without releasing the mouse or 
stylus, drag a rectangle that is a bit 
larger than the area you are filling.

3. Let go. If there is no leak, only the area 
within the black lines will be filled. If 
there is a leak, the fill will go outside 
the area, but not beyond the 
constraints of your rectangle. 

Sometimes you can’t tell if there’s a leak 
just by looking at your image. But if you 
click in a small area and see the prompt, 
“Now Looking for Extent of Fill,” there 
probably is a leak and Painter 3D is 
preparing to fill a bigger area than you had 
in mind. To stop the fill, press Command/
Ctrl+. (period) or choose Edit menu> 
Undo, press Command/Ctrl+Z if you 
don’t catch it.

Lock-Out Color

The Lock-Out Color feature protects areas 
of a given color from accidental filling. 
The Lock-Out Color sets a color that will 
not accept filling when clicked on with the 
Paint Bucket. Black is the default.

This feature applies when filling the 
Image—not Cartoon Cels.

To change the Lock-Out Color:

1. In the Art Materials: Color palette, 
choose the color you want protected.

2. Double-click the Paint Bucket tool 
icon in the Tools palette. The Mask 
Threshold dialog appears. 

3. Click Set. The Lock out color chip 
updates to the new color.

4. Click OK to close the dialog.

Using the Cartoon Cel Fill 
Method

The Cartoon Cel fill method is especially 
good for producing solid fills of regions 
bounded by anti-aliased lines. The 
Cartoon Cel fill method works in 
conjunction with the selection to fill the 
regions completely and without damaging 
the lines.
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ng Leaks

 

you use the Cartoon Cel fill 
d, you can fix leaks by saving the 
n to a mask, editing it by hand, 
loading it to the selection.

 

se a leak:

  

ake sure you have an active 
ection.

  

oose 

 

Select menu> Save 
lection

 

. The Save Selection dialog 
pears.

  

oose New from the Save to pop-up.

  

ick OK. A new mask appears in the 

 

jects palette: Mask List

 

.

  

ished image filled using Cartoon Cel.
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Threshold lets you compensate for the 
semi-transparency of the selection 
mask to get just the fill you want.

To set Mask Threshold for the 
Paint Bucket:

1. Double-click the Paint Bucket tool 
icon in the Tools palette. The Mask 
Threshold dialog appears. 

2. Set the Mask Threshold slider for the 
softness of your lines. This slider 
controls how much the Cartoon Cel 
fill respects the mask. At zero, the fill 
will overrun the mask boundaries. 
Higher threshold values force the fill 
to respect the boundaries.

The appropriate threshold setting 
depends on the softness of your lines. 
You’ll have to experiment with the 
Mask Threshold slider settings until 
the fill is limited to the area within the 
line.

3. Click OK.

To fill with the Cartoon Cel fill method:

1. Choose the Paint Bucket tool from the 
Tools palette.

2. On the Controls palette: Paint 
Bucket tool, choose Cartoon Cel, 
from the What to Fill pop-up.

3. Choose what you want to fill 
with—Color, Grad, Clone Source 
(Pattern) or Weave.

4. Use the Art Materials palette to 
choose the material you want.

5. Click inside a bounded region. 
Painter 3D fills the area.

If the fill overruns the lines, you 
should increase the Mask Threshold 
setting. If the fill leaves line pixels 
anti-aliased to the background color, 
you should reduce the Mask 
Threshold setting.
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ing with Colors: The 
r Palette

 

ter 3D, you can add color to 
 in many ways. The Color palette is 
you select the colors to use. You can 
e the Dropper tool to sample or 
p” a color from an image.

re unique to Painter 3D is the 
 to set color variability. Color 
ility can enhance the Natural-Media 
ance of your work. The Color 
s contain sliders to adjust 
ility. Variability allows you to create 
strokes of several color levels. 

 

 the Color Palettes

 

r 3D provides three different types 
or palettes for you to use: Standard 
, Compact Colors, and RGB Colors. 
n choose between palette displays 
he Art Materials palette: Color 
 Color Picker. 

 

5. Select the mask from the Objects 
palette: Mask List.

6. Choose a brush for masking. The 
same brush you created the lines with 
would be ideal. 

7. Set Black as the current primary color.

8. Paint in the mask to close the gaps 
that allow the Cartoon Cel fill to 
escape.

9. Choose Select menu> Load 
Selection.

In typical cartoon line work, unbounded 

areas—for example, hair, tail feathers, 

and brush bristles—sometimes need to 

be filled. You can use the above 

technique to make these items closed 

off in the selection mask. This 

technique works only with Cartoon Cel.
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ry/Secondary Color Rectangles 

 

lor you select appears on the front 
gle in the pair of overlapping 
gles. The front rectangle shows the 
d primary color. The back rectangle 
the selected secondary color. 
ver you start Painter 3D, black is 

ected primary color and white is the 
d secondary color. 

n swap the primary and secondary 
by clicking the “swap” icon.

 

’t confuse the secondary color with 

t other graphics programs call “the 

kground color.” In Painter 3D, the 

kground color is color of the 

kground in the Model window. 

er color is the color of the 

 

kground in the Image window. 

  

am of the Standard Color palette.
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The Standard Color palette has a hue ring 
and color triangle.

The Compact Colors palette displays the 
hue ring as a single bar with a color 
triangle.

The RGB Colors palette provides simple 
RGB sliders for choosing color.

Click the grow box to expand the palette 

and to see the variability sliders. 

To select a hue and color from the 
Standard Color palette:

1. Drag the circle on the color ring to 
select the predominant hue. You can 
also select the hue by clicking once 
anywhere on the ring. 

The triangle displays all the available 
colors within a predominant hue.

2. Select a color on the triangle by 
dragging the circle or clicking on the 
color you want.

Within the triangle, the colors are 
organized by value and saturation. 
Values span the triangle from top to 
bottom, with the top of the triangle 
being the highest value (white), the 
bottom the lowest value (black).

Saturation levels go from left to right. 
Dragging to the right produces the 
purest color within the predominant 
hue. Dragging to the left gives 
muddier or grayer colors.

Prima

The co
rectan
rectan
selecte
shows 
Whene
the sel
selecte

You ca
colors 

Don

wha

bac

bac

bac

Pap

bac

The Standard Color palette expanded to show 
Color Variability sliders. 

A diagr



 

Applying Art Materials 141

                    

 clone color: 

  

t up a clone source. If you don’t set 
le as the source, Painter 3D uses 
 current Pattern.

 

et up a clone source, open a file 

 choose File menu> Clone. Delete 

contents of the resulting clone file 

hoosing Select menu> All and 

sing the Delete/Backspace key. 

 you can work in the new file, 

ng data from the original, source 

 For more information, refer to the 

ing chapter in the online book 

 

ter 3D Advanced Guide

 

. 

  

lect any brush. 

  

ick the Color icon on the Art 
aterials palette to open the 

 

Art 
aterials

 

:

 

 Color palette

 

. 

  

ick Clone Color. You may also 
oose 

 

Art Materials palette

 

:

 

 Color 
nu> Use Clone Color

 

.

abling the Clone Color option 
ables the color picker. This is a 

inder that your color information 
oming from the clone source.
Most of the time you’ll work with the 
primary color. The secondary color is for 
multicolor brush strokes, two-point 
gradations, and Image Hose effects. 

You can change the secondary color by 
clicking on the back rectangle, then 
picking a color. After changing the 
secondary color, click the front rectangle 
again. 

Sampling Colors from Images

In addition to choosing colors from the 
Art Materials: Color palette, you can use 
the Dropper tool to pick up a color from 
an existing image and use the color 
elsewhere. You can also choose the Clone 
Color option to use colors from the clone 
source image.

Dropper Tool

To use the Dropper tool:

1. Click the front overlapping rectangle 
on the Art Materials: Color palette if 
you want to change the primary color. 
Click the back rectangle if you want to 
change the secondary color.

2. Choose the Dropper tool.

From the Brush or Paint Bucket tools, 

you can temporarily switch to the 

Dropper by holding down the 

Command/Ctrl key.

3. Move the cursor to the color you want 
to pick up and click on it. 

The color picker updates to the color. 
The Controls palette: Dropper tool 
shows the HSV and RGB values for 
the color. RGB values are given in 
both decimal and hexadecimal format 
(which can be useful in Web 
authoring).

Clone Color

The Clone Color option is another way to 
choose color. This feature lets the brush 
pick up color from the original (source 
image) while staying true to its own 
nature. Clone Color takes averaged 
samples of color from the clone source, 
resulting in an approximation of the 
original. 
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Two Colors at Once

 

y you work with only the primary 
he front rectangle of the two 
ping rectangles in the Color 

s. Using one color produces a solid 
stroke.

cting a secondary color, you can 
ine the colors for multicolored 

strokes. Many brush variants are 
 paint with a variable range of 
 

ttings for the brush on the Sliders 
 (Brushes palette: Control menu> 
) determine how Painter 3D 
s when to use one color or the 
For information on this palette, 
 the advanced painting chapter in 

line book 

 

Painter 3D Advanced 
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5. When you paint in the clone file, 
Painter 3D uses colors from the clone 
source image.

Setting Color Variability

Use the Art Materials: Color palette to set 
up multiple colors for any of Painter 3D’s 
brushes.

To display the Art Materials: Color palette, 
click the Color icon on the Art Materials 
palette and expand the palette 
if necessary. 

The ±HSV sliders control ranges of hues, 
saturations, and values. Moving the ±Hue 
slider to the right increases the number of 
hues in the brush stroke. These colors are 
the ones adjacent to the selected color on 
the color wheel.

Moving the ±Saturation slider to the right 
increases the variability in the color 
intensity of the brush stroke.

Moving the ±Value slider to the right 
increases the variability in the brightness 
of the brush stroke. 

You can try different ±HSV slider settings 
with any of the brushes to get some 
interesting results. Moving these sliders to 
the right is most useful when you’re 
working with brushes like Painter 3D’s 

Loaded Oils brush, as well as the Van 
Gogh and Seurat variants of the Artists 
brush.

When you save a brush variant, the 

current color variability setting is saved 

with that variant.
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primary color rectangle.
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 Sets

 

sets are used to organize groups of 
 Some color sets, like the Pantone 
et, are organized both by name and 
elationship. 

r 3D provides several color 
ainter 3D Colors, and the 

tosh and Windows system palettes 
w. 

lor set is open at a time, but you 
sily load a different set.

 

the Color Sets

 

lay the current color set:

  

oose 

 

Window menu> Show Color 
t

 

. 

u can also press Command/Ctrl+8. 
e Color Set palette appears on the 
een.

   

 3D’s default color set.
To set up a two-color brush stroke:

1. Select the Graduated Brush variant or 
another mark-making brush variant.

2. Click the front rectangle on the Color 
palette to select it.

3. Select a color on the Color palette or 
from a color set. The front rectangle 
shows your selection.

4. Click the back rectangle and select a 
secondary color. 

5. Click the front rectangle again to 
make it active. This keeps the primary 
rectangle selected for the next time 
you pick a color.

6. Before you make a stroke, choose 
Brushes palette: Control menu> 
Sliders. The Sliders palette appears.

7. Set the Color slider to Direction.

8. In your document, paint an “X.” 
Notice that the primary color is used 
in one mark and the secondary color 
is used in the other. Draw some loops 
and circles to see the transitions.

You might want to try a different 
setting for the Color slider. Try 
Pressure instead of Direction. 
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colors at once. 
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izing Color Sets

 

n rearrange color set layouts, create 
lor sets, and add and delete colors 
olor sets.

 

izing Color Set Layouts 

 

n arrange a color set in a variety of 
ou can specify the number of rows 
lumns, the size of the color 
es, whether or not there are grid 
nd whether or not the colors are 
. 

n make changes in any order until 
or set is exactly the way you want it. 
mbered steps in the next set 

ructions give you a place to start.

 

tomize a color set layout:

  

oose 

 

Art Materials palette

 

:

 

 Color 
nu> Adjust Color Set

 

. The Color 
t palette appears.

  

the color set is locked (padlock 
sed), click the Padlock button on 
 Color Set palette to unlock it.

  

ick a Sort Order radio button to 
der the colors in the set:

ved sorts colors in the order they 
re originally entered. 
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To load a different color set:

1. Choose Art Materials palette: Color 
menu> Load Color Set. A standard 
Open dialog appears.

2. Locate and double-click on the color 
set or select the color set and click 
Open. The new color set is loaded.

You can set a default color set in the 

Preferences dialog. For more 

information, refer to “Setting 

Painter 3D’s Preferences” on page 41. 

To choose a color from a color set: 

1. In the Color palette, click on the 
primary or secondary (front or back) 
rectangle to select the one you want to 
change.

2. In the Color Set palette, click the color 
you want.

Finding Colors

There are two ways to find a color on a 
color set—by searching for the color 
name or by matching the current color.

To name your colors, refer to “Naming 
Colors” on page 146.

To find a color:

1. Choose Art Materials palette: Color 
menu> Adjust Color Set. The Color 
Set palette appears.

2. Click Find Color. The Find Color 
dialog appears.

3. Select a search method. You can find a 
color by name or find a color that’s 
closest to the current color. 

4. Click Search. If the name isn’t found, 
the OK button is dimmed.

5. Click OK. If the color set is visible, 
Painter 3D surrounds the found color 
with the selection frame.
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oose a color you wish to add to the 
w color set. You can choose a color 
m the Art Materials: Color palette 

 from an existing image.

he color set is locked, click the 
dlock button on the Color Set 
lette to unlock it. 

 the Color Set palette, click Add 
lor. The color is added to the color 
. To name the newly added color, 
uble-click the color swatch and 
ter a name in the dialog that 
pears.

peat this procedure until you have 
osen all of your color set colors.

u may change the name of any 
lor in a color set by double-clicking 
 color. A dialog appears asking you 
name the color. Type the new 
me and click OK.

ick the Library button. A dialog 
pears asking if you want to save the 
anges you’ve made.

ick Save. Enter a name for the color 
, choose a destination directory, 
d click Save.

e Open Color Set dialog appears. 
u can cancel this dialog to keep 
ur saved color set as the active one.
HLS sorts colors by hue, luminance, 
and saturation.

LHS sorts colors for a luminance, hue, 
saturation order.

SHL sorts colors by saturation, hue, 
and luminance.

4. Use the Color Square Size box to 
adjust the size of the individual 
squares in the color set. Click the 
single arrows to expand or contract 
each square by one pixel. Click the 
double arrows to double or halve the 
size of each square. 

5. Use the Color Set Size box to change 
the number of rows and columns in 
the color set. Click the single arrows 
to add or delete rows or columns one 
at a time. Click the double arrows to 
double or halve the number of rows 
or columns in the color set.

6. Click the Display Text checkbox at the 
bottom of the Color Square Size box 
to turn the color names on and off.

7. Click the Display Grid checkbox at the 
bottom of the Color Set Size box to 
turn the grid on and off. Turning it off 
eliminates the lines between colors. 
You can see more colors, but the 
separations between colors are not as 
distinct as when the grid is on.

Creating Color Sets

You can create your own color sets to 
control the colors in particular projects or 
create groups of your favorite painting 
colors. You might call one color set 
“shades of purple.” You might call another 
color set “crayons” or “watercolors.” 

If you want to pick up colors from an 
image, open the image before you begin 
creating the color set. You can customize 
the swatch size, grid lines, and names as 
described in “Customizing Color Set 
Layouts” on page 144.

To create a color set:

1. Choose Art Materials palette: Color 
menu> Color Set. The Color Set 
palette appears.

2. Click New Set. A new empty Color Set 
palette appears.

Sometimes when you create a new set, 

the title bar is hard to see. Once you 

add a color, the color set expands and 

the title will be easy to locate.
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ld down the Option/Alt key and 
ple-click the color in the color set 
t you want to replace. The new 

lor replaces the old one in the 
lor set.

g Colors

g colors can be useful if you want 
ch for a particular color. 

e a color:

uble-click on a color swatch in the 
en Color Set palette. The Color 
me dialog appears.

ter the color name and click OK.

ace Grain: The Paper 
tte

grain, also known as paper texture, 
l in many ways. The word 
e” has many definitions in 3D 
re. It can refer to a texture map, 
is wrapped onto a 3D model to give 
cular characteristic to the model’s 
. In the case of Painter 3D’s Paper 
, texture refers to the physical 
 of the “canvas” you’re painting on. 
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Adding and Deleting Colors from a Set

You can customize color sets further by 
changing, adding, or deleting colors. 

To add a color to an existing color set:

1. Choose the color you want to add to 
an existing color set. You can choose a 
color from the Art Materials: Color 
palette or from an existing image. 

If the color set is locked, click the 
Padlock button on the Color Set 
palette to unlock it. 

If you want to add a color from an 

existing color set, select the color in the 

existing color set before you open the 

destination set. When you open or 

create a new set, Painter 3D will first 

close the current set and then display 

the new set.

2. On the Color Set palette, click Add 
Color. The color is added to the color 
set. To name the newly added color, 
double-click the color swatch and 
enter a name in the dialog that 
appears.

To delete a color from an existing 
color set:

1. Choose the color set that contains the 
colors you want to delete.

If the color set is locked, click the 
Padlock button on the Color Set 
palette to unlock it. 

2. Select the color you want to delete. 
The current selection frame appears 
around the color.

3. On the Color Set palette, click Delete 
Color. A dialog appears asking if you 
really want to delete the color. 

4. Click Yes. Painter 3D deletes the 
chosen color from the color 
set window. 

To change a color in an existing 
color set:

1. Choose the new color you want to 
place into the open color set. You can 
choose a color from the Art 
Materials: Color palette or from an 
existing image.

If the color set is locked, click the 
Padlock button on the Color Set 
palette to unlock it. 
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ember that paper textures are 

ed in libraries. You can load 

rnate libraries for more paper 

ices. For more information on 

king with libraries, refer to “Loading 

rnate Libraries” on page 25.

ting Paper Grain

n think of paper grain as a 
imensional landscape. Usually, 
s react to paper texture by coloring 
ks and ignoring the valleys. 

ng the Invert Paper option (either 
Paper Texture menu or the 
ox in the palette) makes color fill 
leys and ignore the peaks. 
Painter 3D’s brushes interact with the 
grain just as natural tools react with the 
texture of the surfaces on which you 
mark. Paper grains are also useful in 
applying Surface Texture and other 
Effects, like Glass Distortion. 

In this chapter, the terms “paper 

grain,” “texture,” and “paper texture” 

are synonymous.

When you choose a brush that interacts 
with paper grain, you see the results with 
each stroke. If you find a brush and paper 
combination you like, you can save it as a 
brush look. 

You can select different paper textures, 
modify them, organize them in libraries, 
and even create your own custom 
textures. 

Click the Paper Texture icon on the Art 
Materials palette to display the Art 
Materials: Paper palette. Click the palette 
push bar to display additional papers 
stored inside the drawer. Click the grow 
box to expand the palette. 

The Paper palette is where all your paper 
textures are stored. In addition to using it 
to select papers, you can use this palette to 
invert or resize the grain and to open 
other paper libraries.

Selecting Paper Texture Grain 

To select a paper texture grain: 

1. Click the Paper icon on the Art 
Materials palette to open the Art 
Materials: Paper palette. 

2. Click the push bar and open the 
drawer to see more selections.

3. Click a paper texture to select it.

The palette shows the dimensions of 
the paper (in pixels). Painter 3D tiles 
the paper to cover as much canvas as 
needed.
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Click the Paper icon to display the Paper palette. 



ring Paper Textures

pture Paper command lets you 
section of an image into a paper 
. Once textures are saved, they are 
le from the Paper palette drawer 

brary pop-up menu.

ture paper texture:

en or create an image. The Make 
actal Pattern feature creates 
ellent textures. Certain weaves also 

oduce good textures. 

ing the Rectangular Selection tool, 
ect all or a piece of the image. 

oose Art Materials palette: Paper 
nu> Capture Paper. The Save 

per dialog appears.

ecessary, move the Crossfade slider 
the right to blend the distinction 
tween tile borders.

pe the name of your new paper and 
ck OK.

ur paper now appears in the Paper 
lette drawer and is added to the 
rrent library.
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If you want paper texture grain to 

appear uniformly across the image, you 

should create the artwork first, then 

apply the grain as a surface texture. If 

you apply a paper texture when you 

create an image, the paper is erasable. 

You can’t erase brush strokes without 

erasing the paper. Generally, you’ll add 

the paper texture as the last step, not 

the first step, in developing your image. 

Scaling Paper Texture Grain

Use the Scale slider at the bottom of the 
Paper palette to resize the paper grain. As 
you move the slider, the texture preview 
updates to display the new size. You can 
scale the texture down to 25% and up 
to 400%. 

Scaling large textures can use a great 

deal of RAM. Most textures in 

Painter 3D are from 50 to 400 pixels 

square, at 100% scaling.

Captu

The Ca
turn a 
texture
availab
and Li

To cap

1. Op
Fr
exc
pr

2. Us
sel

3. Ch
me
Pa

4. If n
to 
be

5. Ty
cli

Yo
pa
cu

Two brush strokes overlapping; the green was 
painted with grain inverted. 

Scaling paper grain affects how the grain appears 
in brush strokes and image effects. 
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able the Random Brush Stroke 
ain option.

g Gradations: The Grad 
tte

ation is a gradual transformation of 
lor into another. Sometimes they 
led blends or fountains. Painter 3D 
es several different types of 
ions: linear, radial, spiral and 
r. 

ou can do with gradations:

l an image, selection, floater or 
sk.

ntrol the Pop-Art Fill effect (for 
er effects, fill a mask and use it.)

ize paper grain to create a cool effect.
Making Paper Textures

The Make Paper command lets you make 
your own paper textures.

To create paper textures:

1. Choose Art Materials palette: Paper 
menu> Make Paper. The Make Paper 
dialog appears. The Preview window 
reflects your changes.

2. Choose a pattern from the Pattern 
pop-up menu to use as the basis of 
your paper texture.

The reference to patterns in this 

discussion has no relation to the 

Pattern palette or the Define Pattern 

and Capture Pattern features. “Pattern” 

is only used to describe the nature of 

the paper texture.

3. Adjust the Spacing and Angle sliders. 
Moving the Spacing slider to the right 
opens up space between rows and 
columns in the selected pattern. 
Moving the Angle slider changes the 
direction in which the pattern rows 
are lined up.

4. When you like the look of the texture, 
type a name for it and click OK. Your 
new texture appears as the last item in 
the Paper palette.

Randomizing Paper Grain

Normally, paper grain is fixed—the 
texture is in the same position each time 
you apply a brush stroke. You may change 
this if you want the grain to move 
randomly.

To randomize the paper grain:

1. Choose Brushes palette: Control 
menu> Random. The Random 
palette appears.
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The Make Paper Texture dialog allows you to 
create your own Painter 3D textures based on the 
patterns in the Pattern pop-up menu. 

Random



 can click inside the gradation 

iew and Painter 3D rotates the 

ation for you. Click anywhere 

ide the preview to stop the rotation.

radation Types on the right of the 
 let you select from four types of 
ions—linear, radial, spiral or 
r.

les of the gradation types.
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• Express the gradation in an existing 
image by mapping its colors to image 
luminance.

Although Painter 3D comes with libraries 
full of gradations, you’ll want to create 
some of your own. You can define two 
colors and create a gradation between 
them. You can also capture gradations 
from existing images and save them for 
use in other images. You can create 
libraries for your gradations.

Working with Gradations

Use the Art Materials: Grad palette 
to select and adjust Painter 3D’s 
gradations. 

Click the Grad icon on the Art Materials 
palette to display the Art Materials: Grad 
palette. Click the palette push bar to 
display additional gradations stored inside 
the drawer. Click the grow box to expand 
the palette.

Remember that gradations are stored 

in libraries. You can load alternate 

libraries for more grad choices. For 

more information on working with 

libraries, refer to “Loading Alternate 

Libraries” on page 25. 

In the center of the palette, the Preview 
window shows how the current settings 
affect the selected gradation. 

The Rotation Ring changes the angle of 
the gradation. Drag the red ball in the ring 
to change the angle. You can also select the 
angle by clicking once anywhere on the 
ring. The numeric value appears below 
the preview.

For a spiral gradation, you can use the 
Rotation Ring to change how tightly the 
spiral is wound. Hold down the 
Command/Ctrl key and drag around the 
Rotation Ring.
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Click the Grad icon to display the Grad palette.
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w that you have defined the two 
lors, you can make the gradation in 
 Grad palette.

en the Art Materials: Grad 
lette. 

lect the Two-Point icon.

ake sure the drawer is closed, so you 
 see the preview of your gradation.

y changing the color order by 
cking the different icons at the 
ttom of the window. You can also 
 out different gradation types.

u can save the gradation or use it to 
 a selected object. For more 
ormation on filling an object, refer 
“Filling With Art Materials” on 
ge 135.

e Two-Point icon or select Two-Point 
e Library pop-up menu.
The Gradation Orders at the bottom of 
the expanded Grad palette determine how 
a gradation behaves. The Preview Strip 
(above the gradation orders) shows the 
selected gradation order.

The top row (from left to right) orders the 
current gradation from left to right, left to 
right and mirrored, and right to left. The 
bottom row orders the current gradation 

from left to right and doubled, right to left 
and mirrored, and right to left and 
doubled. 

Creating Gradations

You can create your own gradations from 
simple to complex. For a simple 
gradation, choose primary and secondary 
colors to define a two-point gradation. 
For more complex gradations, use the 
Gradation Editor, or capture gradations 
from existing artwork.

Creating a Two-Point Gradation

You can define a two-point gradation by 
defining two colors in the Art Materials: 
Color palette and then having Painter 3D 
create the gradation between them.

You might want to tear off the Grad 
palette or the Color palette, so you can see 
both at once. For more information on 
tearing palettes, refer to “Tearing Off 
Palettes” on page 19. 

To create a two-point gradation:

1. Open the Art Materials: Color 
palette.

2. Choose a primary color.

3. Choose a secondary color.
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ing Color Control Points

n change the color control points in 
ation to change how colors are 
d ina gradation.

nge a control point color:

ick a color control point (pointed 
y marker) to select it. 

lect a new color from the Color 
lette. 

 start with a two-point gradation, 
ck on the far right control point 
d then choose a color. Click on the 
 left control point and choose a 
ferent color. Now you can generate 
ditional colors in between by 
ding new control points.
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Saving a Gradation

Once you’ve created a gradation you like, 
you might want to save it.

To save a gradation:

1.  Choose Art Materials palette: Grad 
menu> Save Grad. The Save Grad 
dialog appears.

2. Enter the name for your gradation.

3. Click OK.

Creating Gradations with the 
Gradations Editor

Use the Gradations Editor to create new 
gradations or edit simple, two-point 
gradations into a more complex blend. 

To edit a gradation:

1. Choose Art Materials palette: Grad 
menu> Edit Grad. The Edit Grad 
dialog appears.

It is often convenient to have both the 

Color palette and the Grad palette 

available during editing. 

The colored ramp across the top of 
the dialog displays the current 
gradation bar. 

The pointed gray markers along the 
bottom of the bar are the color 
control points. You can select these 
points and change the color of the 
blend at this point.

2. Make your changes to the gradation 
as discussed in the following sections.

3. Click OK to exit the Edit Grad dialog.
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Use the gradation editor to edit saved gradations. 
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e Color pop-up menu appears.

lect an option from the Color 
p-up.

B blends directly between the red, 
en, and blue components of the 

o colors. 

e Clockwise and Hue 
unterclockwise blends between the 
dpoint colors by rotating around 
 color wheel. For a better 
derstanding of this concept, refer 
the standard Color Picker (ring and 
angle) and note the order of the 
lors on the Hue ring.

tice that as you change the 
rameters within the Edit Grad 
log, the gradation previews are 
dated within the Grad palette. 

ick OK when you’re finished. You 
 now save your new gradation. 

lor pop-up appears with you select a 
pace square at the top of the color 
ar.
Adding and Deleting Color Control 
Points

You can easily add new color control 
points by clicking in the gradation bar. 
Click anywhere in the color ramp bar and 
a new control point is added without 
changing the color at this location in the 
bar. If you Option/Alt-click in the bar, a 
new control point is added and set to the 
current color. You can also press the 
Delete/Backspace key to remove the 
selected color control point. 

Using the Linear Check Box

Leave the Linear check box checked to 
create ramps that blend linearly between 
colors. When editing non-linear 
gradations (Linear is unchecked), all 
ramps within the gradation are 
non-linearly blended using smooth 
curves. When using non-linear ramps, 
you should use the Color Spread slider to 
control the color smoothness at each color 
control point.

Changing the Color Space

The color space is represented by boxes 
located at the midpoints between the 
adjacent color control points. They allow 
you to change the hue of the blend within 
that segment.

To change the color space:

1. Click on a square box above the color 
ramp bar.
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ing a Gradation to Image 
ance

n also map a gradation to an 
g image, replacing an image’s colors 
ose of the gradation. This effect 
 gradation colors to the pixels of 
age based on their luminance 

ress a gradation in an image:

en the image you want to use. You 
 select part of the image or use the 

tire image. Patterns created with 
ake Fractal Pattern provide 
ellent source images.

 3D allows you to apply a gradation 
n the luminance value of existing colors.
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Capturing a Gradation from an Image

You can use any existing imagery as a 
source for creating new gradations.You 
could capture the colors in a photo of a 
sunset or paint your own range of colors 
as the content of a gradation.

To capture a gradation:

1. Use any tool to draw a gradation or 
open an existing image.

2. Using the Rectangular Selection tool, 
select a horizontal or vertical area. 
Make the selection as narrow as 
possible. If the selection is horizontal, 
Painter 3D uses the first row of pixels 
starting at the upper left for the 
gradation. If the selection is vertical, 
Painter 3D uses the first column of 
pixels starting at the upper left for the 
gradation.

3. Choose Art Materials palette: Grad 
menu> Capture Grad. The Save 
Grad dialog appears.

4. Type a name for the gradation 
and click OK. The new gradation is 
saved in the current library. In the 
future you can choose it by name 
from the Grad palette Library pop-up 
menu.

For information on working with 
libraries, refer to “Libraries” on 
page 24.
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To make perfect blends between a series of colors, 
it’s better to work with a row of single pixels 
rather than a large piece of an image. The Image 
window at left shows a selected row of single 
pixels. The gradation they make is shown on the 
Grad palette. 
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ose a pattern:

ick the Pattern icon on the Art 
aterials palette to open the Art 
aterials: Pattern palette. 

ick the icon for the pattern you 
nt. You can click the push bar to 
en the drawer and display more 
oices. 

hen you’ve selected a pattern, close 
 drawer.

e palette shows a preview of the 
ttern, gives the dimensions of the 
 image (Rows and Columns 

scribe the number of pixels 
rizontally and vertically), and gives 
u options for scaling and arranging 
 tile in fills.

ctangular places the tile in a regular 
d for fills. The Offset slider does 
t apply.

rizontal offsets the tiles in 
bsequent rows. The Offset slider 
ntrols the amount of offset.

rtical offsets the tiles in subsequent 
lumns. The Offset slider controls 
 amount of offset.
2. On the Art Materials: Grad palette, 
select the gradation you want to use.

3. Choose Art Materials palette: Grad 
menu> Express in Image. The 
Express in Image dialog appears.

4. Adjust the Bias slider to define how 
the gradation is mapped. Painter 3D 
replaces the colors in the image with 
the colors in the gradation, based on 
matching luminance.

5. Click OK.

Using Patterns: The Pattern 
Palette

A pattern is a repeating design. The 
smallest unit of a pattern is known as a 
tile. When you fill with a pattern, the tile 
is repeated across the area. Painter 3D 
saves tiles in separate files and in libraries.

You’ll find a sampling of patterns in the 
default library. You’ll find other pattern 
libraries on the Painter 3D CD-ROM.

All of the patterns are displayed in the 
Pattern palette. Click the Pattern icon on 
the Art Materials palette to display the Art 
Materials: Pattern palette. Click the 
palette push bar to display additional 
patterns stored inside the drawer. Click 
the grow box to expand the palette.

Patterns are created by repeating a 
rectangular image tile across the area. 
Ideally, the images are created so that they 
tile seamlessly. Painter 3D provides several 
features to help you generate seamless 
tiles.

Once a pattern is defined as a tile, you can 
paint off the side of the canvas and your 
stroke appears on the opposite side of the 
canvas. Or you can capture the pattern 
after you create it and manipulate it to be 
a half-drop design, traditionally used in 
wallpaper design.

If you have not set a clone source, the 
current pattern is used in any operation 
referring to clone source colors or 
luminance. This means you can paint 
with the pattern using a Cloner brush.
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Click the Pattern icon to display the Pattern 
palette. 



ing Patterns

r 3D offers three ways to create 
s:

 defining the current image as a 
ttern and adding it to the pattern 
rary.

 creating a rectangular selection 
d capturing it as a pattern.

 making a fractal pattern and 
ding it to the library.

reating a pattern tile, you’ll 
ly want to work with it to improve 

y it tiles. Refer to “Tips for Creating 
ss Tiles” on page 158.

ating patterns can become 

ictive. It’s a good idea to keep 

ries small. Use the Patterns Mover 

reate new libraries and delete 

anted patterns. You can switch 

ries whenever you want to use a 

rent set of patterns. For more 

rmation about movers, refer to 

ving Items Between Libraries” on 

e 26.
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When you’ve set these options, you 
can use the pattern. To test it, open a 
new image. (To see the tiling, the 
image must be larger than the tile.) 

To fill an image with multiple pattern 
tiles:

1. Choose Effects menu> Fill. The Fill 
dialog appears.

2. Choose Pattern as the art material 
source.

3. Click OK.

Editing the Pattern Tile with 
Check Out Pattern

If the preview in the Pattern palette isn’t 
detailed enough, or you want to edit an 
existing pattern, you can open the pattern 
tile in its own window. By checking out 
the pattern as a file, you can view the 
pattern tile or modify it.

To check out a pattern’s tile:

1. In the Pattern palette, select the 
pattern you want to work with.

2. Choose Art Materials palette: 
Pattern menu> Check Out Pattern.

Painter 3D opens the selected pattern 
tile in its own document window.

You can edit the pattern tile as you 
would any image. To put the 
modified pattern back in the palette, 
you’ll need to use the save the pattern 
to the library. For more information, 
refer to “Adding Images to the 
Pattern Library” on page 157. 
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Check out a pattern to view it close-up or to 
modify it. 
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ring Patterns

ture a pattern:

en the image that contains the area 
u want to use.

ing the Rectangular Selection tool, 
ect the area you want. Remember, 
 edges of the selection will meet 
en the image is tiled, so select 
efully. 

oose Art Materials palette: 
ttern menu> Capture Pattern. 
e Capture Pattern dialog appears. 

ure a pattern, make a selection and 
apture Pattern. 
Defining Patterns

You can give any image the pattern tile 
characteristics. This helps if you want to 
create seamless tiles. 

To define a pattern:

1. Open the image file you want to 
work with. 

2. Choose Art Materials palette: 
Pattern menu> Define Pattern.

Defining the image as a pattern gives 
it the wrap-around characteristics.

If you want the defined pattern in your 
Pattern palette drawer, you’ll need to add 
it to the library.

Images tagged as patterns using the 

Define Pattern command, and saved in 

RIF format, will maintain these 

characteristics even after they have 

been saved and reopened.

Adding Images to the 
Pattern Library

You can add any image to the current 
library as a pattern tile.

To add a pattern to the current library:

1. Open the image you want to add to 
the pattern library. 

2. Choose Art Materials palette: 
Pattern menu> Define Pattern.

3. Choose Art Materials palette: 
Pattern menu> Add Image to 
Library. Painter 3D prompts you to 
name the pattern.

4. Give it a descriptive name and click 
OK. If a pattern of that name already 
exists in this library, Painter 3D will 
ask if it’s okay to replace it. If not, click 
No and try again with a different 
name.
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p-around the seams:

en an image.

oose Art Materials palette: 
ttern menu> Define Pattern.

ick the Grabber tool on the Tools 
lette.

ld down the Shift key and drag in 
 image. You’ll see a horizontal and 
tical line where the image edges 
et. When the crossing lines are 
tered, release the mouse button.

te a seamless tile, you’ll need to 
e image to get rid of the edge lines. 
l techniques are possible, 
ing on the type of image. 

round seams lets you move the pattern 
s to the middle so you can edit them.
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4. Make other selections as needed. You 
have the following options:

Rectangular Tile places the tile in a 
regular grid for fills. The Bias slider 
does not apply.

Horizontal Shift offsets the tiles in 
subsequent rows. The Bias slider 
controls the amount of offset.

Vertical Shift offsets the tiles in 
subsequent columns. The Bias slider 
controls the amount of offset.

As you try different tile arrangements 
and Bias settings, the Preview window 
shows their result. Don’t worry about 
making it perfect, you can change the 
direction and Bias setting in the 
Pattern palette.

5. Enter a descriptive name for the 
pattern and click OK.

Painter 3D captures the pattern and 
saves it to the current library. You can 
find your captured pattern in the 
Pattern palette. If you want to edit it, 
you can check it out of the library.  

Tips for Creating Seamless Tiles

Patterns are created by repeating a 
rectangular image tile across an area. 
When you develop patterns, you’re 
creating images for tiling. Ideally, the 
images will tile seamlessly. That is, the eye 
will not be able to distinguish between 
tiles. Painter 3D provides several features 
to help you generate such pattern tiles. 

To help in making seamless tiles, 
Painter 3D gives documents defined as 
pattern tiles two special characteristics: 
wrap-around colors and wrap-around 
seams. 

To wra
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The Capture Pattern dialog lets you decide how 
much to offset pattern tiles and in which 
direction.

Wrap-around colors lets you paint off one side of 
your image onto the other side. 
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wer Slider

wer slider controls the intricacy of 
tern’s definition, as if you were 
ing” in and out on a textured 
 with a microscope. Move the 

 slider to the right to zoom out and 
ll see many, smaller patterns. Move 
wer slider to the left to zoom in and 
ll see few, larger patterns.

er slider determines the degree of detail.
If you disabled wrap-around colors for 
your image, you might end up with 
dramatic edge lines, which would require 
heavier editing to make the tile seamless. 
Refer to “Disabling Wrap-Around Colors” 
on page 85.

Make Fractal Pattern

Make Fractal Pattern is a pattern 
generator that creates interesting 
landscapes. These topographic patterns 
can be filled with color and embossed 
with a paper texture.

To use the Make Fractal Pattern 
command:

1. Choose Art Materials palette: 
Pattern menu> Make Fractal 
Pattern. The Make Fractal Pattern 
dialog appears. 

2. Select your options as described in the 
following paragraphs. Any changes 
you make appear in the dialog 
Preview window.

3. When you are satisfied with your 
selections, click OK. 

Wait a moment while Painter 3D 
creates your new pattern file. When 
Painter 3D is finished, your pattern 
file will be displayed in its own 
window. 

Sizing the Tile

The Size option describes the exact size of 
the tile you are creating. If you have a lot 
of memory, you can make a larger file 
with a higher resolution.

Depending on the amount of memory 

you have available to Painter 3D, some 

of the size options may be unavailable.

Make Fractal Pattern Sliders

The sliders within the Make Fractal 
Pattern dialog affect the look of the 
pattern.
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Make Fractal Pattern is a pattern generator. 

The Pow



 generated with this option are 
in conjunction with the Apply 
e Texture feature. White areas are 
nted as peaks, and dark areas 
e depressions.

n also create interesting patterns by 
ng a colorful gradation and using 
t Materials palette: Grad menu> 
s in Image command.

nt Bearing

nt Bearing uses the Red channel to 
 the bearing of the down angle of a 

 field.

e Normal

e Normal uses the Green and Blue 
els to represent the X and Y 
nents of the surface normal (angle 
dicular to the surface at a given 

 of the height field (Green=X, 
).

two latter options for viewing a 
 texture are offered for purely 
tic reasons. One way to take 
age of them is to create color 
ons of the texture with the Adjust 
 feature. Other Effects can lead 
 ways from the original image. 
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The Feature Size Slider

The Feature Size slider defines the number 
of prominent features within the tile. 
Move the slider to the left to increase the 
number of repetitions per tile.

The Softness Slider

The Softness slider adjusts the softness of 
the edges of the pattern. 

The Angle Slider

The Angle slider changes the direction 
from which you view the fractal. 

The Thinness Slider

The Thinness slider controls directional 
tendencies of the fractal pattern. Reducing 
thinness introduces linearity.

Channel Options

Painter 3D uses four channels to store 
graphic information: Red, Green, Blue, 
and Alpha (or Mask). Information other 
than color values can be placed in these 
channels as well. The channel options 
allow you to visualize this information in 
new and different ways. 

Height as Luminance

Height as Luminance displays 
pseudo-height information as luminance.
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The Feature Size slider determines the number of 
repetitions.

Low Thinness settings show the fractal as streaks. 
Use the Angle slider to change the direction of 
streaking. 
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ging Weave Fiber Type

r 3D can display a weave as 
mensional or show the interwoven 
s three-dimensionally, complete 
adows.

e Weave icon to display the Weave 
 

ve can appear differently when displayed 
ee-dimensional fiber type. 
To colorize a fractal pattern, choose an 

appropriate gradation and use the 

Express in Image feature.

Converting a Pattern to a Paper Texture

Fractal Patterns you create make great 
paper textures.

To convert a fractal pattern to a texture:

1. Check out the pattern to display it in 
an Image window. 

The luminance and contrast are all 
that matters. You might want to 
adjust the contrast and brightness.

2. When you’re satisfied with the tonal 
balance, choose Select menu> All.

3. Choose Art Materials palette: Paper 
menu> Capture Paper. The Save 
Paper dialog appears.

4. Name the Paper and click OK.

Using Weaves: The Weave 
Palette

The Weave palette is, in effect, a virtual 
loom you can use to create weaves to use 
as fill patterns.

Two libraries of weaves are included with 
Painter 3D. You can modify a weave by 
changing its fiber type, the scaling and 
thickness of its threads, or its color. You 
can also create and save new weaves of 
your own.

Click the Weave icon on the Art Materials 
palette to display the Art Materials: Weave 
palette. Click the palette push bar to 
display additional weaves stored inside the 
drawer. Click the grow box to expand the 
palette.

Below the drawer are controls that let you 
preview a selected weaving, choose its 
fiber type, change colors, vary the scale of 
the weave and the thickness of its threads, 
and open the advanced editing palette.
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lay the color set for a weave:

lect the weave in the palette and 
se the drawer.

oose Art Materials palette: Weave 
nu> Get Color Set. The color set 
 the selected weave appears.

nge the colors for a weave:

lect a new color from the Art 
aterials: Color palette.

ld down the Option/Alt key and 
ck the color chip on the weave color 
 (Weave menu> Get Color Set) 
t you want to replace. The new 

lor replaces the old one.

oose Art Materials palette: Weave 
nu> Put Color Set. The Preview 

ndow shows the weave with the 
w colors. If you fill an image with 
 weave pattern, now Painter 3D 

es the new color set.

nge the color patterns within a 
 you must work in the Edit Weave 
.
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To change how a weave is displayed:

✤ On the Art Materials: Weave palette, 
click the Fiber Type icon. The button 
changes to show either a 
two-dimensional or 
three-dimensional weave.

Depending on which weave is 
selected, you may or may not see a 
change in the Preview window. For 
different two- and three-dimensional 
effects, you can adjust the scaling and 
thickness sliders at the bottom of the 
Weave palette.

Adjusting Scaling and Thickness

The four sliders at the bottom of the 
Weave palette control the thickness of 
threads and the spacing between them. 
The top two sliders control horizontal 
dimensions; the bottom two control 
vertical dimensions. By adjusting these 
sliders, you can create a wide variety of 
weaves with any one of the patterns 
supplied.

To adjust scaling and thickness:

1. Select the weave you want to adjust. 
Its image appears in the Preview 
window.

2. Click Fiber Type until the button 
shows a three-dimensional weave. For 
most weaves, you won’t see a change 
in the Preview window yet. In order to 
see a change, you have to enlarge the 
weave by increasing its scale and 
reducing its thickness.

3. Adjust the horizontal and vertical 
scale sliders. You still might not see a 
change in the Preview window until 
you also adjust the thickness sliders. 

4. Adjust the horizontal and vertical 
thickness sliders. 

The thickness sliders have no effect 

when the two-dimensional fiber type is 

selected.

Editing Weave Colors

Each weave uses its own color set. You can 
display the color set used for a weave, 
change the colors in the set, and apply 
them to the weave. Remember that you 
can tear off palettes to see more than one 
at a time.
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Saving Weave Changes

After altering the scaling and thickness or 
color of a weave, you can save your 
changes as a new weave pattern.

To save weave changes:

1. Choose Art Materials palette: Weave 
menu> Save Weave. A dialog appears 
asking you to name the new weave. 

2. Type a name for the weave and click 
OK. If you don’t type a new name, 
Painter 3D replaces the existing weave 
with the changed weave. The new 
weave pattern appears in the current 
weaves library.
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nter 3D Brush 
iants

 

duction

 

Pai
Var

Intro
165

This appendix is a catalog of Painter 3D’s 
built-in Brush and Plug-in Brush variants.

The descriptions of the variants outline 
the behavior of a brush when pressure 
information is available. If you are using a 
mouse to paint, you’ll want to modify a 
brush to achieve those pressure-sensitive 
effects. Modifying brushes will help you 
get the most out of the mouse as an input 
device.



            

 Pixel Scribbler

 

gle Pixel Scribbler has a one-pixel 
point. Pressure affects opacity.

 

Pencil

 

riant is a hard lead pencil with 
nti-aliased strokes.

 

d Pencils

 

lored Pencils variant produces 
ith semi-anti-aliased edges. 

 

r

 

 3D has two ways to remove color: 
ser variants, which erase down to 
er color, and the Bleach variants, 

erase to white. Darkeners are Eraser 
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Brush Variants

Brush variants are located in the Brushes 
palette. After selecting a brush, you can 
select a variant from the pop-up menu 
within the palette.

For more information, refer to “Choosing 
a Brush and Variant” on page 118.

Pencils

Pencils are great for anything you’d use 
real pencils for—from rough sketches to 
fine-line drawings. Like their natural 
counterparts, Pencils interact with canvas 
texture. 

All the Pencils variants build to black. 
Pencils are pressure sensitive in terms of 
opacity. The Colored Pencils variant is an 
exception. Colored Pencils have uniform 
opacity regardless of pressure.

With the Colored Pencils, 2B Pencil, 
Sharp Pencil, and 500 lb. Pencil variants, 
dragging quickly produces a thinner line; 
dragging slowly leaves a thicker line. 

The thick-to-thin variation becomes more 
apparent as you increase the ±Size setting 
on the Brushes palette: Controls menu> 
Size palette. 

Thick & Thin Pencils

With this semi-anti-aliased variant, line 
width depends on the direction of your 
stroke. 

2B Pencil

This variant is a soft lead pencil that 
produces thin, anti-aliased lines. 

500 lb. Pencil

The 500 lb. Pencil creates fat, 
semi-anti-aliased lines. 
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ser

Bleach

 Pixel Bleach

rkener

ne Darkener
variants that increase color density, 
building colors toward black. Darkeners 
are the inverse of Bleach. 

With all of the Eraser variants, pressure 
determines how much you erase. To erase 
lightly, press gently. 

If you’re using a mouse, the Opacity slider 
controls how much you erase. With an 
eraser variant’s opacity at 100%, it will 
completely remove color in one stroke. 
With opacity low, the eraser removes 
color gradually.

Small Darkener

Ultrafine Eraser

Fat Bleach

Small Eraser

Medium Darkener

Medium Bleach

Medium Eraser

Ultrafine Bleach

Flat Eraser

Fat Era

Small 

Single

Fat Da

Ultrafi



                

sty Water

 

riant is a large version of Frosty 

 

 Water

 

riant reacts to grain. It is ideal for 
ng existing textured strokes 
e it helps them maintain their 
ess. You can also use it to add 
 to smooth strokes.

  

produces the thick, rich texture of 
ural pastel sticks. Chalk covers with 
 that interact with grain. 

alk variants are pressure sensitive 
s of opacity. Adjust the Opacity 

o get the same effect with a mouse.
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Water

Water smudges and dilutes existing colors 
in the image. It doesn’t add any color. All 
of the Water variants are pressure 
sensitive—the harder you press, the more 
you’ll smear the image. 

The Water variants work in the image 
layer. They are not associated with the wet 
layer or the Water Color variants. 

Just Add Water

This variant smudges with smooth, 
anti-aliased strokes. It removes grain and 
responds to the velocity of your stroke, 
smearing more when you drag slowly.

Frosty Water

This variant smears with a hard-edged, 
brittle stroke. It interacts with the texture 
grain. Try choosing other textures for 
different results.

Tiny Frosty Water

This variant is a sharpened version of 
Frosty Water.

Single Pixel Water

This is the smallest Water brush available, 
similar to wetting a single hair and using 
it to smear an image.

Water Rake

This variant is a multi-bristle water 
applicator.

Water Spray

This variant sprays pixels of water onto 
the image.
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t Charcoal

 

riant produces heavily textured, 
nti-aliased strokes.

 

harcoal

 

arcoal produces a soft, anti-aliased 

  

ns variants give you ink pens that 
log, spatter or run dry.

 

h Ink Pen

 

riant behaves like a traditional 
in pen. Strokes get darker as you 
em. Stroke width and grain 
 on pressure. Heavy pressure 
Large Chalk

This variant is a wider version of Artist 
Pastel Chalk.

Artist Pastel Chalk

This variant produces a medium width, 
semi-anti-aliased stroke.

Oil Pastel

This variant slightly smears the 
underlying color. It uses a captured 
triangular tip to produce a chiseled edge.

Sharp Chalk

This variant is a sharper version of Artist 
Pastel Chalk. 

Square Chalk

This variant uses a captured rectangular 
tip to produce a chiseled edge.

Charcoal

Charcoal produces covering strokes that 
interact with grain. Both Grain and 
Opacity are pressure sensitive

Gritty Charcoal

Gritty Charcoal gives deep-toned, 
semi-anti-aliased strokes. The width of 
the stroke depends on the direction you 
drag.
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 Pixel

 

gle Pixel variant draws with a 
pixel brush. 

riant is not pressure sensitive. 

is variant with the Straight Lines 
g style to draw single-pixel lines.

 

d Ink

 

e Pen and Ink variant, the width of 
ke is determined by how fast you 
he faster you drag, the thinner the 

ecome.

 

oint

 

ne Point variant produces a 
nt pen stroke that reveals texture.
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produces a wide stroke that penetrates the 
grain. Light pressure produces a narrow 
stroke that reveals grain.

Scratchboard Tool

The Scratchboard Tool is smooth, 
anti-aliased and pressure sensitive.

Scratchboard Rake

This variant is a multi-toothed version of 
the Scratchboard tool. This brush is ideal 
for crosshatch shading. Line width 
depends on pressure.

Pixel Dust

Pixel Dust sprays a random distribution 
of pixels.

Calligraphy

The Calligraphy pen is great for stylized 
lettering. The line width varies with the 
direction of the stroke. 

Heavy pressure produces a wide stroke; 
light pressure produces a narrow stroke.

Keep the Opacity slider in its default 
position for the most ink-like lines. 

With variants where direction determines 
stroke width, you can set the angle where 
the width changes. For information, refer 
to the online book Painter 3D Advanced 
Guide.

Leaky Pen

This variant leaves a scattering of drops, 
like you’d expect from a leaky pen. The 
slower you drag, the bigger the drops.
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us Clouds
Flat Color

This variant lets you cover large areas with 
even color.

Image Hose

The Image Hose is a special brush that 
applies images instead of color. The 
images it paints come from Nozzle files.

The following examples are previews of 
the default nozzles. For complete 
information on Image Hose variants, 
creating Nozzle files, loading them, and 
controlling the Image Hose, refer to the 
online book, Painter 3D Advanced Guide.

Hands

English Ivy

Poppies

Mediterranean Village

Small Forest

Cumul

Ivy

Sushi

Grass

Stones



                  

ns

 

ayons produce semi-anti-aliased 
 that interact with texture and 
p as you layer them. Pressure 
ines opacity and grain.

 

rayons

 

riant smears the primary color 
e underlying colors.

 

t

 

 a basic crayon.

 

sh

 

rbrush applies a fine spray of color 
vers underlying colors. Stylus 
re determines the concentration of 
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Felt Pens

The Felt Pens variants draw smooth, 
anti-aliased lines that build toward black 
as you layer strokes. Pressure determines 
opacity for all of the Felt Pens.

Dirty Marker

The Dirty Marker produces shades that 
build toward black more quickly than 
those made with the Felt Marker. The 
direction of the stroke determines its 
width.

Medium Tip Felt Pens

This variant draws medium-width lines. 
Drag quickly for a narrow stroke. Drag 
slowly for a wider one. 

With variants where drag speed 
determines stroke width, you can adjust 
the width range and the smoothness of 
transitions between wide and skinny in 

the Brushes menu> Controls menu> Size 
palette. For information, refer to the 
online book, Painter 3D Advanced Guide.

Single Pixel Marker

This variant is a one-pixel Felt Pen. 
Pressure affects opacity.

Felt Marker

The Felt Marker produces a softer shade 
than the Felt Pens. The direction of the 
stroke determines its width.

With variants where direction determines 
stroke width, you can set the angle where 
the width changes. For information, refer 
to the online book, Painter 3D Advanced 
Guide.

Fine Tip Felt Pens

This variant draws narrow strokes. 
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quid variants treat the underlying 
as though it was floating on a thick 
 The brush stroke drags image 
behind it. 

n be particularly useful when 
g with scanned photographs. 

brushes can create a palette knife 
g effect.

ar existing paint with a Liquid 
variant—without adding 

move the Opacity slider all the 
 the left. 

ar while adding some color, move 
acity slider to the right. 

pressure affects texture differently 
 Liquid variants (drip method). 
exture is visible when you press 
, and less texture is apparent when 
ess lightly. This follows the natural 
or of smearing—the harder you 
the paint, the more you will reveal 
face it is painted on.

ese brushes slowly. The amount of 
re determines how much of the 
you smear.
Spatter Airbrush 

The Spatter Airbrush introducing a 
random texture into the airbrush spray. 
This variant produces a semi-anti-aliased 
stroke. Stylus pressure determines how 
much grain is revealed. 

The results vary with different textures. 
Experiment with different textures and 
see how the brush stroke is affected.

Fat Stroke

The Fat Stroke variant covers a large area 
with a soft, anti-aliased paint stream.

Feather Tip

Feather Tip is a small sized variant that 
paints soft, anti-aliased lines of varied 
widths. The width variation is more 
apparent when you widen the brush size.

Single Pixel Air

This variant is a single-pixel brush. Color 
builds up based on pressure.

Thin Stroke

This variant covers a smaller area than Fat 
Stroke.
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il

 

Oil smears with a stroke loaded 
e primary color.

 

to

 

riant moves paint around without 
 color. Dragging quickly produces a 
r stroke; dragging slowly creates a 
ne.

  

ush provides effects you’d expect 
il paints and acrylics. All of the 
variants cover underlying brush 
, and many are capable of 

colored strokes.

ormation on defining the colors for 
color brushes, refer to“Using Two 
 at Once” on page 142.

f the brush variants, like Loaded 
ve the striated effect of real bristles. 
these variants with Apply Surface 
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The Grain slider controls the strength of 
distortion a Liquid brush exerts on an 
image.

Smeary Bristles

This variant smears the primary color into 
the image. It is also grain-sensitive. 
Dragging quickly produces a thinner 
stroke; dragging slowly creates a wider 
one.

Total Oil Brush

This variant is similar to Smeary Bristles, 
but produces a tighter stroke.

Tiny Smudge

Tiny Smudge is a single-pixel, 
multi-bristled smudging tool.

Smeary Mover

This variant is similar to Smeary Bristles, 
but it smears existing paint without 
adding color.

Coarse Smeary Mover

This variant is a semi-anti-aliased version 
of Smeary Mover.

Coarse Smeary Bristles

This variant is a semi-anti-aliased version 
of Smeary Bristles.

Coarse Distorto

This variant is a semi-anti-aliased version 
of Distorto.
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d Oils

 

aded Oils brush simulates the look 
ditional loaded brush—a brush 
 in more than one color. Use the 
ariability sliders to adjust how 

 oils appear. For more information 
 “Setting Color Variability” on 

42.

 

ugh Out

 

riant is a wider version of Rough 

 

y Ink

 

y Ink is like Big Wet Ink, but with a 
der edge.
Texture in the Effects menu produces 
some great oil or acrylic-like brush 
strokes.

Penetration Brush

This brush has hard, aliased edges. Its 
strokes look like acrylics when you apply 
surface texture to them using the Effects 
menu. For more information, refer to the 
online book, Painter 3D Advanced Guide. 
The Penetration Brush reacts to grain. 
Pressing lightly with a stylus allows more 
texture to show through; pressing heavily 
reveals less texture.

Camel Hair Brush

The Camel Hair Brush produces soft, 
anti-aliased strokes. Bristle size is 
dependent on drawing speed. Dragging 
quickly narrows each bristle; dragging 
slowly widens each bristle. Opacity 
depends on pressure.

Brushy

Brushy is a multi-bristle brush that runs 
out of paint toward the end of a stroke 
and picks up colors it’s dragged through.

Fine Brush

The Fine Brush is a very fine-hair brush 
that changes scale quickly based on 
pressure.

Sable Chisel Tip Water

This variant is a fine-hair brush that uses 
water to smear the colors in an image.
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r Wash Brush

 

aller Wash Brush has a multitude 
, closely spaced bristles that mix 
ear the current color with colors in 
ge.

 

t Ink

 

t Ink is a thick striated brush, 
 with ink. It has a soft appearance 
ks like the bristles are spread apart.

 

Brush

 

ver Brush produces brush strokes 
ve soft, anti-aliased edges. It does 
eract with grain. Stroke width and 
 are determined by pressure.
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Huge Rough Out

This variant is an even wider version of 
Rough Out.

Big Loaded Oils

This variant is a wider version of Loaded 
Oils.

Hairy Brush

The Hairy Brush simulates strokes made 
by a bristle brush, showing 
semi-anti-aliased “brush hair” lines. The 
Hairy Brush interacts with grain and is 
pressure sensitive in terms of opacity and 
stroke width. It can also paint multi-color 
strokes. 

You can customize the Hairy Brush 
dramatically by adding bristles and 
opening up space between them. For 
instructions, refer to “Spacing Palette” on 
page 61.

Big Wet Oils

Big Wet Oils is a wide loaded brush that 
mixes with the colors in the image.

Graduated Brush

The Graduated Brush is ideal for shading. 
It paints semi-anti-aliased brush strokes 
of just the primary color or the primary 
and secondary color, depending on 
pressure. It interacts with grain, and its 
stroke width is also determined by 
pressure. 

For instructions on selecting primary and 
secondary colors, refer to “Primary/
Secondary Color Rectangles” on page 140.
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 Hairs

 

arse Hairs brush produces a stroke 
small number of coarse hairs that 
 scale quickly based on pressure.

 

s

 

tists brush helps you paint in the 
f the master artists. You can paint 

style of Vincent Van Gogh, where 
rush strokes are multishaded, or in 
le of Georges Seurat, where 
le dots combine to form an image. 

ll of the Artists brush variants, 
g quickly produces narrower 

, dragging slowly produces wider 
. Use the Color Variability sliders to 
how the Artists brush strokes are 
. For more information about 
ariability, refer to“Setting Color 

ility” on page 142.
Rough Out

Rough Out acts like a fast, dry brush and 
is ideal for roughing out ideas. The dab 
size of the brush is dependent on drawing 
speed. The faster you drag your stylus, the 
thinner the lines. Dragging slower 
produces thicker lines. The amount of 
grain revealed by this brush depends on 
pressure. Pressing lightly reveals more 
grain; pressing harder reveals less grain.

Ultrafine Wash Brush

This variant is similar to the Smaller Wash 
Brush but with a larger bundle of finer 
bristles.

Oil Paint

The Oil Paint brush gives you strokes that 
have hard, aliased edges. Its strokes 
interact with grain. Stroke width and 
opacity are determined by pressure.

Small Loaded Oils

This variant is a narrower version of 
Loaded Oils.

Digital Sumi

The Digital Sumi brush variant is a 
multiple-bristle brush made up of 
single-pixel bristles. Pressure affects 
width.
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 multicolored, anti-aliased dot 
s. To add more dots, drag over the 
ain.

n regulate dot size on the Size 
 accessed from the Brushes palette: 
ls menu> Size. Move the Size slider 

right to make the dots bigger.

 

rs

 

riants of the Cloners brush behave 
ir “plain” brush counterparts—for 
le, the Chalk Cloner produces the 
ffect as the Artist Pastel Chalk 
 of the Chalk brush.

n customize the Cloners variants 
ainter 3D’s other customizing 
ns that are described in the online 

 

ainter 3D Advanced Guide

 

.

 

loner

 

elt Cloner melts an image so that it 
ike it’s dripping, and works the way 
torto variant in the Liquid brush 
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Van Gogh

One of the things that made Vincent Van 
Gogh’s style special was his use of 
multicolored brush strokes. The Van 
Gogh brush re-creates this style with a 
multicolored, anti-aliased brush stroke 
that covers underlying colors. 

This is a complex brush and the strokes 
must be pre-computed; hence the dotted 
line that follows the cursor during the 
stroke. For best results, use shorter strokes 
and wait for them to render before 
making new strokes.

Impressionist

This brush re-creates the style of the 
Impressionists who painted with flattened 
dabs of color. The direction you drag 
determines the angle of the dab. 

You can use the Impressionist variant to 
push around existing paint in an image by 
moving the Opacity slider to the left.

Flemish Rub

This variant creates an effect similar to the 
Impressionist variants. The difference is 
that Flemish Rub smears existing color 
instead of applying new color. Use this 
variant to apply an impressionistic effect 
to an existing image.

Piano Keys

This variant creates a colorful ribbon-like 
stroke with color bands perpendicular to 
the direction of your stroke. Piano Keys 
uses a closely spaced, thin captured 
rectangular tip to produce the effect. 

Seurat

Georges Seurat painted in the pointillist 
style, a neo-Impressionist technique of 
using clusters of dots to represent the 
subject. The Seurat brush automatically 
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 Rain Cloner

 

riant clones your image as it would 
rough a window during a 
rm.

 

loner

 

ft Cloner gives you airbrush-style 
 that softly recreate the source area. 
ges of the Soft Cloner brush are 
lowing it to blend realistically with 
ting background.

 

loner

 

airy Cloner paints like the Hairy 
variant of the brush, producing 
hat anti-aliased strokes that show 
sh’s “hair lines” and react to the 
his brush is useful with oil 

g.
works. When you use this brush with oil 
painting, it looks like you applied paint 
with a palette knife.

Van Gogh Cloner

This variant paints multicolored brush 
strokes in the style of Vincent Van Gogh.

Felt Pen Cloner

This variant re-creates felt pen strokes 
that get darker as you paint over other 
strokes. To keep the colors from 
darkening too quickly, move the Opacity 
slider in the Controls palette: Brush tool 
to the left.

Hard Oil Cloner

The Hard Oil Cloner gives you a harsh 
stroke with a hard edge that interacts with 
the grain and covers underlying strokes. 
It’s good for oil painting and works best 
with short strokes. 

You can configure this cloner to respond 
to speed or velocity of stroke. Use Brushes 
palette: Control menu> Sliders and 
Brushes palette: Control menu> Size to 
adjust the size based on velocity. How 
quickly you drag the mouse or stylus 
determines the width of the stroke. Drag 
slowly for thick strokes, quickly for thin 
ones. This brush interacts with the 
current paper texture.

For more information on the Size and 
Slider palettes, refer to the online book, 
Painter 3D Advanced Guide.
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s, moving the slider to the right 
the texture more pronounced. 
g the slider to the left reduces the 
nteraction.

pressure affects the width of the 
stroke for all of the Water Color 
variants except Wet Eraser. 
ed pressure widens the brush 
 less pressure narrows the stroke.

 

ater Brush

 

riant behaves like the Water Brush 
 variant except without adding 

se it to spread and blend the 
of existing watercolor strokes.

 

Water Brush

 

riant paints a wide brush stroke 
ows its bristles. 

ys to customize bristle brushes, 
 the online book, 

 

Painter 3D 
ed Guide

 

.
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Oil Brush Cloner

The Oil Brush Cloner gives you 
anti-aliased brush strokes that hide 
underlying ones. This is another good 
brush to use with oil painting. Short 
strokes work best with the Oil Brush 
Cloner. How quickly you drag the mouse 
or stylus determines the width of the 
stroke. Drag slowly for thick strokes, 
quickly for thin ones.

Impressionist Cloner

The Impressionist Cloner uses the 
directions of your brush strokes to place 
many short dabs in varied colors based on 
the source point.

Straight Cloner

This variant duplicates the image without 
changing it. Simply click and drag and 
you’ll see the area around the source point 
come through.

Pencil Sketch Cloner

This variant imitates pencil lines. To get a 
quick-sketch effect with uneven lines, 
open the Brushes palette: Controls 
menu> Random palette and move the 
Clone Location How Often slider all the 
way to the left.

Chalk Cloner

This variant draws like the Artist Pastel 
Chalk variant of the Chalk brush.

Water Color

The Water Color brush variants produce 
natural looking watercolor effects.

All of the Water Color variants, except 
Wet Eraser, interact with the canvas 
texture. The Grain slider works differently 
with the Water Color brushes than with 
the other brushes. With Water Color 
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aser

 

et Eraser removes watercolor 
 from the wet layer. The Wet Eraser 
ure sensitive. Pressing heavily 

more quickly. 

ve “dried” the wet layer (by saving 
age), use the regular eraser to 
e the stroke from the image.

 

 Brush Variants

 

 3D’s new brush variants include 
 brushes. You can access these 
s by choosing Window menu> 
 Palette> Shortcut to New 

s. 

n also load these new brush 
s by choosing Load Library from 
sh Library pop-up in the Brushes 

.

re information, refer to “Choosing 
 and Variant” on page 118.
Spatter Water

This variant spatters water randomly with 
each stroke.

Simple Water

The Simple Water variant paints a stroke 
of the primary color without bristles.

Large Simple Water

This is a larger version of the Simple 
Water variant.

Water Brush Stroke

This variant is a watercolor bristle brush. 
When you first make a stroke, a dotted 
line appears while Painter 3D computes 
the stroke.

Large Water

This variant paints a broad wash of color.

Diffuse Water

This variant produces a stroke with 
diffuse edges (refer to the description of 
Diffusion at the beginning of the Water 
Color section).
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ause all pixels in it are black). Now 

can use the Fire brush in this 

 

er. 

 

ic Print

 

aphic Print brush adds contrast 
y. Colors are reduced to black, 
r the closest major hue—R, G, B, 
r Y. Regions are homogenized and 
s are softened. Opacity controls 
strength.

 

ion

 

nfusion brush creates a confusion 
 in existing imagery. Repeat strokes 

d confusion. Only the Size slider 
 effect on Confusion. The Color 
 and other sliders have no effect.
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F/X

Glow

The Glow brush delivers soft-edged color 
that increases in value with each 
overlapped stroke. The Opacity slider 
controls brush strength. The Grain slider 
controls the saturation of the glow. Low 
Grain settings lead more quickly to white. 
High Grain settings increase the 
saturation of the glow.

To use the Glow brush, choose the color 
you want for the glow. The range between 
red and yellow produces excellent glows. 
To slow the effect, choose a color with 
very low value. (Saturation=100% and 
Value=10%). Repeat strokes to build the 
effect.

This brush is useful for painting the halo 
of light on a glowing object. For best 
results, use Glow on a dark background.

Fire

Fire is a variation of the Glow brush that 
uses a captured dab to produce tongues of 
flame. Fire delivers color that increases in 
value with each overlapped stroke. The 
Opacity slider controls brush strength. 
The Grain slider controls the saturation of 
the flames. Low Grain settings lead more 
quickly to white. High Grain settings 
increase the saturation of the flames.

To use the Fire brush, choose the color 
you want for the fire. An orange-red 
creates excellent fire. To slow the effect, 
choose a color with very low value. 
(Saturation=100% and Value=10%). 
Repeat strokes to build the effect.

For best results, use Fire on a dark 
background.

You can create fire in a separate 

floating layer. Create a floater over the 

area you want to light on fire. Fill the 

floater with pure black. Set the floater’s 

Composite Method to Screen. This 

makes it effectively transparent 
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wirl

 

ght Twirl brush distorts existing 
y by pulling it in clockwise spirals. 
y controls brush strength.

 

r

 

r is an extreme Right Twirl variant 
es a captured dab.

 

r

 

r is an extreme Right Twirl variant 
es a captured dab.

 

ence

 

ence is a Left Twirl variant with 
ized dab placement. This brush 

 chaotic, fractal-like effects.
Bubbles

The Bubbles brush creates circles of 
distortion in underlying imagery. The 
distortion is like the refraction you see in 
bubbles. The Opacity slider controls the 
warping in the bubble. Higher Opacity 
settings produce greater warping. Grain 
and color settings have no effect.

Gooey

Bulge

The Bulge brush distorts existing imagery 
by spreading it apart. Opacity controls 
brush strength.

Pinch

The Pinch brush distorts existing imagery 
by pulling it together. Opacity controls 
brush strength.

Horizontal Pinch

The Horizontal Pinch brush distorts 
existing imagery by pulling it together in 
horizontal strokes and spreading it out in 
vertical strokes. Opacity controls brush 
strength.

Vertical Pinch

The Vertical Pinch brush distorts existing 
imagery by pulling it together in vertical 
strokes and spreading it out in horizontal 
strokes. Opacity controls brush strength.

Left Twirl

The Left Twirl brush distorts existing 
imagery by pulling it in counterclockwise 
spirals. Opacity controls brush strength.
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e

ouse brush variants are designed 
ists using a mouse, not a stylus.

tted variant creates dotted. lines. 
e the size in the Size palette for 
r smaller dots.

irex variant fragments the image.

ol

ne variant is good for drawing in 
t line mode.
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Diffuse Pull

The Diffuse Pull brush distorts and 
smears existing imagery in the stroke 
direction. Opacity controls brush 
strength.

Marbling Rake

The Marbling Rake uses a rake stroke to 
smear existing imagery in the stroke 
direction. It’s like dragging a comb 
through thick oil paint. Grain controls the 
amount of smearing.

Runny

Runny brush creates directional distortion 
with randomized dab placement. Opacity 
controls the amount of color applied. 
Grain controls the amount of distortion.

Layer

The Layer brushes use the Transparent 
Layer Brush Plug-in method subcategory. 
These brushes paint on transparent 
portions of image floaters.

Brush

The Brush variant of the Layer brush 
creates paint brush-type strokes in a 
transparent floater.

Airbrush 

The Airbrush variant of the Layer brush 
creates paint airbrush-type strokes in a 
transparent floater.

Pen

The Pen variant of the Layer brush creates 
Pen-type strokes in a transparent floater.
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ush

y Brush smears existing colors but 
hem from blending too much. This 
tly the effect a traditional artist gets 
ging a stiff, dry brush over oil 

t Brush

rgent Brush smears existing 
y and applies color. The Grain 
ontrols the smearing amount. The 
y slider controls how much of the 
t color is added in.

t Turpentine

t Turpentine smears existing colors 
large, bristle dab. The Grain slider 
ls the smearing amount.
Scratchy

The Scratchy variant produces a random 
width line.

Brush Dab

The Brush Dab variant produces nice 
brushed looking strokes. This brush 
responds to the velocity of your stroke.

Rubber Stamp

The Rubber Stamp variant clones the 
active clone source. Hold the Control/
Shift key to set the source point in the 
same document.

Single Pixel

The Single Pixel variant produces good 
clean aliased (jaggy) lines.

Impressionist

The Impressionist variant uses direction 
in conjunction with thin brush pads.

Calligraphy

The Calligraphy variant produces a stroke 
similar to calligraphy.

New Paint Tools

Palette Knife

The Palette Knife smears existing colors 
with a large, rectangular dab. It lets you 
emulate the traditional artist’s palette 
knife painting technique.

Dry Br
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n

arpen brush increases contrast in 
y on a small scale so that borders 
e sharper. For best results, use 
ely low Opacity.

h Remover

ratch Remover brush uses blurring 
ove aberrations in the image. For 
sults, use low Opacity and a small 
tting.

ain

d Grain brush produces value 
s in existing imagery based on the 
t Paper grain. The Grain slider 
ls the strength of the effect. For best 
, keep the Grain slider very low.
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Big Wet Luscious

Big Wet Luscious applies color and smears 
existing colors with a large, bristle dab. 
The Grain slider controls the smearing 
amount. The Opacity slider controls how 
much of the current color is added.

Photo

Dodge

Dodge lightens the colors of the image. 

Dodge is a photographer’s technique. A 
photographic print is made in the 
darkroom by projecting the negative’s 
image onto light-sensitive paper. While 
making a print, a photographer might 
mask a small portion of the image for a 
few seconds. The photographer keeps the 
mask moving, “dodging” it over the paper, 
so that it won’t leave an outline. When the 
exposure is finished, the area that was 
dodged received less light. When the 
paper is developed, the dodged area is 
lighter.

Burn

Burn darkens the colors of the image.

Burn uses the same technique as dodge, 
but with the opposite mask—one that 
covers most of the image. The un-masked 
portion receives more light during the 
exposure, so it develops darker.

Blur

The Blur brush softens color transitions in 
existing imagery. Lower Opacity produces 
a more gentle blur.

Diffuse Blur

The Diffuse Blur brush creates a 
directional motion blur on existing 
imagery. Lower Opacity produces a 
milder effect.
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 the Hue Sat brush: Set the color 
nt to move toward as the primary 
n the Art Materials: Color palette. 
 Opacity slider to describe how 
 you want to get there. Paint in the 

to change hue and saturation. 

e Sat brush is ideal for colorizing 
le imagery.

tion Add

turation Add brush changes the 
ion level of existing colors. Hue 
lue are not changed. The Grain 
ontrols whether the brush 
es or decreases saturation. Grain 
ettings above 50% increase 
ion. Grain settings below 50% 
se saturation. The closer the Grain 
s to either extreme (zero or 100%) 
re quickly the colors change 
ion level. Opacity controls brush 
h.

r palette settings have no effect on 

brush.
Relief

The Relief brush changes contrast in 
existing imagery based on image 
luminance. The result is surface relief 
(three dimensional appearance) in the 
image. For best results, keep the Opacity 
slider very low.

Comb

The Comb brush changes contrast in 
existing imagery following the stroke 
direction. The result is surface relief lines 
that follow the brush stroke.

Overlay

The Overlay brush adds contrast broadly. 
Colors are reduced to black, white or the 
closest major hue—R, G, B, C, M or Y. 
Opacity controls brush strength.

Hue

The Hue brush migrates existing colors 
toward the hue of the current primary 
color. Saturation and value are not 
changed. Opacity controls brush strength. 

Both the existing imagery and the current 
primary color must have some degree of 
saturation for this brush to be effective.

Hue Add

The Hue Add brush migrates the hue of 
existing colors around the color ring. The 
Grain slider controls the direction of hue 
migration. Grain slider settings above 
50% migrate hues clockwise. Grain slider 
settings below 50% migrate hues 
counterclockwise. 

Hue Sat

The Hue Sat brush migrates existing 
colors toward the hue and saturation of 
the current primary color. Value is not 
changed. Opacity controls brush strength.
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Value Add

The Value Add brush changes the value 
level of existing colors. Hue and 
saturation are not changed. The Grain 
slider controls whether the brush 
increases or decreases value. Grain slider 
settings above 50% increase value (move 
toward white). Grain settings below 50% 
decrease value (move toward black). The 
closer the Grain slider is to either extreme 
(zero or 100%) the more quickly the 
colors change in value. Opacity controls 
brush strength.

Color palette settings have no effect on 

this brush.

Value Add Sat Subtract

The Value Add Sat Subtract brush changes 
the value and saturation of existing colors. 
Hue is not changed. The Grain slider 
controls whether the brush increases or 
decreases value. Grain slider settings 
above 50% increase value while reducing 
saturation. Grain settings below 50% 

decrease value while increasing 
saturation. The closer the Grain slider is 
to either extreme (zero or 100%) the more 
quickly the colors change. Opacity 
controls brush strength. With the Grain 
slider below 50%, this brush is ideal for 
darkening touch-up work.

Color palette settings have no effect on 

this brush.

Super Cloners

The Super Cloner brush variants use 
multi-point cloning to transform source 
imagery when you clone it. 

Cloning and the Super Cloner brushes are 
described in the online book, Painter 3D 
Advanced Guide.



  

Meta

 

THIS LICENS
LEGAL AGREE
THE END USE
METACREATI
IS A LICENSE
AN AGREEME
READ THIS L
CAREFULLY B
SEALED PACK
AGREE WITH
CONDITIONS
AGREEMENT
THE PACKAG
PLACE YOU O
MONEY WILL

 

MetaCreatio

 

1) License 

 

This software c
computer at an
that the softwa
one hard drive
this software o
you must eithe
the first hard d
software to a se
purchase two c
may not under
this program lo
of two or more
time. You also 
onto a hard dr
on another com
be executed fro
by multiple co
authorized cop
licensed for eac
software.

          

ect, special, incidental, 
l damages arising out of 

lity to use the software 
on, even if 
Corporation has been 
ossibility of such 

 

nd remedies set forth 
ive and in lieu of all 
ritten, express or implied.
orporation is not 
ny costs including, but 
ose incurred as a result of 

venue, loss of time or use 
oss of data, the costs of 
software or data, the cost 
ware, claims by third 
similar costs. In no case 
ns Corporation’s liability 
nt of the license fee.
rovided give you specific 
may have other rights 
 state to state. Some states 
 exclusion of incidental or 
mages, or the limitation 
mplied warranty lasts, so 
e may not apply to you.

 

ent Restricted Rights 

 

ainter 3D and 
thereto are provided with 
IGHTS. Use, duplication 
he Government is subject 
 set forth in subparagraph 
Rights in Technical Data 
oftware clause at 52.227-
ctor/manufacturer of 
ocumentation thereto is 
orporation, P.O. Box 

lley, CA 95067-6959, 
Creations License Agreement

E AGREEMENT IS A 
MENT BETWEEN YOU, 
R, AND 

ONS CORPORATION. IT 
 AGREEMENT AND NOT 
NT FOR SALE. PLEASE 

ICENSE AGREEMENT 
EFORE OPENING THIS 
AGE. IF YOU DO NOT 
 THE TERMS AND 
 OF THIS LICENSE 

, PROMPTLY RETURN 
E UNOPENED TO THE 
BTAINED IT AND YOUR 
 BE REFUNDED.

ns Software License

an only be used on a single 
y one time. This means 

re should be loaded on only 
 at a time. If you wish to use 
n more than one computer, 
r erase the software from 
rive when you move the 
cond hard drive, or else 
opies of the software. You 
 any circumstances have 
aded onto the hard drives 
 computers at the same 

may not copy this software 
ive and then use the disks 

puter. The software may 
m a common disk shared 

mputers provided that one 
y of the software has been 
h computer executing the 

2) Copyright 

This software is owned by MetaCreations 
and is protected by United States 
copyright laws and international treaty. By 
law, you, the end user, may do the 
following:
a) make a copy of the software solely for 
backup or archival purposes; or
b) transfer the software to a single hard 
disk, provided you keep the original solely 
for backup or archival purposes.
United States copyright laws prohibits you 
from making any other copy of the 
software for any reason without our 
permission. These federal copyright laws 
also prohibit you from copying the 
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	1. Open the palette drawer from within the palette you are currently working, for example, Brushes.
	2. Click the Brush pop-up and choose Load Library. Painter�3D displays an Open dialog.
	3. Select a library, then click Open or OK. Painter�3D loads the items from that library into the...


	Customizing Libraries
	Creating a New Library
	To create a new library:
	1. Open the Mover for the art material or tool you want.
	2. Click New. Painter�3D prompts you to name the new library.
	3. Enter a descriptive name and click Save or OK.


	Moving Items Between Libraries
	To copy an item between libraries:

	Modifying a Library
	Deleting Items
	To delete an item from a library:
	1. Open the Mover for the resource category you want to modify.
	2. Select the item you want to delete.
	3. Click Delete.
	Renaming Items

	To change the name of an item:
	1. Open the Mover for the resource category you want to modify.
	2. Double-click the icon of the item. (You can also click once to select the item, then click Cha...
	3. Enter the new name and click OK.
	Changing Brush Icons

	To change the image icon of a bush icon:
	1. Create artwork for the brush icon. Use the Rectangular Selection tool to select the image.
	2. Open the Brush Mover by choosing Brushes palette: Brushes�menu> Brush�Mover.
	3. Select the brush whose picture you want to change.
	4. Click Change Picture. Painter�3D displays the change that you’re proposing.
	5. If you’re sure you want to change the picture, click OK.
	Deleting a Library



	About Plug-Ins
	Filter Plug-ins
	Acquire Plug-ins
	Export Plug-ins
	Making Plug-Ins Available to Painter�3D
	To locate the plug-ins folder:
	1. Choose Edit menu> Preferences> Other Raster Plug-Ins. The Open File dialog appears.
	2. Locate the folder that contains your plug-ins.
	3. Click Select Plug-ins.
	4. Quit Painter�3D and then restart the program to load these plug-ins.

	To use third-party 2D plug-ins from within Painter�3D:




	Chapter 3
	Painter�3D Basics
	How Painter�3D Works
	Putting It All Together
	1. Begin with a model. This can be a multi-object model you’ve created in a 3D modeling program a...
	2. Select an object and apply images to it as surface maps. You can have six types of maps associ...
	3. Add lights, if necessary, so you can clearly see the effects of the images you’re creating. (N...
	4. Save the maps and apply them to your model in your 3D application. Or, if you created and pain...
	5. If you like, render the finished model as a 2D image complete with mask for compositing in oth...


	Working With the Pieces
	Models
	Objects

	Maps
	Texture Map
	Bump Map
	Highlight Mask Map
	Reflection Mask Map
	Glow Map
	Environment Map

	Map Files and the Image Window
	Mapping Methods

	Lighting
	Rendering

	Working in the Model Window
	Using the Virtual Trackball
	To change the 3D view:
	1. Choose the Virtual Trackball tool.
	2. In the Model window, drag to rotate your view of the model.
	Controlled Rotation
	Preset Views
	Magnifying Your Subject


	To zoom in:
	1. Choose the Magnifier tool.
	2. Click the area you want to view closer. You can also drag a marquee around the area you want t...

	To move back and get a larger view:
	Magnification Pop-up Menu
	Panning the Model�Window


	To pan the Model window:
	1. Choose the Grabber tool.
	2. Drag the model (or image) to view the area you want.

	To return the object to center:
	Changing the Size of the Model�Window

	To change the size of the Model window:
	1. Choose Window menu> Set 3D View Size. The Set View Size dialog appears.
	2. Click OK. Painter�3D sets the Model window to the new size.
	Setting the Model window �Background Color

	To change the background color:
	1. Choose Edit menu> Preferences> Model. Painter�3D displays the Model Preferences dialog.
	2. Click the Background Color swatch. Painter�3D opens the system color picker so you can choose ...
	Importing a Background Image

	To import a background:
	1. Open the model you are working on.
	2. Choose File menu> Acquire> Background. A standard Open dialog appears.
	3. Navigate to the location of the file you want, select it, then choose Open.
	Hiding and Showing the Background Image

	To hide the background image:
	1. Bring the Model window to the front.
	2. Choose Window menu> Hide Background. Painter�3D sets the window to display the background color.

	To show the background image:
	1. Bring the Model window to the front.
	2. Choose Window menu> Show Background. Painter�3D sets the window to display the background image.

	To remove the background image completely:

	Objects and Maps
	To select an object:
	1. Choose the Object Selection tool.
	2. In the Model window, click the object you want. The selected object appears outlined in the 3D...

	The Maps Manager Palette
	Simultaneous Map Editing


	Rendering an Image
	Render to Image
	To render the 3D view:
	1. Before rendering, use the Virtual Trackball, Magnifier, and Grabber tools to set the view of t...
	2. Choose File menu> Render to Image. Painter�3D displays a dialog that lets you set rendering op...
	3. Enter width and height values (in pixels) for the rendering resolution you want.
	4. Enter a pixel resolution at which to render the image. (Refer to “Images and Resolution” on pa...
	5. Set your anti-aliasing options.
	6. When you click OK, Painter�3D renders the image. Rendering can take some time, depending on th...

	Using Renderings in Painter�3D
	To composite your renderings in Painter�3D:
	1. Open the saved rendering in Painter�3D. The rendering must be saved in a format that retains t...
	2. Click the Draw Inside icon at the bottom left of the Image window. A selection marquee appears...
	3. Choose Edit menu> Copy.
	4. You can now move to another file and paste the selection. The selection is pasted as a floater...


	Saving Files
	Tips for Saving Files

	Setting Painter�3D’s Preferences
	General Preferences
	Drawing Cursor
	Setting the Default Libraries
	Choosing a Default Scratch Disk
	Default Units
	Floater Pre-Feather
	Cloning Preference
	Draw Zoomed-out Views Using Area-�averaging
	Display Warning When Drawing Outside Selection
	Show Commit Dialog when Converting to a Floater
	Show Red Indicator When Selecting Objects

	Brush Tracking and Setting Pressure Sensitivity
	Function Keys
	To assign commands to function keys:
	1. Choose Edit menu> Preferences> Function Keys.
	2. Choose the function key you want to assign from the pop-up.
	3. Check the Shift key box if you want to use the Shift key in combination with the function key.
	4. Choose the command you want—either from a main menu or a palette menu.
	5. Click Set to assign the command to the selected key.
	6. Repeat steps 2 through 5 for each key you want to set, then click Done when you’re finished.

	Customizing the Interface
	Changing Icon Selection Color

	To change the icon selection color:
	1. Using the Materials: Color palette or the Dropper tool, choose the color you wish to use.
	2. Click Use Current Color next to Icon Selection Color. The selection box changes to the current...

	To change the palette background texture:
	1. Choose the texture you wish to use in the Paper palette.
	2. Choose Edit menu> Preferences> Interface. The Interface Preferences dialog appears. Click in g...
	3. Click Use Current Texture.
	4. Click Done. Your palette background texture changes.

	To use the current pattern as the palette background texture:
	1. Choose one of the default patterns or use the Rectangular Selection tool to select part of an ...
	2. Return to the Preferences dialog and click Use Current Pattern. The palettes updates so you ca...
	3. Click Done. Your palette background texture changes to the current pattern.

	To change the drawer bottom:
	To change the window background color:
	1. Set the current color using the Materials: Colors palette or Dropper tool.
	2. Click Use Current Color next to Window Background Color. The background is filled with the cur...

	To load a saved interface set:
	1. Click Load in the Interface Sets section.
	2. Choose the interface set from the Open dialog that appears.
	3. Click Open to load the interface set.

	To return to Painter�3D’s default interface:
	1. Click Use Defaults in the Interface Sets section.
	2. Click Done. Painter�3D reverts to the default interface.

	Other Raster Plug-ins
	To indicate the plug-ins folder:
	1. Choose Edit menu> Preferences> Other Raster Plug-ins.
	2. Locate and select the folder containing your plug-ins.
	3. Click OK, then restart Painter�3D to activate this feature.

	Setting Multiple Undo Levels
	Model Preferences
	Model Display During Movement
	Wire Frame
	Wire Frame with Depth Cueing
	Anti-Aliased Wire Frame
	Anti-Aliased Wire Frame with Depth Cueing
	Fully Textured Rendering
	Shaded Non-Textured Rendering
	New Model Rounding Factor
	Background Color


	To change the window background color:
	1. Click the Background Color swatch. Painter�3D opens the system color picker.
	2. Choose a color for the window background. Model renderings will use this background color.
	Mesh Color

	To change the mesh color:
	1. Click the Mesh Color swatch. Painter�3D opens the system color picker.
	2. Choose a color for the mesh.
	Ray Dream Compatible

	Preferences for Windows
	Physical Memory Usage
	Printing Options
	Display Option



	Chapter 4
	Using Painter�3D With Other Programs
	Overview
	Saving Maps for Use in Other 3D Applications
	To save maps and apply them in another application:
	1. In your 3D application, save the model you want to paint in a file format compatible with Pain...
	2. Choose File menu> Acquire to open the model in Painter 3D.
	3. Create the surface maps, using a comparable projection map type or implicit UV mapping.
	4. With the image window active, save the maps in a file format compatible with your 3D application.
	5. Return to your 3D application and apply the maps you’ve just created to the original object.


	Exporting Models and Maps from Painter 3D
	To save and export a model and maps to another application:
	1. In your 3D application, save the model you want to paint in a file format compatible with Pain...
	2. Choose File menu> Acquire to open the model in Painter 3D.
	3. Create the surface maps, using all the Painter 3D tools and features at your disposal.
	4. With the Model window active, save the model as a P3D (Painter�3D format) file. Painter�3D pro...
	5. Export the model by choosing File menu> Export. Choose a file format compatible with your 3D a...
	6. Return to your 3D application and import the model and maps.

	Working With Models from Poser
	To bring Poser models into Painter�3D:
	1. In Poser, save the model in OBJ format.
	2. Choose File menu> Acquire> Wavefront OBJ to open the model, then create whatever surface maps ...
	3. When you’re through, save the maps as PICT files (Macintosh) or TIFF or BMP files (Windows).
	4. Return to Poser and open the model, then apply the PICT images as surface maps. If you’re plan...

	Working with Bryce 3D
	Using 3DMF Files
	Importing 3DMF Models
	Map Assignment
	Shared Maps

	Using DXF Files

	Special Features for Normals
	Invert Normals
	To invert normals:
	1. Select an object in the Model window.
	2. In the Controls palette: Object Selection tool palette, click Invert. Painter�3D inverts the o...
	Repair Normals

	To repair normals:
	1. Select an object in the Model window.
	2. In the Controls: Object Selection palette, click Repair. Painter�3D makes the object’s normal ...
	Smooth Normals

	To smooth normals:
	1. Select an object in the Model window.
	2. In the Controls: Object Selection palette, click Smooth.
	3. Specify an angle in the dialog, then click OK. Painter�3D smooths the normal vectors for the e...


	Using the Plug-in With Ray Dream Studio and 3D Studio MAX
	Using Painter�3D Renderings in Other Applications
	To setup your rendering for compositing:
	1. Render an image from the Model window and save it in a format that retains the mask: TIFF, RIF...
	2. With the image open in Painter�3D, set the Selection Draw mode to Draw Inside. The selection m...
	3. Choose Edit menu> Copy.
	4. You can now move to another file and paste the floater.


	Photoshop Compatibility
	Layers and Floaters
	Rulers, Guides, and Grid
	Adjustment Layers
	Channels and Masks



	Chapter 5
	Working With Models
	Models in Painter�3D
	Creating a Primitive Model in Painter�3D
	To create a primitive model in Painter�3D:
	1. Choose File menu> New Model. Painter�3D displays the New Model dialog.
	2. Choose the model you want: Box, Sphere, Cylinder, Cone, Cup, Ellipsoid, or Torus.
	3. Set the dimensions and tolerance for the model and the width and height for the Model window.
	4. Click OK. Painter�3D opens the model in the Model window.

	Opening Saved Models
	To open a Painter�3D model:
	1. Choose File menu> Open Model. Painter�3D displays an Open dialog.
	2. Navigate to the location of the file, select it, and click Open.
	3. If you’re opening a Painter�3D model exported from Ray Dream Studio, Painter�3D prompts you to...
	Opening Models Created in Ray Dream Studio or 3D Studio MAX

	Importing Models
	To import a model:
	1. Choose File menu> Acquire and select the format of the file you want to import. The Import dia...
	2. Locate and select the file, then click OK.


	The Model in Painter�3D
	Selecting an Object within a Multi-object Model
	To select an object:
	1. Choose the Object Selection tool.
	2. In the Model window, click the object you want. The selected object appears outlined in red in...
	The Controls palette: Object Selection tool
	Getting Technical Information

	To obtain 3D information:
	1. Choose the Object Selection tool.
	2. Hold down the Control key (Macintosh), Shift+Ctrl keys (Windows), and click a point of interes...
	Setting a Base Color for an Object

	To give the model a base color:
	1. Select the object you want to color.
	2. Display the Objects 3D: Hierarchy palette.
	3. Choose Objects 3D: Hierarchy menu> Set Object Color.
	4. Select a color for the object and click OK.

	To set the base color of an object using the Dropper tool:
	1. Use the Art Materials: Color palette to choose a color.
	2. Select the Dropper tool.
	3. Hold down the Option key (Macintosh), Alt key (Windows), and click the object you want to color.

	To give all objects in a multi-object model the same color:
	1. Choose Objects 3D: Hierarchy menu> Set All Objects Colors. Painter�3D displays the system colo...
	2. Select a color and click OK. Painter�3D applies the color you select to all objects in the model.

	Setting Object Properties
	Diffuse
	Specular
	Reflection

	The Objects 3D Palette Menus
	The Objects 3D: Hierarchy Menu
	The Objects 3D: Images Menu
	The Objects 3D: Objects Menu


	Saving a Painter�3D Model
	To save a Painter�3D model:
	1. Bring the Model window to the front. You can click in the window or select its listing from th...
	2. Choose File menu> Save.
	3. Save the map files to the same location and name each file descriptively.
	4. When all images have been saved, Painter�3D opens a Save dialog for the model. In the Save dia...

	Closing a Model
	To close a Painter�3D model:
	1. Bring the Model window to the front.
	2. Click the window’s close box, or choose File menu> Close. If you don’t want to save the model ...
	3. If you want to save any associated maps and the model, click Save. You’re prompted for a name ...

	Exporting Models
	To export a Painter�3D model:
	1. Open the model you want to export.
	2. Choose File menu> Export and select the format you want to use. An Export dialog appears.
	3. Choose a location to save it to and name the file.
	4. Click OK. Painter�3D exports the model file.




	Chapter 6
	Using Maps
	Creating Surfaces on the Model
	About the Six Maps
	Texture Map
	Bump Map
	Highlight Mask Map
	Reflection Mask Map
	Glow Map
	Environment Map

	About Images in the Different Maps
	Grayscale Images


	Applying Maps
	To apply a map to an object:
	1. Display the Maps Manager palette by choosing Window menu> Show Maps Manager.
	2. Select the object you want to work with.
	3. Choose Map menu> Load> and select the map type you want (Texture, Bump, Highlight, Reflection,...
	4. Choose the map source and content, the image size, the mapping type, and the orientation. (The...
	5. Click OK.

	Determining the Map Source
	Making a New Image
	Blank
	Current Pattern or Paper Texture
	Opening an Image into a Map
	Copying an Image into a Map
	Sharing an Image


	Image Dimensions
	The Image Window
	Tips for Creating New Images
	Choosing a Mapping Type
	Implicit
	About Projective Mapping
	Cylindrical
	Spherical
	Cubical
	Pass-thru

	Orientation
	Align with Coordinate Axes
	Align with Current View
	Align in Register With

	Scale and Origin

	Removing or Detaching a Map
	Unsharing a Map

	Changing Mapping on a Current�Map
	To change mapping:
	1. With the Object Selection tool, select the object you want to work with.
	2. Choose Map menu> Set Mapping Options> Map Type. Painter�3D opens the Set Mapping Options dialo...


	Adjusting a Map
	To adjust a map:
	1. Choose Map menu> Adjust Mapping> and select the map you want to adjust.
	2. Choose an appropriate tool and adjust the map.

	Mapping Tools
	Implicit
	Cylindrical
	Spherical
	Pass-thru
	Cubical


	Working in the Maps and Painting on the Model
	Saving Map Images
	Controlling Applied Maps
	Making a Map Active

	To make a map active:
	Making Multiple Maps Active for Simultaneous Editing

	To select multiple maps:
	1. Select a map in the Maps Manager palette list.
	2. Shift-click the Pencil icon for any additional maps you want to select.
	Hiding a Map

	To hide any map:
	1. Click the Eye icon beside its listing in the Maps Manager palette. The Eye winks shut and the ...
	2. To bring back the map, click the Eye icon again to open it.

	Working in Either the Image Window or Model Window
	Using the Mesh
	To show the mesh:
	1. Select the Image window for the map whose mesh you want to view.
	2. Choose Canvas menu> Display Mesh.

	To hide the mesh:
	Dropping the Mesh

	To drop the mesh onto the image:
	1. Select the map into which you want to drop the mesh.
	2. Display the mesh by clicking the mesh icon in the top right corner of the Image window.
	3. In the Maps Manager palette, click the Drop Mesh button.

	Wrap-around Colors and Seamless Maps
	Wrap-around Colors
	Disabling Wrap-Around Colors
	Seamless Maps



	Reflection Mapping
	Creating an Environment Image
	To warp an image:
	1. Before warping, make sure all floaters are dropped.
	2. Choose Effects menu> Surface Control> Quick Warp.
	3. In the Quick Warp dialog, use the default settings (sphere) and click OK.
	4. When you’ve finished developing the environment image, save it.
	Using an Image for the Environment Map

	Setting Reflection for an Object
	Using a Reflection Mask

	Technical Considerations for Designing Maps
	Scale Changes Across the Surface
	Painting and Distortion
	Optimizing Maps for Implicit Mapping
	Optimizing Image Aspect for Cylindrical Mapping
	Optimizing Image Aspect for Spherical Mapping
	Optimizing Image Aspect for Pass-thru Mapping
	To optimize the image aspect:
	1. Set the view in the Model window for the angle of pass-thru you want.
	2. Choose File menu> Render to Image.
	3. In the rendering, use the Rectangular Selection tool to draw a marquee that’s just large enoug...
	4. You can get width and height values by looking in the Controls palette: Selection Tool. Then c...
	5. You can also copy the selection, then choose Edit menu> Paste> Into New Image. Now you can cho...

	Optimizing Image Aspect for Mapping onto a Box
	You can calculate the correct aspect ratio for mapping to any box as follows:
	1. Note the width, depth, and height of the box. To check the dimensions, you can click on the bo...
	2. Use the following equations to determine the correct aspect ratio for images used in cubical o...
	Finding the Box Faces
	Finding the Dimensions of Each Box Face Region

	To determine pixel dimensions:
	1. Use the formula described in “Optimizing Image Aspect for Mapping onto a Box” on page�91 to de...
	2. Divide the width of the map image (in pixels) by the map width (in units). This gives you the ...
	3. Now you can multiply the ppu value by the box width, height, and depth dimensions.
	4. Refer to the diagrams in “Finding the Box Faces,” earlier in this chapter, to see how these va...

	Changing the Aspect Ratio of a Map Image
	To change the aspect ratio:
	1. Make sure that all floaters are dropped.
	2. Choose Effects menu> Orientation> Scale. Painter�3D floats the image and opens the Scale Selec...
	3. Disable the Constrain Aspect Ratio check box.
	4. Enter scaling percentages for the width or height. Notice that a rectangle in the Image window...
	5. Choose Edit menu> Copy to begin moving this floater to its own image file.
	6. Choose Edit menu> Paste> Into New Image.
	7. In the Maps Manager palette, double-click the listing for the map type (texture, bump, etc.) y...
	8. In the Apply Map dialog, use the Copy Image pop-up to select the name of the modified image. C...

	Using Reference Floaters to Avoid Regional Distortion
	To scale labels differently:
	1. Set up your texture map so that the larger label (on the body) is at its natural proportions.
	2. Add the label for the neck as a reference floater. Position the floater on the neck of the bot...
	3. Increase the horizontal scale of the neck label.




	Chapter 7
	Using Light
	Lighting the Model
	Colored Lights on the Model
	Light Reveals the Third Dimension
	Highlights
	Depth Shading
	Lighting and the Bump Map

	Using Painter�3D’s Lighting Palette
	Preview
	Light Icons
	Display Slider
	Show Icons
	Controlling Individual Lights


	To add a new light:
	To move a light:
	To select a light:
	To change the selected light’s color:
	1. Click the Color button. Painter�3D displays the system color picker so you can choose a color.
	2. Choose a color from the color picker and click OK. The model in the Model window is tinted wit...

	To change the selected light’s brightness:
	To change the selected light’s concentration:
	To delete the selected light:
	Controlling Model Lighting
	Exposure Slider
	Ambient Slider
	Flat Lighting

	Adding Lights With the Light Tool
	To add a light using the Light tool:
	1. Select the Light tool from the Tools palette.
	2. Click the model at the spot where you want the light to shine. Painter�3D adds the light. You’...
	3. Use the Controls palette: Light tool to adjust the light’s Brightness, Concentration, Exposure...

	Locking Lights to Objects
	Saving Light Settings
	To save light settings:
	1. Set the lighting you want. The settings for position, color, and all of the sliders will be sa...
	2. Choose Objects 3D: Lighting menu> Save. Painter�3D prompts you to name the light set.
	3. Enter a descriptive name and click OK.

	To load saved light settings:
	1. Choose Objects 3D: Lighting menu> Load. Painter�3D displays a dialog list of the saved light s...
	2. Click the listing you want. Painter�3D displays a preview of the light set.
	3. Click OK. Painter�3D closes the dialog and loads the light setting for the model.




	Chapter 8
	Working With Images
	Developing Images
	Learning About Painter�3D Map Image Files
	Creating a New Image File
	To create a new image:
	1. Create a new image by choosing File menu> New Image. The New Picture dialog appears.
	2. Set dimensions, resolution, and paper color, then click OK.

	Canvas Size
	Width and Height
	Choosing a Unit of �Measurement
	Setting Resolution

	Paper Color
	To change an existing paper color:
	1. Use the Art Materials: Color palette to select the color you want.
	2. Choose Canvas menu> Set Paper Color. The paper is set to the current primary color


	Opening a New View
	To open a new view:
	To close the view:

	Image Size Information
	To check image size and orientation:
	1. Move the pointer to the i and hold down the mouse button.
	2. Release the mouse button to close the image information window.


	Navigating Your Image
	Zoom to Fit
	Zooming In and Out
	To magnify a specific area:
	Using the Grabber Tool
	Rotating an Image Window
	To rotate an Image window to suit your drawing style:
	1. Choose the Virtual Trackball tool or with almost any other tool selected, hold down Option-Spa...
	2. Press down on your stylus or mouse and drag, and a rectangle with an arrow pointing at the top...
	3. Drag the rectangle or the arrow to the angle you want. To constrain page rotation to 90° angle...

	To return the Image window to its normal position:
	1. Choose the Virtual Trackball tool or hold down Option-Spacebar (Macintosh) or Spacebar+Alt (Wi...
	2. Click once in the Image window.


	Rulers
	To display the rulers:
	To hide the rulers:
	Ruler Options
	Snap to Ruler Ticks
	Changing the Origin
	To change the origin of the rulers:
	1. Drag from the box where the horizontal and vertical rulers meet to the point in the document y...
	2. When you release the mouse button, the ruler updates to describe the new point as the origin.

	To restore the top left corner as the origin:

	Guides
	To create guides:
	1. Show the rulers. You must display the rulers to create guides.
	2. Click once in either the horizontal or vertical ruler to create a guide at that point. If you ...

	Guide Options
	Hiding and Showing Guides
	Snap to Guides

	Using the Grid Overlay
	Grid Options
	Grid Type
	Horizontal Spacing
	Vertical Spacing
	Line Thickness
	Grid Color
	Background
	Transparent Background


	Using the Mesh
	Opening and Saving Images
	Opening Existing Images
	To open an existing image file:
	1. Choose File menu> Open Image. An Open dialog appears.
	2. Locate the file you want to open. If it was saved in Painter�3D or Painter, the right-hand sid...
	3. From the Open dialog or the Browse dialog, open the document by double-clicking the file name,...

	Making Sense of Open Images
	To list all open images:
	To list only maps:
	Saving Images
	RIFF Format
	TIFF Format
	JPEG File Format

	To save a file as a JPEG:
	1. Choose File menu> Save As and select JPEG from the list of file types.
	2. Click the Save button and the JPEG Encoding Quality dialog appears.
	3. Choose a quality option and click OK.


	Undoing Operations
	Multiple Undo
	Fade
	To see how fade works:
	1. Draw a dark brush stroke or apply an effect.
	2. Choose Edit menu> Fade. The Fade dialog appears.
	3. Drag the Undo Amount slider and watch the brush stroke or effect fade in and out.
	4. When the preview shows the weight of stroke you want, or the right effect, click OK.




	Chapter 9
	Painting
	Painting With Painter�3D’s Brushes
	To begin painting:
	1. Open a model and load a blank texture map.
	2. Choose the Brush tool from the Tools palette.
	3. In the Brushes palette choose a brush, then choose one of its variants from the Variant pop-up.
	4. Choose a color to paint with from the Art Materials: Color palette or from the color set. (Whe...
	5. Choose a texture from the Art Materials: Paper palette.
	6. Adjust the sliders for brush size, opacity, and penetration into the paper grain on the Contro...
	7. Mark in either the Image window or the Model window.

	Choosing a Brush and Variant
	Special Brushes

	Choosing Colors
	Two-color Brush Strokes
	To set two colors for brush strokes:
	1. Choose the Brush tool from the Tools palette.
	2. Select the Graduated Brush variant of the Brush in the Brushes palette, or choose another mark...
	3. Click the front rectangle on the Color palette to select it.
	4. Select a color in the Art Materials: Color palette or from a color set. The front rectangle sh...
	5. Click the back rectangle and select a secondary color.
	6. Click the front rectangle again to make it active. This keeps the primary rectangle selected f...
	7. Before you make a stroke, choose Brushes palette: Control menu> Sliders. Painter�3D displays t...
	8. Set the Color slider to Direction.
	9. In the Image window, paint an “X.” Notice that the primary color is used in one mark and the s...


	Choosing Paper Texture
	Setting Basic Brush Controls
	Size
	To change brush size in the Image window:
	1. Hold down the Command�Option/ Ctrl+Alt keys.
	2. In the Image window, click and drag. A circle that represents the brush size appears beneath t...
	3. You might need to build the brush now.
	Opacity
	Grain


	Painting the Surface
	Freehand versus Straight Lines Drawing
	Keyboard Shortcuts
	Constraining Stroke Angle
	Undo stroke
	Fade stroke
	Stylus Versus Mouse
	3D Tracking Speed


	Where You Can Paint—the Image,�a�Floater, or a User Mask

	Learning about Brushes—Starting with�Method
	The Methods
	Buildup
	Cover
	Eraser
	Drip
	Cloning
	Wet
	Plug-in

	Changing Methods
	Water Color
	The Wet Layer
	Diffusion
	To use diffusion:
	1. Apply one or more strokes with a water color brush variant.
	2. To restrict the diffusion to a region, make a selection with any selection tool, such as the L...
	3. Press Shift-D or adjust the slider on the Water palette.
	4. Repeat the command until the strokes show the level of diffusion you want.
	The Water Color Brush Variants



	Expandable Plug-in Brushes
	Using Plug-in Methods with Other�Brushes
	Painting on a Transparent Floater�with�the Layer Brush
	To paint on a transparent floater:
	1. Choose Objects palette: Floater menu> Transparent Layer. Painter�3D creates a new transparent ...
	2. Choose one of the Layer brush variants and start painting. To find the Layer brush, click the ...





	Chapter 10
	Applying Art Materials
	Working With Art Materials
	The Art Materials Palette
	Filling With Art Materials
	Filling an Area
	To use the Fill command:
	1. Select part of your image. Refer to the selection chapter in the online book Painter�3D Advanc...
	2. Choose Effects menu> Fill. You may also press Command/Ctrl+F. The Fill dialog appears.
	3. Select what you want to fill with—the current color, gradation, clone source/pattern, or weaving.
	4. Adjust fill opacity if you like.
	5. Click OK. Painter�3D fills the selection.

	To fill with the Paint Bucket:
	1. Select the Paint Bucket tool from the Tools palette.
	2. Make sure the Controls palette: Paint Bucket tool is visible. You need it to set your Paint Bu...
	3. Use the What to Fill pop-up to choose the type of fill you want.
	4. Use the Fill With pop-up to choose the material you want in the fill. The Current Fill preview...
	5. Use the Art Materials palette to choose the specific material you want.
	6. If you are doing an Image fill, adjust the Controls palette sliders for Tolerance and Color Fe...
	7. Click in the area of the image you want to fill.


	Leaky Line Work
	To limit leakage:
	1. With Cartoon Cel or Image selected on the Controls palette: Paint Bucket tool, click within th...
	2. Without releasing the mouse or stylus, drag a rectangle that is a bit larger than the area you...
	3. Let go. If there is no leak, only the area within the black lines will be filled. If there is ...


	Lock-Out Color
	To change the Lock-Out Color:
	1. In the Art Materials: Color palette, choose the color you want protected.
	2. Double-click the Paint Bucket tool icon in the Tools palette. The Mask Threshold dialog appears.
	3. Click Set. The Lock out color chip updates to the new color.
	4. Click OK to close the dialog.


	Using the Cartoon Cel Fill Method
	To copy the lines to the selection:
	1. Choose Select menu> Auto Select.
	2. Choose Image Luminance from the Using pop-up.
	3. Click OK. Painter�3D creates a selection that will protect the dark lines.

	To set Mask Threshold for the Paint�Bucket:
	1. Double-click the Paint Bucket tool icon in the Tools palette. The Mask Threshold dialog appears.
	2. Set the Mask Threshold slider for the softness of your lines. This slider controls how much th...
	3. Click OK.

	To fill with the Cartoon Cel fill method:
	1. Choose the Paint Bucket tool from the Tools palette.
	2. On the Controls palette: Paint Bucket tool, choose Cartoon Cel, from the What to Fill pop-up.
	3. Choose what you want to fill with—Color, Grad, Clone Source (Pattern) or Weave.
	4. Use the Art Materials palette to choose the material you want.
	5. Click inside a bounded region. Painter�3D fills the area.


	Closing Leaks
	To close a leak:
	1. Make sure you have an active selection.
	2. Choose Select menu> Save Selection. The Save Selection dialog appears.
	3. Choose New from the Save to pop-up.
	4. Click OK. A new mask appears in the Objects palette: Mask List.
	5. Select the mask from the Objects palette: Mask List.
	6. Choose a brush for masking. The same brush you created the lines with would be ideal.
	7. Set Black as the current primary color.
	8. Paint in the mask to close the gaps that allow the Cartoon Cel fill to escape.
	9. Choose Select menu> Load Selection.



	Working with Colors: The Color Palette
	Using the Color Palettes
	To select a hue and color from the Standard Color palette:
	1. Drag the circle on the color ring to select the predominant hue. You can also select the hue b...
	2. Select a color on the triangle by dragging the circle or clicking on the color you want.
	Primary/Secondary Color Rectangles
	Sampling Colors from Images
	Dropper Tool

	To use the Dropper tool:
	1. Click the front overlapping rectangle on the Art Materials: Color palette if you want to chang...
	2. Choose the Dropper tool.
	3. Move the cursor to the color you want to pick up and click on it.
	Clone Color

	To use clone color:
	1. Set up a clone source. If you don’t set a file as the source, Painter�3D uses the current Patt...
	2. Select any brush.
	3. Click the Color icon on the Art Materials palette to open the Art Materials: Color palette.
	4. Click Clone Color. You may also choose Art Materials palette: Color menu> Use Clone Color.
	5. When you paint in the clone file, Painter�3D uses colors from the clone source image.
	Setting Color Variability
	Using Two Colors at Once

	To set up a two-color brush stroke:
	1. Select the Graduated Brush variant or another mark-making brush variant.
	2. Click the front rectangle on the Color palette to select it.
	3. Select a color on the Color palette or from a color set. The front rectangle shows your select...
	4. Click the back rectangle and select a secondary color.
	5. Click the front rectangle again to make it active. This keeps the primary rectangle selected f...
	6. Before you make a stroke, choose Brushes palette: Control menu> Sliders. The Sliders palette a...
	7. Set the Color slider to Direction.
	8. In your document, paint an “X.” Notice that the primary color is used in one mark and the seco...


	Color Sets
	Using the Color Sets
	To display the current color�set:
	To load a different color set:
	1. Choose Art Materials palette: Color menu> Load Color Set. A standard Open dialog appears.
	2. Locate and double�click on the color set or select the color set and click Open. The new color...

	To choose a color from a color set:
	1. In the Color palette, click on the primary or secondary (front or back) rectangle to select th...
	2. In the Color Set palette, click the color you want.
	Finding Colors

	To find a color:
	1. Choose Art Materials palette: Color menu> Adjust Color Set. The Color Set palette appears.
	2. Click Find Color. The Find Color dialog�appears.
	3. Select a search method. You can find a color by name or find a color that’s closest to the cur...
	4. Click Search. If the name isn’t found, the OK button is dimmed.
	5. Click OK. If the color set is visible, Painter�3D surrounds the found color with the selection...
	Customizing Color Sets
	Customizing Color Set �Layouts

	To customize a color set layout:
	1. Choose Art Materials palette: Color menu> Adjust Color Set. The Color Set palette appears.
	2. If the color set is locked (padlock closed), click the Padlock button on the Color Set palette...
	3. Click a Sort Order radio button to order the colors in the set:
	4. Use the Color Square Size box to adjust the size of the individual squares in the color set. C...
	5. Use the Color Set Size box to change the number of rows and columns in the color set. Click th...
	6. Click the Display Text checkbox at the bottom of the Color Square Size box to turn the color n...
	7. Click the Display Grid checkbox at the bottom of the Color Set Size box to turn the grid on an...
	Creating Color Sets

	To create a color set:
	1. Choose Art Materials palette: Color menu> Color Set. The Color Set palette appears.
	2. Click New Set. A new empty Color Set palette appears.
	3. Choose a color you wish to add to the new color set. You can choose a color from the Art Mater...
	4. On the Color Set palette, click Add Color. The color is added to the color set. To name the ne...
	5. Repeat this procedure until you have chosen all of your color set�colors.
	6. Click the Library button. A dialog appears asking if you want to save the changes you’ve made.
	7. Click Save. Enter a name for the color set, choose a destination directory, and click Save.
	Adding and Deleting Colors from a Set

	To add a color to an existing color set:
	1. Choose the color you want to add to an existing color set. You can choose a color from the Art...
	2. On the Color Set palette, click Add Color. The color is added to the color set. To name the ne...

	To delete a color from an existing color�set:
	1. Choose the color set that contains the colors you want to delete.
	2. Select the color you want to delete. The current selection frame appears around the color.
	3. On the Color Set palette, click Delete Color. A dialog appears asking if you really want to de...
	4. Click Yes. Painter�3D deletes the chosen color from the color set�window.

	To change a color in an existing color�set:
	1. Choose the new color you want to place into the open color set. You can choose a color from th...
	2. Hold down the Option/Alt key and triple-click the color in the color set that you want to repl...
	Naming Colors

	To name a color:
	1. Double-click on a color swatch in the open Color Set palette. The Color Name dialog appears.
	2. Enter the color name and click OK.



	Surface Grain: The Paper Palette
	Selecting Paper Texture Grain
	To select a paper texture grain:
	1. Click the Paper icon on the Art Materials palette to open the Art Materials: Paper palette.
	2. Click the push bar and open the drawer to see more selections.
	3. Click a paper texture to select�it.


	Inverting Paper Grain
	Scaling Paper Texture Grain
	Capturing Paper Textures
	To capture paper texture:
	1. Open or create an image. The Make Fractal Pattern feature creates excellent textures. Certain ...
	2. Using the Rectangular Selection tool, select all or a piece of the image.
	3. Choose Art Materials palette: Paper menu> Capture Paper. The Save Paper dialog appears.
	4. If necessary, move the Crossfade slider to the right to blend the distinction between tile bor...
	5. Type the name of your new paper and click OK.


	Making Paper Textures
	To create paper textures:
	1. Choose Art Materials palette: Paper menu> Make Paper. The Make Paper dialog appears. The�Previ...
	2. Choose a pattern from the Pattern pop�up menu to use as the basis of your paper texture.
	3. Adjust the Spacing and Angle sliders. Moving the Spacing slider to the right opens up space be...
	4. When you like the look of the texture, type a name for it and click OK. Your new texture appea...


	Randomizing Paper Grain
	To randomize the paper grain:
	1. Choose Brushes palette: Control menu> Random. The Random palette appears.
	2. Enable the Random Brush Stroke Grain option.



	Using Gradations: The Grad Palette
	Working with Gradations
	Creating Gradations
	Creating a Two-Point Gradation
	To create a two-point gradation:
	1. Open the Art Materials: Color palette.
	2. Choose a primary color.
	3. Choose a secondary color.
	4. Open the Art Materials: Grad palette.
	5. Select the Two-Point icon.
	6. Make sure the drawer is closed, so you can see the preview of your gradation.
	7. Try changing the color order by clicking the different icons at the bottom of the window. You ...
	Saving a Gradation

	To save a gradation:
	1. Choose Art Materials palette: Grad menu> Save Grad. The Save Grad dialog appears.
	2. Enter the name for your gradation.
	3. Click OK.
	Creating Gradations with the Gradations Editor

	To edit a gradation:
	1. Choose Art Materials palette: Grad menu> Edit Grad. The Edit Grad dialog appears.
	2. Make your changes to the gradation as discussed in the following sections.
	3. Click OK to exit the Edit Grad dialog.
	Changing Color Control Points

	To change a control point color:
	1. Click a color control point (pointed gray marker) to select it.
	2. Select a new color from the Color palette.
	Adding and Deleting Color Control Points
	Using the Linear Check Box
	Changing the Color Space

	To change the color space:
	1. Click on a square box above the color ramp bar.
	2. Select an option from the Color pop�up.
	3. Click OK when you’re finished. You can now save your new gradation.
	Capturing a Gradation from an Image

	To capture a gradation:
	1. Use any tool to draw a gradation or open an existing image.
	2. Using the Rectangular Selection tool, select a horizontal or vertical area. Make the selection...
	3. Choose Art Materials palette: Grad menu> Capture Grad. The Save Grad dialog appears.
	4. Type a name for the gradation and�click OK. The new gradation is saved in the current library....


	Mapping a Gradation to Image Luminance
	To express a gradation in an image:
	1. Open the image you want to use. You can select part of the image or use the entire image. Patt...
	2. On the Art Materials: Grad palette, select the gradation you want to�use.
	3. Choose Art Materials palette: Grad menu> Express in Image. The Express in Image dialog appears.
	4. Adjust the Bias slider to define how the gradation is mapped. Painter�3D replaces the colors i...
	5. Click OK.



	Using Patterns: The Pattern Palette
	To choose a pattern:
	1. Click the Pattern icon on the Art Materials palette to open the Art Materials: Pattern palette.
	2. Click the icon for the pattern you want. You can click the push bar to open the drawer and dis...
	3. When you’ve selected a pattern, close the drawer.

	To fill an image with multiple pattern tiles:
	1. Choose Effects menu> Fill. The Fill dialog appears.
	2. Choose Pattern as the art material source.
	3. Click OK.

	Editing the Pattern Tile with Check�Out�Pattern
	To check out a pattern’s tile:
	1. In the Pattern palette, select the pattern you want to work with.
	2. Choose Art Materials palette: Pattern menu> Check Out Pattern.


	Creating Patterns
	Defining Patterns
	To define a pattern:
	1. Open the image file you want to work�with.
	2. Choose Art Materials palette: Pattern menu> Define Pattern.


	Adding Images to the Pattern�Library
	To add a pattern to the current library:
	1. Open the image you want to add to the pattern library.
	2. Choose Art Materials palette: Pattern menu> Define Pattern.
	3. Choose Art Materials palette: Pattern menu> Add Image to Library. Painter�3D prompts you to na...
	4. Give it a descriptive name and click OK. If a pattern of that name already exists in this libr...


	Capturing Patterns
	To capture a pattern:
	1. Open the image that contains the area you want to use.
	2. Using the Rectangular Selection tool, select the area you want. Remember, the edges of the sel...
	3. Choose Art Materials palette: Pattern menu> Capture Pattern. The Capture Pattern dialog appears.
	4. Make other selections as needed. You have the following options:
	5. Enter a descriptive name for the pattern and click OK.


	Tips for Creating Seamless Tiles
	To wrap-around the seams:
	1. Open an image.
	2. Choose Art Materials palette: Pattern menu> Define Pattern.
	3. Click the Grabber tool on the Tools palette.
	4. Hold down the Shift key and drag in the image. You’ll see a horizontal and vertical line where...


	Make Fractal Pattern
	To use the Make Fractal Pattern command:
	1. Choose Art Materials palette: Pattern menu> Make Fractal Pattern. The Make Fractal Pattern dia...
	2. Select your options as described in the following paragraphs. Any changes you make appear in t...
	3. When you are satisfied with your selections, click OK.
	Sizing the Tile
	Make Fractal Pattern Sliders
	The Power Slider
	The Feature Size Slider
	The Softness Slider
	The Angle Slider
	The Thinness Slider
	Channel Options

	Height as Luminance
	Gradient Bearing
	Surface Normal
	Converting a Pattern to a �Paper Texture


	To convert a fractal pattern to a texture:
	1. Check out the pattern to display it in an Image window.
	2. When you’re satisfied with the tonal balance, choose Select menu> All.
	3. Choose Art Materials palette: Paper menu> Capture Paper. The Save Paper dialog appears.
	4. Name the Paper and click OK.



	Using Weaves: The Weave Palette
	Changing Weave Fiber Type
	To change how a weave is displayed:

	Adjusting Scaling and Thickness
	To adjust scaling and thickness:
	1. Select the weave you want to adjust. Its image appears in the Preview window.
	2. Click Fiber Type until the button shows a three-dimensional weave. For most weaves, you won’t ...
	3. Adjust the horizontal and vertical scale sliders. You still might not see a change in the Prev...
	4. Adjust the horizontal and vertical thickness sliders.


	Editing Weave Colors
	To display the color set for a weave:
	1. Select the weave in the palette and close the drawer.
	2. Choose Art Materials palette: Weave menu> Get Color Set. The color set for the selected weave ...

	To change the colors for a weave:
	1. Select a new color from the Art Materials: Color palette.
	2. Hold down the Option/Alt key and click the color chip on the weave color set (Weave menu> Get ...
	3. Choose Art Materials palette: Weave menu> Put Color Set. The Preview window shows the weave wi...


	Saving Weave Changes
	To save weave changes:
	1. Choose Art Materials palette: Weave menu> Save Weave. A dialog appears asking you to name the ...
	2. Type a name for the weave and click OK. If you don’t type a new name, Painter�3D replaces the ...
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